
 

 
 

Opera t i on  Manua l  

 

 

 

TMR 7300 
DYNAMIC MEASUREMENT SOFTWARE 

Ver.1.2 



 

 

 



 

 

Introduction 

This software is general-purpose dynamic measurement software 

that controls our instrument TMR-211 or TMR-311 to enable data 

monitoring, data collection, data edition (tabulation and drawing fig

ures) and data processing by using the Microsoft Windows OS. 

To use this software effectively, read this operation manual thor

oughly and understand the functions and operations sufficiently. 

This operation manual is written based on the basic operation m

ethod of Windows. For the basic operation of Windows, refer to t

he user's guide supplied to the Windows OS. 

In order to use the frequency analysis function described in this

 operation manual, installation of optional software on the instrum

ent TMR-211 is required. For details, see the operation manual of

 the instrument. 

Option Name ： Histogram analysis library 

TMR-211-01/TMR-311-01 



 

 

Notational system of this manual 

This manual uses the notational system shown below in the bod

y text for simplifying the description of operation. 

 

Examples ： Description 

File menu ： Names of the menu and menu items a

re indicated in block letters. 

 

"Set" button ： Names of the buttons are shown in bl

ock letters in quotation marks. 

 

Ctrl+N ： It denotes a shortcut： The sign in the

 left means that  

you press the alphabet "N" while holdi

ng the Ctrl key. 

 

 ： Describes the referential item for opera

tion. 

 

 

 ： Describes the caution on operation. 

The body text is indicated in italic typ

e. 

 

 ： Describes the referential page for oper

ation. 

 

Setting Items ： Item titles are indicated in block letter

s. 

 

Pictorial cuts in the text 

 ： For the pictorial cuts in this manual, t

he screens of Windows 10 are used. 

 

The pictorial cuts used for this manual are the pictorial 

cuts of software under development. Note that the screens 

may be different from those of actual product. 
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Chapter 1 Setup 
 

 1-1 

This section explains setup and connection of the hardware, and setup of the 
software. 
 

1 What you need for setup 
You need followings before starting the setup procedure. 
 

 TMR-7300 Setup CD: 1 disc 
 

 OS: Microsoft Windows 7 (SP1) / 8.1 / 10/ 11 
 

 Computer with the above OS installed and a CD drive 
 



 

 1-2 

2 Setting up the measurement system 
Connect the instrument to a computer using a LAN or USB interface. 
 

2-1 Connection using a LAN interface 
If you are connecting the instrument using a LAN interface, setting of the LAN 
(Ethernet) is necessary on your computer. 
 
Perform setting of the computer from Property of the Network connections or 
Ethernet. 

 

Select Internet Protocol Version 4 (TCP/IP), and click the "Properties" button. 

 

When setting the Internet Protocol for the first time, refer to the IP address of 
the instrument and change only the rightmost number from it. 
For example, if the IP address of the instrument is 192.168.1.1, set the 
computer to 192.168.1.2. Set the subnet mask to 255.255.0.0. If, however, this 
number has been already assigned to any other device, you have to set a 
different number. 
If a LAN environment is already established, set an IP address of the instrument 
which is different from any addresses used already. 
If your LAN is administered organizationally, consult with the network 
administrator of the organization. 
 

For the IP address settings of 
the measurement system, refer 
to "Chapter 4: 2-3 IP address 
change of instrument" (Page 
4-4). 
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2-2 Connection using a USB interface 
If you are connecting the instrument using a USB interface, you have to install 
a USB driver. You should install USB driver before connecting the instrument 
and your PC. 
 
1. Insert the Setup CD into the CD drive. 

2. When the TMR-211 is used, open "Driver\TMR-211" folder in the Setup CD. 

When the TMR-311 is used, open "Driver\TMR-311" folder in the Setup 
CD. 

3. Double click the "Driver Install" to execute it. 

 

4. User Account Control is displayed depending on OS setting. 

 

Click the "Yes" button. 
5. "Start of the installation Wizard of the USB driver" will be started. 

 

Click the "Next>" button to start the installation of the USB driver. 
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6. Installation of the driver starts. 

 

 
7. Windows Security window is displayed depending on OS setting. 

Click the "Install" button. 

 

 
8. "Completing the Device Driver Installation Wizard" is displayed. 

 

Click the "Finish" button to complete the installation. 
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3 Setup of this software 
Here the setup procedure of this software is described. 
 
Log in as the user with the administrator privilege. 
Ensure all other applications are closed prior to installing the software. 
 

1. Open "TMR-7300\English" folder in the Setup CD, and double click the 
setup.exe. 

2. User Account Control is displayed depending on OS setting. 

 

Click the "Yes" button. 
 
3. The screen shown below is displayed depending on your PC. 

 

Click the "Install" button. 
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4. The setup program will start up. 

 

Click the "Next>" button. 
 
5. Select where to install. 

 

If you want to change where to install, click the "Change..." button. 
Click the "Next>" button. 

 
6. The confirmation screen is displayed. 

 

Click the "Install >" button. 
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7. Setup is started. 

 

8. "Restarting Windows" is displayed. 

 

If possible, select "Yes, I want to restart my computer now." and click the 
"OK" button. 

 
9. Setup of TMR-7300 is now completed. 

 

Click the "Finish" button to complete the setup procedure. 
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This section explains basic specification of this software and functions of each 

part of the screen. 

 

1 Check of the system configuration 

The standard system configuration is shown below. Please check your system 

against it. 

 

◼ OS Microsoft Windows 7(SP1)/8.1/10/11 

◼ Computer Meet the system requirements of the above OS. 
CD drive and USB port. And if LAN interface is used, 
LAN port is needed. 

◼ Interface 

One of the following interfaces is necessary 

LAN 100BASE-TX 

USB USB 2.0 

◼ Printer The model which can be worked on above OS. 

◼ Multi-recorder 

TMR-311 (Control Unit) Ver.1.0A 

TMR-321 (Strain Full Bridge Unit) 

TMR-322 (Strain 1G2G4G Unit) 

TMR-323 (Carrier type Strain Unit) Ver.1.2A 

TMR-331 (Voltage Input Unit) Ver.1.1A 

TMR-332 (Thermocouple/Voltage Unit) Ver.1.4A 

TMR-341 (Voltage Output Unit) Ver.1.3A 

TMR-351 (CAN Unit) Ver.2.0A 

TMR-353 (Digital I/O Unit) Ver.1.6A 

TMR-354 (GPS Unit) Ver.2.1A 

TMR-361 (Charge Amplifier Unit) Ver.1.7A 

TMR-362 (IEPE Unit) Ver.2.3A 

TMR-311-01 
 (Histogram analysis library/Option) Ver.1.9A 

 

TMR-211 (Control Unit) Ver.1.1B 

TMR-221 (Strain Full Bridge Unit) 

TMR-222 (Strain 1G2G4G Unit) 

TMR-223 (Carrier type Strain Unit) 

TMR-231 (Voltage/Thermocouple Unit) 

TMR-241 (Voltage Output Unit) Ver.1.5A 

TMR-251 (CAN/Voice/GPS Unit) 

TMR-252 (Telemetry I/F Unit) 

TMR-253 (Digital I/O Unit) 

TMR-261 (Charge Amplifier Unit) 

TMR-211-01 

(Histogram analysis library/Option) 

 

If the control unit is older than the above version, it is necessary to upgrade the 

firmware of the control unit. 

 

For the TMR-251, refer to 

"Chapter 11: CAN/Voice/GPS 

Unit". 

For the TMR-253, refer to 

"Chapter 12: Digital I/O Unit" 

 

For the TMR-351, refer to 

"Chapter 10: CAN Unit" 

For the TMR-354, refer to 

"Chapter 11: GPS Unit" 

For the TMR-353, refer to 

"Chapter 13: Digital I/O Unit" 
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2 Basic specification 

Measurement conditions 

◼ Number of units which can be used simultaneously 

Up to 10 units by selecting input units 

◼ Measurement points 

80 points maximum (with 10 units) 

◼ Maximum number of arithmetical expressions 

1000 

◼ Setting of the Measurement Project 

 Meter setting 

Selection of the units to use and setting of the interface 

 A/D setting 

Perform setting of the A/D conversion by specifying the number of data and 

sample clock. 

 Channel setting 

Input CH 

SET : Set measurement channels to use. 

Name : Set the name of the measurement point. 

Input mode : Set the type of the input signals. 

Input range : Set the range for A/D input. 

Low-pass filter : Set the cutoff frequency and filter property (Vessel / 

Butterworth) of the low-pass filter 

High-pass filter : Set the cutoff frequency of the filter. 

Balance : Set Valid/Invalid of zero-adjustment function. 

Reference Junction 

 : Set the reference junction to use the thermocouple 

Coefficient : Set coefficients for measurement data. 

Rated output : Set the rated output of sensor. 

Capacity : Set the capacity of sensor. 

Shift : Set the shift amount of measurement data. 

Unit : Set the unit of measurement data. 

Format : Set the display format of measurement data. 

Alarm : Set the alarm generation condition for measurement 

data. 

Option : Up to three points of coordinate for creating distribution 

chart can be set for one data. 

Output CH 

Input CH. : Set the input channel. 

Output voltage : Set the maximum value for the output voltage. 

Input Value : Set an input value at the rated output. 

Rated output : Set a voltage corresponding to the input value. 

Calibration : Set the calibration value. 
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Frequency NO 

Input CH. : Set the input channel. 

Analysis method 

 : Set the method for frequency analysis. 

Full scale : Set the full scale. 

Hysteresis : Set the invalid amplitude. 

Sampling/Cross level 

 : Set the sampling time if you use a time-based analysis 

method, and set the cross level, if you use the 

maximum/minimum value method. 

Slice : Set the slice numbers of the positive and  

negative sides, respectively. 

 

Expanded CH 

Name  : Set the names of measurement system and result of 

calculation. 

Function  : Set the function of four arithmetic operation, power, 

trigonometric function, log, average, sum, rosette 

analysis and correction for temperature. 

Unit  : Set the unit of expanded CH data. 

Format  : Set the display format of expanded CH data. 

Alarm  : Set the alarm generation condition for expanded CH 

data. 

Option : Up to three points of coordinate for creating distribution 

chart can be set for one data. 

 Setting for Automatic Measurement 

Data Trigger Measurement:  

ON/OFF : Specify channels to perform data trigger measurement. 

Trigger level : Set the trigger level using a physical quantity 

Trigger mode : Select the trigger mode from [Relative], [Upper], and 

[Lower]. 

 

Program Measurement:  

Date/Time of start 

 : Set the date and time to start program measurement. 

Measurement time 

 : Set the duration of the program measurement. 

Halting time : Set the duration of the pause during program 

measurement. 

Number of measurements 

 : Set the number of measurements in program 

measurement. 

 

To perform the frequency 

analysis using this software, 

the instrument shall be 

equipped with the function of 

executing the frequency 

analysis (option). 
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Interval Measurement:  

Date/Time of start 

 : Set the date and time to start interval measurement. 

Interval : Set the interval for measurement. 

Condition : Set the control (infinity, repetition, GOTO) and number 

of times of repetition. 

Data Comparator Measurement:  

Name (CH/NO) : Set the channel number of input CH or data number of 

expanded CH setting. 

Variation : Measurement is performed every time when the relative 

variation is surpassed for previous measurement data. 

Condition : Set the control (infinity, repetition, GOTO) and number 

of times of repetition. 

◼ Measurement data 

Data list : A data list for single measurement is displayed. 

Chart list : A list of elapse diagram for single measurement is 

displayed. 

◼ History 

Measurement history 

 : File name of waveform data, date and time of 

measurement, test title and measurement time are 

displayed. 

You can edit the file name and test title on the sheet. 

Max/Min/Average 

 : The maximum, minimum and average values of each 

measurement data are displayed. 

Frequency history 

 : The frequency data file name, file name on the Memory 

card, date and time of start and stop of measurement, 

and test title are displayed. 

◼ Storage and loading of the Measurement project 

Measurement projects can be stored. You can load a stored measurement 

project to resume the measurement, or to use it for similar measurement. 

◼ Printing the Measurement project 

You can print out the data of channel setting (Input CH / Output CH / 

Frequency NO / Expanded CH), automatic measurement setting (Data trigger 

measurement / Program measurement/Interval measurement/Data 

comparator measurement), measurement data (data list / chart list), and 

history (measurement history / max/min/average values / frequency history / 

voice history) in the same format as they are displayed. 
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During Measurement: 

◼ Balance 

Perform zero-adjustment of the sensor. You can also select any channel to 

balance. 

The channel with balance invalid in the instrument setting cannot be 

balanced. 

◼ Setting of the Measurement mode 

You can choose from Manual measurement, Monitor measurement, Free run 

measurement, Data trigger measurement, Program measurement, Interval 

measurement and Data comparator measurement. 

◼ Offline measurement 

After the Free run measurement, Data trigger measurement, or Program 

measurement is started, you can close this software to perform offline 

measurement. You can obtain the data by online after the measurement. 

◼ Storage of Measurement data 

After measurement, measurement data are stored automatically at the same 

location as the stored measurement project file, in a data-storage folder of the 

name of the Project File name followed by "_DATA". 

For waveform data, the name of the measurement data file will be the capital 

"D" followed by the date data and time data. The extension is "tmrd". 

For frequency data, the file name will be the capitol "H" followed by the date 

data and time data, with the extension of "tmrh". 

You can change multiple file names of serial measurement data in one 

operation from the setting screen for measurement history. 

◼ The maximum number of Measurement data 

A measurement project can manage up to 50,000 measurement data. If the 

number of measurement data reached 50,000, user cannot measure anymore 

in that measurement project. In this case user has to make another 

measurement project. 

◼ Stopping storage of Measurement data 

It is possible not to store the measurement data. 

Even if measurement data is not stored, maximum, minimum and average 

values can be recorded in history. 

◼ Auto-deletion of memory data 

Data is deleted from the memory card after the data is acquired from the card 

during measurement. 

This prevents running out of free space on the memory card. 
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Data Processing 

◼ Tabulation 

You can display measurement data in a spread sheet format on the screen. 

◼ Chart plotting 

The scale can be changed. And there is an automatic scaling function. 

The chart can be drawn overlapping on other chart. 

 Chart types: 

Monitor chart : A chart of Monitor measurement data is plotted. 

You can plot the following charts: line monitor, elapse 

monitor, vertical-bar monitor, horizontal-bar monitor, 

X-distribution monitor, Y-distribution monitor, and 

frequency chart. 

Data chart : The chart of measurement data is drawn. 

Line chart, scatter chart and elapse diagram can be 

drawn. 

Frequency chart : The chart of frequency data is drawn. 

History chart  : Figures are drawn by setting the measurement date and 

time to horizontal axis and selecting maximum value, 

minimum value and average value. 

Spectrum chart : The chart of power spectrum or amplitude spectrum is 

drawn by selecting arbitrary one channel and 

implementing FFT analysis. 

The preparations for DC cut, trend cut, hamming 

window and hanning window are available. 

Blank form : The image, drawing and value monitor data can be laid 

out freely on a chart. 
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◼ Data file processing (edit, cutout, thinning out, conversion) 

Data editing : You can edit measurement data files freely. 

Data cutout : You can specify a range of the measurement data on the 

chart list using a cursor, in order to delete any 

unnecessary part or cutout any necessary part to use it. 

Thinning out of data 

 : You can thin out the data with any interval you wish. 

Data conversion : Data in a measurement data file can be converted into a 

text file. 

You can convert data into a text file of this software’s 

original format, CSV file, DRA-7610-compatible text 

file, or DADiSP-compatible text file. You can also 

convert more than one file continuously. 

Maximum/Minimum value search 

 : The maximum and minimum values among all data or 

within a selected range are searched. 

◼ Printing 

Measurement results can be printed out in a form of a table or chart list. 

You can print also charts. 

Charts can be printed in different sizes to suit the paper size. 

◼ Data restriction 

Maximum displayable floating-point number 

 : 3.402823466E+38 

Minimum normalized positive floating-point number 

 : 1.175494351E-38 
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3 Measurement project 

The Measurement project enables you to control various measurement settings 

and measurement results.  

Settings for measurement are categorized into the following four groups; Meter 

setting, A/D setting, Channel setting, and Automatic measurement setting. 

Control items of measurement results fall into two categories; Measurement 

data and History. 

 

3-1 Meter setting 

Specify the type and number of units and the interface to be used for 

measurement. 

You have to perform this setting always before starting measurement. 

 

3-2 A/D setting 

Specify the interval of data recording and the amount of data. 

You have to perform this setting always before starting measurement. 
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3-3 Channel setting 

Perform setting of each channel of the instrument and setting for data operation. 

Channel setting is composed of Input CH, Output CH, Frequency No and 

Expanded CH, which is selected depending on the content of setting. 

◼ Input CH 

Specify conditions for instrument to record data for each channel. 

You have to perform this setting before starting measurement. 

 

◼ Output CH 

Specify the voltage output for each channel when the voltage is output from 

the measurement instrument. 

Perform this setting only when you use a voltage output unit. 

 

◼ Frequency NO 

When frequency analysis is performed, you have to specify various items for 

each frequency number, including the channel number for frequency 

processing, analysis method, full scale, hysteresis, and slice number. 

The maximum frequency number is 80. 

 

To perform the frequency 

analysis using this software, 

the instrument shall be 

equipped with the function of 

executing the frequency 

analysis (option). 
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◼ Expanded CH 

Make a setting for implementing calculation using recorded data. 

The functions such as four arithmetic operations, arithmetical function and 

rosette calculation can be used. 

 

 

3-4 Automatic measurement setting 

Perform setting for automatic measurement and data recording. 

According to the condition to start measurement, it is divided in data trigger 

measurement, program measurement, interval measurement and data 

comparator measurement. 

 

◼ Data trigger measurement 

Specify the input signal level for the instrument to start measurement. 

 

◼ Program measurement 

Perform setting for program measurement. 
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◼ Interval measurement 

Make a setting for starting measurement at certain intervals using time of 

computer. 

 

◼ Data comparator measurement 

Make a setting for starting measurement with variation of specific channel 

(including expanded CH). 
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3-5 Measurement data 

A table list and an elapse chart list for the last-measured waveform are 

displayed. 

 

◼ Data list 

A table is generated including all the channels. 

Maximum, minimum, and average values are also shown. 

 

 

◼ Chart list 

An elapse chart is generated for each channel. 

Maximum, minimum, and average values are also shown. 
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3-6 History 

The history of the measurement result and the history of the maximum, 

minimum, and average values are displayed. 

 

◼ Measurement history 

The file information of waveform measurement are displayed in a list. 

You can change the file name or the test title collectively. 

Display of a data file as well as data conversion into a text file is possible. 

 

◼ Maximum/Minimum/Average 

The maximum, minimum, and average values of the past data are displayed 

in a list. 

 

◼ Frequency history 

The file information of frequency measurement are displayed in a list. 

You can change the file name or the test title collectively. 

Display of a data file as well as data conversion into a text file is possible. 

 

To perform the frequency 

analysis using this software, 

the instrument shall be 

equipped with the function of 

executing the frequency 

analysis (option). 
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4 Data file 

When you perform measurement using the measurement project, the result is 

recorded as a measurement data file automatically. 

 

You can perform the following processing:  

 

Data editing : You can edit measurement data files freely. 

Data cutout : You can specify a range of the measurement data on the 

chart list using a cursor, in order to delete any 

unnecessary part or cutout any necessary part to use it. 

Thinning out of data 

 : You can thin out the data with any interval you wish. 

Data conversion : Data in a measurement data file can be converted into a 

text file. 

Calculating data 

 : It is possible to set the expanded CH to calculate the 

data. 

 

4-1 Where to store data files 

When you save a measurement project file, a folder is created automatically at 

the same place as the "measurement project file_DATA". 

In this "_DATA" folder, a new folder will be created with "D" and time stamp 

every time waveform measurement is performed. 

(ex. 2017/Apr/06 13:00:00  D170406130000) 

In this new folder, a measurement data file with the same name as the folder 

(with the extension of "tmrd") is saved. 

Two or more files would have the same file name if the measurement is started 

at the same time. Therefore, a serial number (_1, _2....) is added at the end of 

the file name, in such a case. 

 

 

 

 

 

 

 

 

 

StartUp folder is created at the same time with the DATA folder. Chart files 

saved in this folder are displayed at the same time when the measurement 

project is loaded with this software. 

 

In case of frequency data, the file name will be a string consisting of a capital 

"H" followed by the date and time of measurement. The extension is "tmrh". 

Document folder 

Dynamic Test.tmrp（Measurement project file） 

Dynamic Test_DATA folder 

D170406130000 folder（Folder of the data measured at 13:00:00,Apr/06/2017） 

D170406130000.tmrd（Measurement data file） 

CH1（Data of channel1） 

CH2（Data of channel2） 

:  

:  

StartUp folder 
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4-2 Channel setting 

Setting of each channel at the time of measurement is recorded. 

 

◼ Input CH 

You can change the name, unit, and format only. 

 

◼ Expanded CH 

The setting of expanded CH can be edited even if a measurement was done. 

Its result will be reflected by performing recalculation. 

Each data file saves own calculation. Therefore if you want to change 

calculation of all files, you should change every files independently. 
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4-3 Measurement data 

The stored data is confirmed by data list and chart list. Editing, deleting and 

thinning-out of data are possible. 

 

◼ Data list 

A table is created including all the channels. 

Maximum, minimum, and average values are also shown. 

 

◼ Chart list 

An elapse chart is plotted for each channel. 

Maximum, minimum, and average values are also shown.. 
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4-4 Frequency data 

Setting at the time of frequency measurement and frequency data of each 

channel are displayed. 

 

◼ Input CH 

Conditions of the channels which were subjected to frequency analysis by 

the instrument are displayed. 

You cannot change any data except for the format. 

 

 

◼ Frequency data 

Result of frequency analysis of the channel specified by the frequency 

number is displayed. 

 

To perform the frequency 

analysis using this software, 

the instrument shall be 

equipped with the function of 

executing the frequency 

analysis (option). 
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5 Chart 

The chart is divided in two types; monitor chart that is drawn in real time and 

data chart that draws measurement data. 

 

5-1 Monitor chart 

When you perform monitor measurement referring to and using a Measurement 

project, the monitor chart is updated based on the current data collected from 

the measurement instrument. 

The update interval depends on the number of measurement point, number of 

chart and performance of the computer. 

 

A monitor chart can be of the following type:  

Line monitor : A line chart is plotted, with the data set on the horizontal 

and vertical axis. 

Elapse monitor : A chart is plotted, with data set on the vertical axis and 

the elapsed time of monitoring on the horizontal axis. 

Vertical-bar monitor 

 : A bar chart is plotted, with the data set on the vertical 

axis and the coordinates specified on the horizontal axis. 

Horizontal-bar monitor 

 : A bar chart is plotted, with the data set on the horizontal 

axis and the coordinates specified on the vertical axis. 

X-distribution monitor 

 : A distribution map is plotted, with the data set  

on the vertical axis and the coordinates specified on the 

horizontal axis. 

Y-distribution monitor 

 : A distribution map is plotted, with the data set  

on the horizontal axis and the coordinates specified on 

the vertical axis. 

Frequency monitor 

 : The collected data from the measurement instrument are 

monitored while measuring frequency. 

 

To perform the frequency 

analysis using this software, 

the instrument shall be 

equipped with the function of 

executing the frequency 

analysis (option). 
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5-2 Data chart 

When a measurement project is referred to, data chart is drawn by the latest 

measurement data. 

When a measurement data is referred to, data chart is drawn by its data. 

The data interval is based on A/D conversion setting at the time of the 

measurement. 

 

Following formats are available for data chart. 

Line  : Drawn with line by setting data for horizontal axis and 

vertical axis. 

Scatter : Drawn with dots by setting data for horizontal axis and 

vertical axis. 

Elapse diagram : This diagram is drawn by setting data for vertical axis 

and setting lapsed time of measurement for horizontal 

axis. 

History chart : This chart is drawn by setting the measurement date and 

time for horizontal axis and selecting maximum value, 

minimum value or average value for vertical axis. 

Only a measurement project can be referred to by this 

chart. 

Frequency chart 

 : The result of frequency analysis which was recorded in 

frequency data file is drawn. 

Spectral chart : The chart of power spectrum or amplitude spectrum for 

which FFT analysis is implemented is drawn by 

selecting arbitrary one channel. 

The preprocessing for DC cut, trend cut, hamming 

window and hanning window are available 

 

To perform the frequency 

analysis using this software, 

the instrument shall be 

equipped with the function of 

executing the frequency 

analysis (option). 
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This chapter explains icons which are used by this software, and start-up and 

exit operation of this software. 

 

1 Icons of this software 
Icons related to this software are following five types:  

 

 Program Icon of this software 
This is a program icon of this software. 

 

 Measurement project Icon 
This is an icon of a file where a Measurement project with measurement 

setting, A/D setting, channel setting, automatic measurement setting, etc. is 

stored. 

 

 Measurement data file Icon 
This is an icon of a file where measurement data (waveforms) are stored. 

 

 Frequency data file Icon 
This is an icon of a file where frequency data are stored. 

 

 Chart sheet Icon 
This is an icon of a file where charts are stored. 
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2 Start of this software 
You can start this program by clicking [Visual LOG] ― [TMR-7300] from the 

START menu, as shown below. 

 

Alternatively, you can start this software by double clicking the measurement 

project file, measurement data file or chart sheet file and open the specified file. 

 

When the software is started from the START menu, the Start up dialog box is 

displayed. 
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3 Start-up 
The Start up dialog box is the dialog box that is displayed first when this 

software is started up. 

 

You can create a new project file or open an existing file. 

 

Item description 

New Measurement Project 
 : New Measurement project is created. 

This is selected when this software is used for the first time or 

the measurement is newly started. 

Open File : Existing file (measurement project, measurement data, or chart) 

is opened. 

This is selected when the measurement is continued or the 

measurement results are post-processed. 

Open an Existing Measurement Project 
 : Up to four measurement files that are previously stored are 

displayed in reverse chronological order of update date. 

When the file name is clicked, the measurement project is 

displayed. 

The chart of StartUp is opened at the same time. 
 : When this item is checked, the chart sheet file in relevant 

StartUp folder is displayed at the same time when the 

measurement project is displayed. 

Close : The startup dialog box is closed. 
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4 Exit this software 
You can exit this software, by selecting Exit application from the File menu. 

If any change has been made after opening of the Measurement project, 

Measurement data file or Chart sheet, a dialog box is displayed to confirm if the 

changed file should be saved. 
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This chapter explains Measurement project settings, including Meter setting, 

A/D setting, Channel setting, Automatic measurement setting, Measurement 

data, and History. 

 

1 Switching the setting item of Measurement project 

Setting items can be switched by clicking the respective button located in the 

left side of the Measurement project. 

 

 

 

Meter setting 

 : Select this to perform selecting of unit to use and selecting an 

interface. 

A/D setting : Select this to perform setting of Analog-to-Digital conversion 

by the number of data and sampling clock. 

Channel setting 

 : Select this to perform setting of input CH, output CH, frequency 

NO, expanded CH and/or digital input/output. 

Auto measurement 

 : Select this to perform setting for Data trigger measurement, 

Program measurement, Interval measurement, and Data 

comparator measurement. 
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2 Setting of the instrument 

Set the number of units to use, type of the interface, and IP address and port 

number for the LAN interface. 

In addition, you can check the connection of interface, obtain information about 

the connected units, and/or change IP address of the instrument. 

 

2-1 Setting of connection conditions 

Click the "Meter setting..." button in the Measurement project. 

 

Setting items 

Control unit : Selects the instrument to use. (TMR-211 or TMR-311) 

Interface type 

 : Selects the interface to use. (LAN or USB) 

 

When using LAN: 

IP address : Sets the IP address of the instrument to use. 

Port number : Sets the port number of the instrument to use. 
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2-2 Confirmation of connection 

Communication with the instrument is done with the set contents of interface 

and information of the connected unit is obtained. 

 

Setting items 

Confirm : Confirms whether connection is possible with the contents of 

interface that is connected to the computer and the instrument. 

Acquisition of unit name 

 : This item is referred to when the "Confirm" button is clicked. 

If this checkbox is checked, unit information is updated by 

received data. 

If this box is unchecked, the confirmation dialog is displayed 

when unit information is different from received data. 

IP address change 

 : Changes LAN setting of the instrument. 

Refer to "Chapter 4: 2-3 IP address change of instrument 
from interface" (Page 4-4) for more detail. 
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2-3 IP address change of instrument from interface 

To change IP address of the instrument, communication with the instrument is 

necessary. Therefore, it is required to use USB or to make the instrument 

possible to be connected with LAN. 

 

Check "IP address change" and click the "Confirm" button. 

 

If connection is available, the IP address change dialog box is displayed. 

 

Setting items 

IP address : Sets IP address to be set to the instrument. 

Port number 

 : Sets port number to be set to the instrument. 

Subnet mask 

 : This is a value for distinguishing network address from IP 

address. 

Ordinarily done as well as computer setting. 

Default gateway 

 : Set IP address of router when the computer and the instrument 

have different network address. 

When the computer address and the instrument address are the 

same, communication is possible even if this option is not set. 

 

"Execute" button 

 : The set content is reflected to the instrument. 

 

In case of using the 

TMR-211, if firmware is older 

than Ver. 2.2A, IP address 

cannot be changed. 

In IP address, the part of 

255 for subnet mask is 

network address and the 

part of 0 is host address 

When selecting the 

TMR-311, setting of Subnet 

mask and Default gateway 

do not exist. 
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2-4 IP address change of instrument by configuration file 

If you cannot change IP address from interface, you can change it using 

configuration file. 

 

Select LAN from Interface Type, and input IP address and Port number for 

setting of instrument. 

 

Click the "Create..." button. The following dialog box is displayed. 

 

Setting items 

Subnet mask 

 : This is a value for distinguishing network address from IP 

address. Ordinarily done as well as computer setting. 

Option : Usually, communication is possible even if these items are not 

set. 

Workgroup : Set workgroup name for Windows network. 

Default gateway 

 : Set IP address of router when the computer and the instrument 

have different network address. 

Network : Set the host address part of the IP address of the computer as 0. 

Broadcast : Set the host address part of the IP address of the computer as 

255. 

"OK" button : Create configuration file with current setting. 

 

The Save as dialog will be displayed. Save the file without changing the file 

name from TMR_IPADDRESS. 

Copy the saved file into a memory card, and insert the memory card into the 

instrument. IP address will be changed after the instrument power is turned on 

again. 

When selecting the 

TMR-311, "Create 

TMR_IPADDRESS" dialog is 

not displayed. 

In IP address, the part of 

255 for subnet mask is 

network address and the 

part of 0 is host address. 
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3 A/D setting 

In A/D setting, the interval of data recording and number of data to be recorded 

in one measurement should be set. 

 

Click the "A/D setting..." button in the Measurement project. 

The dialog box for A/D setting is displayed. 

 

Setting items 

Data words : Specify the number of data to be recorded. 

When the conditions in the table below are satisfied, the number 

of data must be set equal to or less than the value shown in the 

table. 

 
High speed mode and/or 

memory card is not used 

Low speed mode and 

memory card is used 

TMR-211 TMR-311 TMR-211 TMR-311 

Up to 2CH 
10,000,000 

64,000,000 

10,000,000 

64,000,000 

Up to 4CH 32,000,000 32,000,000 

Up to 8CH 8,000,000 16,000,000 16,000,000 

Up to 16CH 4,000,000 8,000,000 

10,000,000 
Up to 32CH 2,000,000 4,000,000 

Up to 64CH 1,000,000 2,000,000 

Up to 80CH 800,000 1,600,000 

 

In the TMR-311, the sample clock can be set to less than 0.01 msec. 

In this case, the following restrictions are applied to the 

measurement conditions. 

 

 

 

 

 

 

 

Available unit1 
Number of channels per 

unit2 

Maximum number of 

storable data records 

TMR-362 

1CH 16,000,000 

2CH 8,000,000 

Up to 4CH 4,000,000 
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1Only measurement units that support sampling intervals shorter 
than 0.01 milliseconds can perform measurements at such intervals. 

If a unit that does not support this sampling rate is connected, all 
channels of that unit must be set to off before starting the 
measurement. 

 

2The maximum number of data records that can be configured is 
limited by the number of channels used per measurement unit.  

When multiple units are connected, the unit with the highest number 
of channels used will be referenced to determine the limit on the 
maximum number of data records. 

 

Pre data words 

 : For Data trigger measurement, specify the number of pre-trigger 

recording within the number of data words set above. 

Sample clock 

 : Set the interval of data recording in millisecond. 

The A/D conversion mode is either Low speed mode or High 

speed mode, depending on the setting of the sample clock and 

the number of measuring points. 

The following combination gets Low speed mode. 

TMR-211 TMR-311 

Number of 

measuring points 

Sample clock 

(msec) 

Number of 

measuring points 

Sample clock 

(msec) 

1 0.02～ 1～4 0.02～ 

2 0.03～ 5～6 0.04～ 

3～4 0.05～ 7～8 0.05～ 

5～8 0.1～ 9～16 0.1～ 

9～16 0.2～ 17～32 0.2～ 

17～24 0.3～ 33～48 0.3～ 

25～32 0.4～ 49～64 0.4～ 

33～40 0.5～,2048Hz 65～80 0.5～ 

41～48 0.6～   

49～56 0.7～   

57～64 0.8～   

65～72 0.9～   

73～80 1.0～,1024Hz   

 

External sampling 

 : The external sample can be used when SCLK is set in digital IN 

of Digital I/O unit. 

 

 

The external sample is valid when Digital I/O unit is used. 

 

For the External sample, 

refer to "Chapter 12: Digital 

I/O unit". 

When using the TMR-211, if 

firmware is older than 2.2A, 

instrument becomes low 

speed mode when sample 

clock is more than 1msec 

regardless of the number of 

measuring points. 



 
 

 4-8 

Find from measurement time. 

 : The A/D setting is set based on the measurement time. 

Measurement time 

 : Specify the time of measurement. Select the unit from; 

millisecond / second / minute / hour. 

Time before trigger 

 : For Data trigger measurement, specify the recording time until 

the trigger is activated within the measurement time set above. 

The time unit is as per the setting of the measurement time. 

 

The time before trigger and the pre data words are enabled only for data 

trigger measurement. 

 

Phenomenal 

 : The inverse number of the sample clock time is displayed. 

Sample clock can be set by selecting frequency. 

 

"Calculation" button 

 : Measurement time equivalent to the specified number of data is 

displayed. If you have specified the measurement time, the 

number of data equivalent to that time is displayed. 

The number of channels for high speed mode are indicated 

depending on sample clock. 

 

 

4 Input of the measurement title 

The title in the upper part of the Measurement project is modifiable arbitrarily. 

This title is used for the measurement data file. 

 

Enter a measurement title arbitrarily after selecting the upper part. 

 

The test title of measurement project is set for measurement data file. 

 

The unit set for the 

Measurement time is 

reflected to the unit of the 

elapsed time display and 

that of the horizontal axis of 

the chart displaying the 

progress during 

measurement. 

 

If TMR-211 firmware is older 

than Ver. 2.2A, 1024, 2048, 

4096 and 8192Hz cannot be 

set. 

 

Measurement title is output 

when printing and saving 

text. And it is copied to the 

chart when chart is made. 
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5 Channel setting 

Perform here setting of measurement. 

Click the "Channel setting" button in the Measurement project. 

 

Input CH : Set the following items: SET, Name, Input mode, Input range, 

Low-pass filter, High-pass filter, Balance, Reference junction, 

Calibration, Unit, Format, Alarm, and Option. 

Output CH : Set the following items: Input channel, Output voltage, Input 

value, Rated output, and Calibration value. 

Frequency NO 

 : Set the following items: Input channel, Analysis method, Full 

scale, Hysteresis, Sampling time/Cross level, and Slice number. 

Expanded CH 

 : Set the following items: Name, Function, Unit, Format, Alarm, 

and Option. 

 

5-1 Setting errors 

While you perform setting, the content of setting may be displayed in red. This 

red display denotes a setting error and occurs when you have changed the 

sample clock or instrument to a certain setting, though the condition does not 

allow such setting. 

Since you cannot proceed with the instrument setting as it is, correct the setting 

before starting measurement. 

 

5-2 How to select a setting item 

To select a setting item, move the mouse pointer on the cell which you want to 

set, and click . After that select an item from popup menu. 

 

To perform the frequency 

analysis using this software, 

the instrument shall be 

equipped with the function of 

executing the frequency 

analysis (option). 
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6 Input Channels 

Perform here setting of the input conditions for data recording by the 

instrument as well as setting for the recorded data to be processed by this 

software, for each channel. 

Select the Input CH from the "Channel setting" button menu. 

 

 

6-1 How to specify measurement channels to use 

Select between SET (to use) and OFF (not to use) for each channel. Channels 

set to SET are used for the measurement. 

 

Since no settings are sent to the channels set to OFF, it is not necessary to 

make settings for those channels. 
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6-2 How to assign a sequential number to the name 

You can assign sequential numbers to the names of multiple channels at one 

operation. 

You can also specify an additional letter, which is useful for measurement with 

2-axis gauge, 3-axis gauge, etc. 

When a new Measurement project is opened, sequential names are already 

assigned as shown below:  

 

Here we explain how to specify the name for 3-axis gauges: 

Select the name cells where you want to specify a name. If the cells have 

already a preset name, what you specify now will be added after the preset 

name. 

 

When you select Name... from the Project menu, the setting dialog box will 

be displayed. 

 

Select Consecutive NoXYZ for Concatenation number. The additional 

characters will be added, grouping the cells by three from the top. 

Set the remaining items as shown above, and click the "OK" button. 
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6-3 How to set the input mode 

Specify the type of the input signal (bridge voltage, voltage, or thermocouple). 

 

Some input modes may not be selectable, depending on the connected unit. For 

input modes which can be set, see the operation manual of the unit. 

 

The strain resolution will change with the setting of the bridge voltage:  

4G 0.5V : Resolution of 4×10-6 strain 

4G 2.0V : Resolution of 1×10-6 strain 
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6-4 How to set the input range 

Specify the input range. 

When the input range value is lower, the measured value becomes more stable. 

 

TMR-211 Strain Full Bridge 

Input 

range 

Input mode 

4G 2.0V 4G 0.5V VOLT (CR-4010) 

5000 -5,000～+5,000 (1×10-6) -20,000～+20,000 (4×10-6) -5,000～+5,000 (1mV) 

10000 -10,000～+10,000 (1×10-6) -40,000～+40,000 (4×10-6) -10,000～+10,000 (1mV) 

20000 -20,000～+20,000 (2×10-6) -80,000～+80,000 (8×10-6) -20,000～+20,000 (2mV) 

 

TMR-211 Voltage/Thermocouple 

Input 

range 

Input mode 

VOLT Thermocouple 

600  -200～+600 (0.1℃) 

1000 -1,000～+1,000 (0.1mV)  

1300  
-200～+1,300 (0.2℃) 

※Not usable with a thermocouple T. 

5000 -5,000～+5,000 (0.5mV)  
10000 -10,000～+10,000 (1mV)  
20000 -20,000～+20,000 (2mV)  

 

TMR-311 Strain Full Bridge 

Input 

range 

Input mode 

4G 2.0V 4G 0.5V VOLT (CR-4010) 

2000 -2,000～+2,000 (0.1×10-6) -8,000～+8,000 (0.4×10-6) -2,000～+2,000 (0.1mV) 

5000 -5,000～+5,000 (1×10-6) -20,000～+20,000 (4×10-6) -5,000～+5,000 (1mV) 

10000 -10,000～+10,000 (1×10-6) -40,000～+40,000 (4×10-6) -10,000～+10,000 (1mV) 

20000 -20,000～+20,000 (1×10-6) -80,000～+80,000 (4×10-6) -20,000～+20,000 (1mV) 

 

TMR-311 Voltage Input 

Input 

range 

Input mode 

VOLT Thermocouple 

600  -200～+600 (0.1℃) 

1000 -1,000～+1,000 (0.1mV)  

1300  
-200～+1,300 (0.2℃) 

※Not usable with a thermocouple T. 

5000 -5,000～+5,000 (0.5mV)  
10000 -10,000～+10,000 (1mV)  
20000 -20,000～+20,000 (2mV)  
52000 -52,000～+52,000 (5mV)  
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6-5 How to set the cutoff frequency of the low-pass filter 

Input signals with frequency higher than the specified frequency are attenuated 

by the digital filter. When the low pass filter is set to PASS(0), signals with 

frequency higher than 10kHz are attenuated by the analog filter. 

You cannot select anything other than PASS(0) for a thermocouple. 

 

 

6-6 How to set the frequency characteristic of the low-pass filter 

Specify the frequency characteristic for the low-pass filter from among Bessel 
(2nd), Butterworth (2nd), Bessel (8th), and Butterworth (8th). 

When the low-pass filter cutoff frequency is set to PASS(0), you cannot select 

anything but Bessel(2nd). 

 

Bessel (8th)/Butterworth (8th) can be used for Strain Full Bridge unit 

(TMR-221/TMR-321), Strain 1G2G4G unit (TMR-222/TMR-322), and Carrier 

type Strain Full Bridge unit (TMR-223/TMR-323). 

 

When the TMR-211 is used, its firmware version must be 2.2A or later and also 

the measurement unit (TMR-221/TMR-222) must be of version 1.2A or later. 
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6-7 How to set the cutoff frequency of the high-pass filter. 

Input signals with frequency lower than the specified frequency are attenuated 

by the digital filter. Select the frequency from among PASS, 0.2Hz and 1.0Hz. 

 

PASS : High-pass filter is not used. 

0.2 : Component of DC to 0.2Hz is rejected. 

1.0 : Component of DC to 1.0Hz is rejected. 

 

High-pass filter is available with Strain Full Bridge unit (TMR-221/TMR-321), 

Strain 1G2G4G unit (TMR-222/TMR-322), and Carrier type Strain Full Bridge 

unit (TMR-223/TMR-323). 

 

When the TMR-211 is used, its firmware version must be 2.2A or later and also 

the measurement unit (TMR-221/TMR-222) must be of version 1.2A or later. 

 

6-8 How to set balance 

Sets valid/invalid of balancing function of instrument. 

 

If TMR-211 firmware is older 
than Ver. 2.2A, Balance cannot 
be set. 
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6-9 How to set the reference junction 

With the Voltage/Thermocouple unit (TMR-231) or Thermocouple/Voltage unit 

(TMR-332), set the reference junction for measuring temperature. 

 

RJC OFF : An external reference junction is used. 

RJC ON : Built-in reference junction of the TMR-231 is used. 

 

6-10 How to set a coefficient 

Set a coefficient for each channel. 

If a value is entered in coefficient, both rated output and capacity become 

blank. 

 

 

6-11 Setting the coefficient by rated output and capacity of sensor 

You can set the sensor's rated output and capacity to set a corresponding 

coefficient automatically. The coefficient will be obtained by calculation 

"Capacity / Rated output". 
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6-12 How to set the shift amount 

A shift amount, which is specified from the data before multiplied by the 

coefficient, is added. 

Use this function to shift strain or voltage data beyond the balance range. 

 

 

6-13 How to set the unit 

A unit should be set for each channel. 

When the TMR-311 is used, you can set any string up to 10 characters. 

 

 

 

 

Shift amount may not be 

available for some functions 

of this software. For details, 

see “8 Frequency NO.” (Page 

4-22). 
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6-14 How to set the format for measurement data 

Set the display format and display digit number of the measurement data shown 

in the measurement data list and numeric value monitor. 

 

Value : Display measurement data as decimal representation. 

Exponent : Display measurement data as floating point representation. 

 

6-15 Setting the alarm value 

By configuring the alarm settings, you can output alarm sound or change the 

color of the value monitor during monitoring. 

 

ON/OFF : ON enables the alarm, and OFF disables it. 

Upper : Set upper-limit threshold 

Lower : Set lower-limit threshold 

 

6-16 How to set option data 

Option data are used as coordinate data for measurement data when plotting a 

distribution chart. If distribution chart is not plotted, you do not need to set this. 
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7 Output Channels 

With the Voltage Output unit (TMR-241/TMR-341), the measured data of any 

channels can be output as a voltage value. 

If the Voltage Output unit (TMR-241/TMR-341) is not used, settings for analog 

output are not necessary. 

 

Select the Output CH from the "Channel setting" button menu. 

 

When using the Voltage Output unit with this software, version 1.5A or later is 

needed in case of TMR-211, otherwise version 1.3A or later is needed in case of 

TMR-311. 

 

7-1 How to set the input channel 

Set channels of measurement data to use for voltage output. 

 

 

IN1 : Select channel for voltage output. 

If you don't need to output, set OFF to this option. 

IN2 to IN4 : When outputting voltage by adding or subtracting channels, 

select the channels for operation. 

If you don't need the operation, set OFF to this option. 
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7-2 How to set the output voltage 

Select the range of output voltage from among ±5V, ±10V, and 0 - +5V. 

 

The output voltage is set for each unit. And thus, if you change the 

voltage for one channel, the same setting applies not only to that 

channel but also to all the channels of the unit. 

 

7-3 Setting output sensitivity 

Set the sensitivity of voltage output by input value and rated output. 

 

Input value : When a value in the Input ch. becomes the value set in the 

Input Value, the value set in the Rated Output is output. 

The Input Value is set in physical quantity. 

When only the IN1 is set, the value of input signal is indicated 

in [ ]. 

Rated output 

 : Set a voltage output value for the input value by V unit. 
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7-4 How to set the calibration value 

Set a calibration value in physical quantity. 

 

In the [ ], a value corresponding to the input signal is displayed. 

If the input mode is Thermocouple, the display in the [ ] denotes a value in the 

unit of 0.1°C. For example, in case the display is [25], it shows a value 

corresponding to 2.5°C. 

 

Supposing that the Input Value is 200 and the Rated Output is 2V, when the 

Calibration value is set to 100 for example, calibration voltage of 1V is output 

by "plus calibration" and -1V is output by "minus calibration". 

 

For the output calibration, 

refer to "Chapter 5: 18 

Calibration of the voltage 

output". (Page 5-32) 
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8 Frequency NO. 

You can perform frequency measurement, by using the Histogram analysis 

library TMR-211-01/TMR-311-01. 

This software defines new frequency numbers from DN_1 to DN_80 for 

frequency measurement as Frequency NO. In order to perform a frequency 

measurement, you have to set an input channel, analysis method, hysteresis, 

sampling/cross level, and slice number for each frequency number. 

Frequency analysis requires that the sample clock is 1ms or longer. When 17 or 

more Frequency NO are used in a TMR-211 with firmware version of 1.2A or 

older, pay attention to the following restriction: 

1. The sample clock for A/D conversion should be 10ms or longer. 

2. The analysis method should be peak/valley method (PEAK/V) 

for all frequency numbers. 

 

If you do not perform any frequency measurement using the Histogram analysis 

library TMR-211-01/TMR-311-01, setting of the frequency NO is not 

necessary. 

 

Since the input CH shift amount is a software-specific function, the shift amount 

cannot use with this function, which performs frequency measurement in the 

measuring instrument. Please reset the shift amount of the input channel to 0 or 

set another input channel. 

 

Select the Frequency NO from the "Channel setting" button menu. 

 

 

8-1 How to set the input channel 

Select a channel to perform frequency measurement from among input 

channels, for each frequency number. 

 

 

To perform the frequency 

analysis using this software, 

the instrument shall be 

equipped with the function of 

executing the frequency 

analysis (option). 
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8-2 How to set the analysis method 

Set the analysis method for frequency measurement. 

 

PEAK/V : Peak/valley method 

MAX/MIN : Maximum/minimum method 

AMP : Amplitude method 

TIME : Time method 

LEVEL : Level-crossing method 

RAIN : Rain-flow method 

 

8-3 How to set the full scale 

Input the full scale in physical quantity. Inside the [ ], a value corresponding to 

the input signal is displayed. 

 

 

For the details of analysis 
method, refer to the 
operation manual of 
"Histogram analysis library". 
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8-4 How to set the hysteresis 

Input invalid amplitude in terms of the ratio to the full scale at one side (%FS). 

Inside the [ ], a value corresponding to the input signal is displayed. 

 

 

8-5 How to set the cross level 

If you use the maximum/minimum method for analysis, input a cross level in 

physical quantity. 

Inside the [ ], a value corresponding to the input signal is displayed. 

 

 

8-6 How to set the sampling time 

If you use the time method for analysis, set the sampling time. 
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8-7 How to set the slice number 

Set the slice number for the positive side and for the negative side, respectively. 

You cannot set such slice numbers which result in the total exceeding 100. 

In the Amplitude method and Rain-flow method, the slice number of the 

negative side is fixed at 0. 
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9 Expanded CH 

It is possible to execute the calculation for each measurement based on the 

arbitrary set arithmetic expression. The calculation result can be processed as a 

measurement data. 

The maximum number of Expanded channel is 1000 points. 

 

Set the name, arithmetic expression, unit, format, alarm, and option data. 

 

Select Expanded CH from the "Channel setting" button menu. 

 

 

9-1 Assigning the sequential number to name 

You can assign sequential numbers to the names of multiple channels at one 

operation. 

You can also specify an additional letter, which is useful for measurement with 

2-axis gauge, 3-axis gauge, etc. 

 

Refer to "Chapter 4: 6-2 How to assign a sequential number to the name" 

(Page 4-11) for more detail. 
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9-2 Setting the arithmetic expression 

For setting the arithmetic expression of measurement data, a function is used. It 

is set by inputting from keyboard or pasting function. 

 

◼ How to input it by pasting function 

Click the cell for which the function is input. 

 

Select the Paste function... of Project menu. 

 

Select the function from Function name list. When "OK" button is clicked, 

the selected function is set to Measurement project. 

At this time, for the function that requires argument, move the cursor within 

the bracket and set the argument. When there is an error for input, display is 

changed to error display. 

 

[List of arithmetic expression error] 

Error1 
Function is not correct. Or, arithmetic expression is 
not correct 

Error2 - - - 

Error3 ( ) is not matched 

Error4 
Input of argument is not matched with specification 
(exceeding maximum or minimum value) 

Error5 
The data No. of cell that is set when the data No. is 
used by argument is used as argument 

Error6 The number of argument is different 

Error7 Argument is not proper (for example, character etc.) 

Trigonometric function, log, time, 2-axis and 3-axis calculation etc. can be used 

in arithmetic expressions in addition to the four arithmetic operations (+,-,*,/), 

power (^), and bracket. 
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9-3 Setting the unit 

Select a unit for an Expanded CH from menu. Also it can be entered directly 

from the keyboard. 

 

 

 

 

 

9-4 Setting the format of Expanded channel data 

Set the display format and display digit number of the Expanded channel data 

shown in the measurement data list and numeric value monitor. 

 

Value : Display Expanded channel data as decimal representation. 

Exponent : Display Expanded channel data as floating point representation. 
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9-5 Setting the alarm value 

By configuring the alarm settings, you can output alarm sound or change the 

color of the value monitor during monitoring. 

 

ON/OFF : ON enables the alarm, and OFF disables it. 

Upper : Set upper-limit threshold 

Lower : Set lower-limit threshold 

 

9-6 Setting the option data 

The option data are used as coordinate data for Expanded channel data when 

plotting a distribution chart. If distribution chart is not plotted, you do not need 

to set this. 
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10 Setting for Automatic measurement 

Perform setting for automatic measurement. 

Click the "Auto measurement" button in the Measurement project. 

 

This software supports four kind of automatic measurement; Data trigger 

measurement, Program measurement, Interval measurement, and Data 

comparator measurement. If these measurements are not used, you do not need 

to set anything for them. 

 

For more information of each automatic measurement: 

Refer to "Chapter 5: 8 Data trigger measurement" (Page 5-11). 

Refer to "Chapter 5: 9 Program measurement" (Page 5-15). 

Refer to "Chapter 5: 10 Interval measurement" (Page 5-18). 

Refer to "Chapter 5: 11 Data comparator measurement" (Page 5-21). 

Refer to "Chapter 12: 4 Cycle trigger measurement" (Page 12-6). 
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11 Saving a measurement project 

You can save a measurement project by selecting Save or Save As... from the 

File menu. 

 

Save : When a project is saved for the first time, a dialog box appears 

to input the measurement project name and to specify where to 

store it. Once saved, a Measurement project is overwritten with 

the same name. 

Save As... : A dialog box appears always so as to enable input of the 

measurement project name and specification of the location to 

store it. 

 

 

When saving with a different name, the project cannot be saved if there is 

already the same name in the specified folder. Rename it or change the location 

to save it. 

 

Use a storage with sufficient free space, because measurement data requires a 

big capacity. 

Rough size of a measurement data file can be calculated as follows, as a 

guideline:  

 (Number of channels used) x Number of data in single measurement x 4byte 

For example, if you set the [channels to use] to "20 channels" and perform 

measurement of 500,000 words, the size will be:  

 20 * 500,000 * 4 = 40,000,000bytes 

i.e. about 38 megabytes. 

Actual size may be a little larger because settings and some other information 

are recorded. 

 

 
 

 



 
 

 4-32 

12 Creating instrument setting file 

Setting on instrument can be saved in a file and then reflected to the instrument 

using a display unit of the instrument. 

 

Select Creating instrument setting file... from File menu. A dialog box is 

displayed. Save the file with file name designated by alphanumeric characters. 

 

You cannot use a double-byte character set (i.e. Chinese, Japanese, Korean, 

etc.) in file name. 

 

◼ Instructions for TMR-211 

Move the saved file to memory card, and insert the memory card into the 

instrument. 

Touch the button on the display unit in the following order. 

[To menu] > [ETC] > [Loading and saving of setting file] 

Select the moved setting file, and touch the [Load] button to start to read the 

file. 

 

◼ Instructions for TMR-311 

Move the saved file to the "Lot number/SET" folder of the memory card, and 

insert the memory card into the instrument. 

Touch the button on the display unit in the following order. 

[MENU] > [etc.] > [Setting file] 

Select the moved setting file, and touch the [START] button to start to read the 

file. 

 

 

 

 

If the firmware version of 
TMR - 211 is older than 2.2A 
or the firmware version of 
TMR - 311 is older than 
1.4A, then it cannot load the 
setting file. 
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This chapter explains each measurement method. 

 

1 How to display the Measurement panel 
By displaying the measurement panel, communication with instrument is 

established, and measurement data acquisition and real time data monitoring 

become possible. 

 

Save the Measurement project before displaying the Measurement panel. If you 

try to display the Measurement panel without saving, the saving dialog box is 

displayed. 

 

Select Show Measurement panel... from the Measurement menu, the 

following dialog box is displayed. 

 

"Transmit the setup information to the instrument" 
 : The settings in measurement project are reflected to the 

instrument. 

"Receive the channel information in SET from the instrument" 
 : The settings set in the instrument such as channel condition and 

A/D setting are imported into the measurement project. 

Select either one of above, and click the "OK" button to display the 

Measurement panel. 

 

When a High-speed mode instrument is connected, the title of the Measurement 

panel is displayed as follows. 
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1-1 Memory card state indicator 
When the Measurement panel is displayed, the state of memory card which is 

inserted in instrument appears on the tool bar. 

If the memory card has enough space for measurement, it displays the 

percentage of free space. 

 

◼ The yellow message appears when no memory card is installed. 

 

 

◼ The red message appears when a memory card is installed but unable 
to record data. 
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2 How to balance 
Before starting measurement, you can execute zero balancing of the sensor. 

 

Select Balance... from the Measurement menu. The confirmation dialog box 

is displayed. 

 

Setting items 

If the channel of strain exceeds the range of balance, current value is 
recorded in the shift to set channel condition. 
 : For the channel of strain that exceeds the balance range of 

measurement system, the value does not become 0. When this 

item is enabled, the current value is recorded in the shift cell of 

the input CH of the Measurement project that is referenced, and 

it becomes 0 by calculation. 

Left list : The list of channels for which balancing is possible is displayed. 

The channel set invalid in the input CH setting is not indicated. 

Right list : The list of channels for which balancing is executed is 

displayed. 

"Register>>" button 
 : The data selected from left data is registered in right list. 

"Register All" button 
 : Every data in left list is registered in right list. 

"Release" button 
 : The data selected from right list is deleted from list. 

"Release All" button 
 : Every data registered in right list is deleted. 

When the data to be balanced is selected from left list and "Register>>" button 

is clicked, it is displayed in right list. 

When the zero balancing can be implemented, click "Execute" button. 

 

If you execute zero balancing for channels in Voltage/Thermocouple unit 

(TMR-231), Voltage Input unit (TMR-331) or Thermocouple/Voltage unit 

(TMR-332), current value is recorded in the Shift cell of each input channel of 

the referring Measurement project. 
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3 Monitor measurement 
Current data are displayed on the Measurement panel during measurement on 

real time. 

 

3-1 Setting of the monitor data on the Measurement panel 
Click the "Set monitor" button on the Measurement panel for selecting monitor 

channels. 

 

 

Setting items 

Left list : The list of channels for which monitor measurement is possible 

is displayed. 

Right list : A list of data to be monitored is displayed. 

The "Register>>", "Register All", "Release", and "Release 
All" buttons are used for selecting channels. 

"Register>>" button 
 : The data selected from left data is registered in right list. 

"Register All" button 
 : Every data in left list is registered in right list. 

"Release" button 
 : The data selected from right list is deleted from list. 

"Release All" button 
 : Every data registered in right list is deleted. 

 

When the data for which monitor measurement is implemented is selected from 

left list and "Register>>"button is clicked, it is displayed in right list. 

After the registration is implemented, click "OK" button. 
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3-2 Setting of the monitor display position 
Click the "Set monitor" button on the Measurement panel for specifying the 

monitor display position. 

 

 

Setting items 

In the Measurement panel 
 : The monitor value is displayed in Measurement panel. 

No display : The monitor value is not displayed. The size of Measurement 

panel gets smaller. 

Monitor panel display 
 : Monitor panel is displayed in addition to the Measurement 

panel. Monitor value is displayed in the Monitor panel and the 

size of Measurement panel gets smaller. 

 

3-3 Setting of the monitor display color 
Click the "Set monitor" button on the Measurement panel for specifying the 

color of monitor display. 

 

 

Setting items 

Color of character 
 : Specify the color of character of monitor display. 

Color of background 
 : Specify the background color of monitor display. 

Size of character 
 : Specify the character size when the monitor is displayed in 

monitor panel. 
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3-4 Setting of the peak data 
Click the "Set monitor" button on the Measurement panel for setting a peak 

data. 

 

 

Setting items 

Display : The maximum and minimum peak data is displayed. 

Automatic reset 
 : The peak data is reset in the specified time intervals. 

Reset at the start of measurement 
 : The peak data is reset when the measurement is started. 

 

When you want to reset the peak data manually, click the "P.R" (Peak Reset) 

button on the Measurement panel. 

 

 

3-5 Start of monitor measurement 
Click the "Monitor" button on the Measurement panel for starting the monitor 

measurement. 

 

Click the "Monitor" button once again to cancel the monitor measurement 

status. 
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4 How to set the recording data 
Select which data to record on the memory card during measurement from; 

Waveform + Frequency data, Waveform data only, and Frequency data 
only. 

Selection is not possible, if no input channel is set for the frequency No. in the 

Measurement project setting, or if sample clock restriction, etc. prevents 

frequency analysis. 

 

Select Setting recording data... from the Measurement menu for selecting 

recording data. 

 

Setting items 

Waveform + Frequency data 
 : Waveform and frequency data are recorded simultaneously. 

Waveform data only 
 : Only waveform data are recorded. 

Frequency data only 
 : Only frequency data are recorded. 

 

The display of the "Start measurement" button on the Measurement panel 

changes depending on the selected recording data. 

◼ When Waveform + Frequency data is selected 

 

◼ When Waveform data only is selected 

 

◼ When Frequency data only is selected 

 

To perform the frequency 
analysis using this software, 
the instrument shall be 
equipped with the function of 
executing the frequency 
analysis (option). 
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5 Manual measurement 
A measurement is performed once at any time you wish. 

 

5-1 Start of manual measurement 
Click the "Start measurement" button on the Measurement panel for starting 

the manual measurement. 

 

The start time, finish time, and elapsed time of the measurement are displayed 

on the Trigger status bar. 

 

On completion of the measurement, the measurement data is transmitted from 

the instrument to computer. 

 

When all data processing is completed, a data file is created. 

 

◼ Measurement time in case the setting requires recording of frequency 
data 

Waveform + frequency data 
 : Waveforms and frequency are measured during the 

measurement time set in A/D setting. 

Frequency data only 

 : Frequency measurement is during the measurement time set in 

A/D setting. 

 

To perform the frequency 
analysis using this software, 
the instrument shall be 
equipped with the function of 
executing the frequency 
analysis (option). 
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6 Stop of manual measurement 
To stop manual measurement, click the "Stop measurement" button on the 

Measurement panel. 

 

When measurement is stopped, the measurement data is transmitted from the 

instrument to computer. 

 

When all data processing is completed, a data file is created. 

 

When some automatic measurement is performed, the dialog box to confirm 

whether the automatic measurement is continued is displayed. 

 

When "Yes" button is clicked, every automatic measurement is terminated. 

When "No" button is clicked, the automatic measurement continues. 

 

By closing the measurement panel during measuring, Offline measurement will 

be started. 

Refer to "Chapter 5: 12 Offline measurement" (Page 5-24) for offline 

measurement. 

 

Interval measurement and Data comparator measurement are unavailable to 

use as offline measurement. 
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7 Free run measurement 
Measurement is repeated until the "Stop measurement" button is clicked or 

the capacity of the memory card is reached. 

 

You cannot perform free run when measuring in High-speed mode, or when a 

memory card is not inserted. 

Measurement time must be at least 10 seconds. 

 

7-1 Start of free run measurement 
Click the Free run... from "Auto measurement" button menu on the 

Measurement panel. 

 

 

Click the "Start" button to start free run measurement. 

If you click the "Waiting" button, the instruments waits to start measurement 

until the "Start measurement" button on the Measurement panel is clicked. 

 

◼ Measurement time in case the setting requires recording of frequency 
data 

Waveform + frequency data 
 : Frequency analysis is performed continuously till free-run 

measurement is stopped. That means, one free-run measurement 

creates one frequency data file. 

Frequency data only 
 : Frequency measurement is continued till you stop it manually. 

 

 

7-2 Stop of free run measurement 
To stop free run measurement, click the "Stop measurement" button on the 

Measurement panel. 

 

To perform the frequency 
analysis using this software, 
the instrument shall be 
equipped with the function of 
executing the frequency 
analysis (option). 

When recording the 
frequency data, the 
frequency data file will be 
created only once because 
frequency analysis works 
until measurement is 
stopped. 
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8 Data trigger measurement 
The instrument judges input signals based on the setting of the trigger level and 

trigger mode of the channel to perform automatic measurement. 

 

8-1 Setting of the trigger mode and trigger level 
Click the Data trigger measurement from "Auto measurement" button 

menu on the Measurement panel. 

 

Setting items 

ON/OFF : Turn ON the channel that is the target of data trigger 

measurement. 

When the SET is set to OFF, trigger measurement is not started 

even if the channel is set to ON. 

Trigger level 
 : Input the trigger level by physical quantity. In [ ], the value 

equivalent to input signal is displayed. 

Trigger mode 
 : Select the trigger mode from Relative, Upper and Lower. 
Relative : The measured value when starting the data trigger measurement 

is taken as a reference value. Trigger measurement is started 

when the measured value changes by the trigger level from the 

reference value. 

Upper : When the measurement value exceeds the trigger level, trigger 

measurement is started. 

Lower : When the measurement value drops below the trigger level, 

trigger measurement is started. 

 

If a - (negative) polarity is set as a calibration coefficient, the polarity of the 

physical quantity of the trigger level and that of the value in [ ] is reversed. If 

you perform data trigger measurement in this condition, the trigger value that 

is judged from input signal by instrument does not correspond to the value that 

is judged from data of physical quantity. Please pay sufficient attention to it in 

setting. 

 

If frequency data are included in the recording data, data trigger measurement 

cannot be performed. 
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8-2 Example of Data trigger measurement 
◼ When the trigger mode is set to Relative and the trigger level is set to a 

positive value. 

 

In the above setting, measurement is performed, when the measurement data 

has changed by +100 from the measurement value at the start of data trigger 

measurement. 

0
50

100
150

-150
-100
-50

Data Trigger measurement start

: Trigger Point

Trigger Level

+100

 

◼ When the trigger mode is set to Relative and the trigger level is set to a 
negative value. 

 

In the above setting, measurement is performed, when the measurement data 

has changed by -100 from the measurement value at the start of data trigger 

measurement. 

0
50

100
150

-150
-100
-50

Data Trigger measurement start

: Trigger Point

Trigger Level

-100
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◼ When the trigger mode is set to Upper 

 

In the above setting, measurement is performed when the measurement data 

has exceeded +100. 

0
50

100
150

-150
-100
-50

Data Trigger measurement start

:Trigger Point

Trigger Level

 

 

◼ When the trigger mode is set to Lower 

 

In the above setting, measurement is performed when the measurement data 

has gone below -100. 

0
50

100
150

-150
-100
-50

Data Trigger measurement start

:Trigger Point

Trigger Lebel
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8-3 Start of Data trigger measurement 
Click the Data trigger... from "Auto measurement" button menu on the 

Measurement panel. 

 

 

In case of clicking the "1 time" button, the data trigger measurement will be 

executed only once. 

In case of clicking the "Continue" button, the data trigger measurement will 

be executed, then becomes waiting state. 

 

8-4 Stop of Data trigger measurement 
To stop data trigger measurement, click the Data trigger... from "Auto 
measurement" button menu on the Measurement panel. 

 

Refer to "Chapter 5: 6 Stop of manual measurement" (Page 5-9) for 

stopping the measurement. 
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9 Program measurement 
Program measurement is performed at the specified time and with the specified 

interval. 

 

If no memory card is inserted, you cannot start program measurement. 

 

9-1 Setting the program measurement 
Select the Program measurement in Auto measurement setting of the 

Measurement project. 

 

Setting items 

Date/Time of start 
 : Set the date and time to start measurement. 

Measurement time 
 : Set the measurement time. 

If this setting time is longer than the one set for the A/D 

conversion setting: 

In low-speed mode, measurement is performed in the same way 

as free run measurement. 

In high-speed mode, measurement is performed only for the 

time of A/D conversion setting. 

Halting time : Set the time to pause measurement until the next measurement 

is started. 

The number of measurements 
 : Set the number to repeat measurement. 

 

◼ In case the setting requires recording of frequency data 
Waveform + frequency data and Frequency data only 

 : Frequency analysis is performed from the measurement start 

time for the duration of the measurement time. As many 

frequency data files as necessary for the specified number of 

measurements are created. 

 

If lack of space on memory card occurs, waveform data will not be recorded. 

However frequency data will be created continuously until the memory card 

becomes full. 

 

Even if the time has come to start the next measurement while the measurement 

instrument is writing data to memory card, new measurement will not be 

started. 
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9-2 Example of Program measurement setting 
◼ If measurement is performed from the specified start date/time for the 

specified measurement time: 

 

Measurement is started at 14:00:00 on October 12, and finished at 16:30:00 

on October 12. 

 

◼ If interval measurement is performed from the specified start date/time 
for a specified number of times 

 

One hour measurement is performed from 14:00:00 on October 12, and 

pauses 1 hour and 30 minutes. This series of operation is repeated twice. 

 

◼ If measurement is performed for the specified time from the start of 
program measurement 

 

Measurement is performed for three hours from the start of program 

measurement. 
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If interval measurement is performed from the start of program measurement. 

 

One hour measurement is performed at the start of program measurement, and 

then comes a pause of 1 hour and 30 minutes. This series of operation is 

repeated twice. 

 

9-3 Start of Program measurement 
To start program measurement, click the Program from "Auto measurement" 
button menu on the Measurement panel. 

 

 

9-4 Stop of Program measurement 
To stop program measurement, click the "Stop measurement" button on the 

Measurement panel. 

Refer to "Chapter 5: 6 Stop of manual measurement" (Page 5-9) for 

stopping the measurement. 
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10 Interval measurement 
The measurement is automatically performed with set time and interval. 

The interval measurement is executed in order from step 1 to step 100. If the 

next interval cannot be calculated, the measurement is terminated. 

 

10-1 Setting the interval measurement time 
Click the Interval measurement from "Auto measurement" button menu on 

the Measurement panel. 

 

Setting items 

Date/Time of start 
 : Set the year, month, day and time to start the interval 

measurement. 

When it is not set, the time when the interval measurement is 

started or when the previous step is terminated is the 

measurement start time. 

When the year, month and day are omitted, the measurement is 

started from the set time. 

Interval  : Set it within hour (1 to 1000), minute (1 to 59) and second (1 to 

59). If the measurement start time has already passed, 

measurement is performed at the relevant time calculated from 

the measurement start time. 

Condition : The control is selected from INFINITY, REPEAT and GOTO. 

INFINITY : Measurement is performed until the measurement is stopped 

manually. 

REPEAT : Measurement is repeated for the number of times that is 

specified by Repeat. 
GOTO : It shifts to the step that is specified by Repeat. Measurement 

start time and measurement interval are ignored. 
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10-2 Example of Interval measurement setting 
◼ When the measurement is performed at specified intervals from the 

start time 

 

With the setting shown in the figure above, the measurement is performed 13 

times at 5 minutes intervals from 14:00:00 on 2017/7/3, and the measurement 

is performed at one hour intervals from 15:00:00 on 2017/7/3. 

 

◼ When the measurement is performed twice a day at fixed time 

 

With the setting shown in the figure above, the measurement is performed once 

at 08:00:00 after starring interval measurement, and next, measurement is 

performed once at 17:00:00, then returning to step 1 again and the measurement 

is performed at next 08:00:00. After that, the measurement is repeated until the 

interval measurement is terminated manually. 

 

When the interval 
measurement is started at 
between 8:00 and 17:00, 
take note that the 
measurement is not 
performed at 17:00 on that 
day. In that case, set 
17:00:00 and 8:00:00 to step 
1 and step 2, respectively. 
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10-3 Start of Interval measurement 
For starting the interval measurement, click the Interval from "Auto 
measurement" button menu of Measurement panel. 

 

 

10-4 Stop of Interval measurement 
To stop the interval measurement, click the Interval from "Auto 
measurement" button menu on the Measurement panel. 

 

Refer to "Chapter 5: 6 Stop of manual measurement" (Page 5-9) for 

stopping the measurement. 
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11 Data comparator measurement 
Every time when the measurement data for which relative variation is set 

reaches the relative variation, the automatic measurement is performed. 

The data comparator measurement is executed in order from step 1 to step 100. 

When the next variation cannot be calculated, the measurement is terminated. 

 

11-1 Setting the data comparator measurement 
Click the Data comparator measurement from "Auto measurement" button 

menu on the Measurement panel. 

 

Setting items 

Name (CH/NO) 
 : Input the channel number which is used for the data comparator 

measurement. Or select data from the dialog box which is 

displayed by double clicking. 

When inputting the number of extended CH, input it by adding 

500 to number of NO. For example, NO1 is input as 501. 

 

Variation : Input the relative variation in physical quantity. 

Condition : The control is selected from INFINITY, REPEAT and GOTO. 

INFINITY : The measurement is performed until the measurement is 

stopped manually. 

REPEAT : The measurement is repeated for the number of times that is 

specified by Repeat. 
GOTO : It shifts to the step that is specified by Repeat. The Name and 

Variation are ignored. 
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11-2 Example of Data comparator measurement 

 

◼ When [Setting the current value to reference value] 

 

◼ When [Setting the reference value to 0] 

 

When the variation of measurement data is greater than variation that is set for 

data comparator, the measurement may be skipped. When the measurement 

value exceeds 2kN immediately after the measurement shown in the figure 

above is started, the measurement with 1kN is not performed and the 

measurement with 2kN is performed. At this time, the number of repetitions is 

judged as twice measurements, so measurements are performed three times 

after that, and the data comparator measurement is terminated. 
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11-3 Start of Data comparator measurement 
For starting the data comparator measurement, click the Data comparator... 
from "Auto measurement" button menu on the Measurement panel. 

 

 

Select either "Set current value as reference value" or "Set 0 for reference 
value" for reference value, then click "Start" for starting Data comparator 

measurement. 

 

11-4 Stop of Data comparator measurement 
To stop the data comparator measurement, click the Data comparator... from 

"Auto measurement" button menu on the Measurement panel. 

 

Refer to "Chapter 5: 6 Stop of manual measurement" (Page 5-9) for 

stopping the measurement. 
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12 Offline measurement 
After automatic measurement is started, measurement continues by instrument 

itself even if a connection between computer and instrument is disconnected. 

This is called "Offline measurement". 

 

Interval measurement and Data comparator measurement are unavailable to 

use as offline measurement. 

In case of using TMR-211, its firmware should be 2.2A or later. If not so, Data 

trigger measurement cannot be used for this function. 

Offline measurement needs a memory card inserted into the instrument. 

 

12-1 Start of Offline measurement 
Start automatic measurement of Free run measurement, Data trigger 

measurement, or Program measurement. 

 

The connection between computer and instrument is disconnected by closing 

the Measurement panel. The first dialog box appears for closing panel. Select 

"Yes". Then next dialog box appears for stopping the current measurement. 

Select "No". 

  

Select "Yes"    ⇒  Select "No" 

 

12-2 Obtain the data of Offline measurement 
The measurement data is recorded to the memory card by offline measurement. 

You can obtain this data by two ways of following methods. 

 

◼ Reads memory card data via interface 
Refer to "Chapter 5: 16 Reading memory card data" (Page 5-30) for more 

detail. 

 

◼ Reads memory card data directly 
Refer to "Chapter 7: 6 Reading instrument data" (Page 7-20) for more 

detail. 
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13 Alarm function 
When the measurement data exceeds the alarm upper or lower limits, the alarm 

is sounded and the data name is displayed in alarm panel. 

 

13-1 Setting the alarm level 
The alarm upper and lower limits are set in Input CH or Expanded CH in the 

Measurement project. 

 

With the setting shown in the figure above, the alarm is generated when the 

value of measurement data of either CH1 or CH2 exceeds +50 or drops below 

-50. 

 

◼ The example of behavior that has been set +50 for upper limit and -50 
for lower limit. 

 

 

Refer to "Chapter 4: 6-15 
Setting the alarm value" 
(Page 4-18) or "Chapter 4: 
9-5 Setting the alarm value" 
(Page 4-29) for setting. 
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13-2 Starting the alarm display 
When Show alarm is selected from the Alarm submenu of the Measurement 
menu, the alarm panel is displayed. 

 

When monitor measurement is started, the alarm judgement is also started. If 

the measurement data exceeds the limit, channel information will be displayed 

on the alarm panel. 

 

Setting items 

"Show alarm condition" button 
 : The alarm condition of selected row is displayed. 

"Release output" button 
 : All alarm outputs are released. 

Even if the alarm outputs are released, an alarm is output again 

during a monitor measurement if the alarm condition is met. 
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13-3 Changing the alarm operation 
It is possible to change the method to reset the alarm output and alarm sound 

that is sounded when the alarm is generated. 

 

Select Alarm setting... from Alarm submenu of Measurement menu. 

 

Setting items 

Reset the alarm output level to fit the data 
 : When the monitor data changes to the value out of the alarm 

judgment, the alarm is released. 

If not checked, user should stop the alarm manually by clicking 

the "Release output" button. 

 

When an input signal exceeds the limit and returns immediately, displayed 

alarm data may not exceed the alarm level. 

 

Turn on the alarm 
 : It enables to play alarm from computer. 

 Button : Sound is played. 

Specify the sound 
 : The sound file specified by "Browse..." button is set to alarm 

sound. 

"Browse..." button 
 : Click this button when selecting the sound file to be used. 

 
When "Browse..." button is clicked, the dialog box to select 

sound file is displayed. 

 
Select the sound file to be used and click "Open" button. 

Measurement 
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14 Disabling the automatic save of data 
When it is not necessary to record the measurement data to computer, it is 

possible to disable the function of automatic save. 

 

It is not possible to change the setting of measurement data automatic save 

while the measurement panel is displayed. 

 

Even if you disable the automatic save, the measurement data will be saved to 

the memory card in the instrument. 

If "Auto-deletion of memory card data" function is enabled, the measurement 

data will not be saved to the memory card. 

 

Select Automatically save data from the Measurement menu. 

 

Setting items 

Disable automatic saving 
 : After measurement, the data is not saved to computer. 

Record data in Measurement history (Waveform data) 
 : When the automatic save is disabled, the maximum, minimum 

and average values are recorded in measurement history. 

 

If both "Disable automatic saving" and "Record data (Wave data) in 
Measurement history" are checked, the column of file name of measurement 

history will become blank. 

 

 



Chapter 5 Measurement 

 5-29 

15 Auto-deletion of memory card data 
The data file which is automatically acquired after measurement is deleted from 

the memory card to prevent running out of free space on the card. 

 

Select Automatically deleting memory card data... from the Measurement 
menu. 

 

Setting items 

Delete after getting the measuring data 
 : The data file which is automatically acquired after measurement 

is deleted from the memory card. 
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16 Reading memory card data 
You can load the measurement data from memory card to computer via 

interface. 

 

Select Reading memory card data... from the Measurement menu. 

 

Setting items 

Waveform data / Frequency data / Voice 
 : Select the type of data file to display in list. 

Use the coefficient, unit and format of file 
 : If you check this box, the settings of coefficient, unit and format 

included in the specified folder are applied for reading 

waveform data. If there are no such data, the setting of the 

Measurement project is used. 

Left list : The measurement data which are recorded in the memory card 

are listed. 

Right list : The measurement data to read are listed. Select the data to read 

using Register button and Release button. 

"Register" button 
 : The data selected from left data is registered in right list. 

"Release" button 
 : The measurement data selected from right list is deleted from 

list. 

 

To perform the frequency 
analysis using this software, 
the instrument shall be 
equipped with the function of 
executing the frequency 
analysis (option). 
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17 Deletion of selected memory card data 
Delete the recorded measurement data in the memory card in the instrument. 

 

Select Deleting selection of memory card data... from the Measurement 
menu. 

 

Setting items 

Waveform data / Frequency data / Voice 
 : Select the type of data file to display in list. 

Delete : If "Yes" is selected, its file will be deleted. 

 

"Execute" button 
 : Selected file is deleted from the memory card. 

 

To perform the frequency 
analysis using this software, 
the instrument shall be 
equipped with the function of 
executing the frequency 
analysis (option). 
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18 Calibration of the voltage output 
The Voltage Output Unit (TMR-241/TMR-341) can output voltage for 

calibration. 

 

Select Calibration output... from the Measurement menu. 

 

Setting items 

"plus calibration" button 
 : The positive calibration is output. 

"zero calibration" button 
 : The 0mV calibration is output. 

"minus calibration" button 
 : The negative calibration is output. 

 

The Output calibration dialog box cannot be closed during output. Click the red 

button to stop output before closing. 

 

 

 

For setting of the calibration 
values to output, see 
"Chapter 4: 7-4 How to set 
the calibration value" (Page 
4-21). 
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This chapter explains how to draw and edit a chart sheet. 

The chart is divided into a monitor chart that is drawn in real time, and a data 

chart that draws already measured data. 

 

1 Monitor chart 
A monitor chart is drawn in succession while you are performing monitor 

measurement. 

The interval of data collection differs depending on the number of measurement 

points, the number of chart, and the computer performance. 

 

A monitor chart can be of the following type:  

Line monitor : A line chart is plotted, with the data set on the horizontal and 

vertical axis. 

Elapse monitor : A chart is plotted, with data set on the vertical axis and the 

elapsed time of monitoring on the horizontal axis. 

Vertical-bar monitor 

 : A bar chart is plotted, with the data set on the vertical axis and 

the coordinates specified on the horizontal axis. 

Horizontal-bar monitor 

 : A bar chart is plotted, with the data set on the horizontal axis 

and the coordinates specified on the vertical axis. 

X-distribution monitor 

 : A distribution map is plotted, with the data set  

on the vertical axis and the coordinates specified on the 

horizontal axis. 

Y-distribution monitor 

 : A distribution map is plotted, with the data set  

on the horizontal axis and the coordinates specified on the 

vertical axis. 

Frequency monitor 

 : The collected data from the measurement instrument are 

monitored while measuring frequency. 

 

To perform the frequency 
analysis using this software, 
the instrument shall be 
equipped with the function of 
executing the frequency 
analysis (option). 
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1-1 Drawing the Line monitor chart 
A line monitor chart is drawn using lines, with the data set on the horizontal 

and vertical axes. 

 

When you select Line monitor... from the Monitor chart submenu of Chart 
menu after selecting a Measurement project, the dialog box is displayed for 

setting of a chart. 

 

Setting items 

New line : Select this to create a new line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

"OK" button : The monitor chart is displayed. 

"Cancel" button 
 : Plotting is canceled. 

 

Plotting data 
Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project for plotting the chart. 

X-axis list / Y-axis list 
 : Select data for plotting. 
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When creating a new line, if two or more data are selected from either X-axis 

list or Y-axis list, only one data can be selected from another list. 

When changing an existing line, only one data can be selected from either list. 

 

When you click the "OK" button after completion of setting, a line monitor 

chart is displayed, where data plotting is started simultaneously with start of 

monitor measurement. 
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1-2 Drawing the Elapse monitor chart 
An Elapse monitor chart is drawn, with the data set on the vertical axis and the 

elapsed time on the horizontal axis. You can also plot this chart with a fixed 

plot range on the horizontal axis, so as to shift the plot range automatically, if 

the specified range is exceeded. 

 

When you select Elapse monitor... from the Monitor chart submenu of Chart 
menu after selecting a Measurement project, the dialog box is displayed for 

setting of a chart. 

 

Setting items 

New line : Select this to create a new line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

"OK" button : The monitor chart is displayed. 

"Cancel" button 
 : Plotting is canceled. 

 

Plotting data 
Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project for plotting the chart. 

X-axis list : Fixed to Elapsed time. 

Y-axis list : Select data for plotting. 

 

When creating a new line, two or more data can be selected from Y-axis list. 

When changing an existing line, only one data can be selected from the list. 
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Click the Drawing method tab to specify how to plot. 

 

Drawing method 
Scroll the X-axis automatically 
 : When this is enabled, the construction area of X-axis is fixed 

and when the construction area is exceeded, X-axis is 

automatically scrolled, and the latest monitor value is always 

displayed. 

The line is connected with the horizon by the perpendicular line. 
 : The chart is drawn in step-wise pattern by linking the interval 

between data by horizontal and vertical lines. 

 

When you click the "OK" button after completion of setting, an Elapse monitor 

chart is displayed, where data plotting is started simultaneously with the start of 

monitor measurement. 

 

While "Scroll the X-axis automatically" is activated, the plotting range 

remains fixed, and latest monitor values area displayed there. 
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1-3 Drawing the Vertical bar monitor chart 
In a vertical bar monitor chart, a bar chart is drawn, with the data set on the 

vertical axis and the coordinates specified on the horizontal axis. 

 

Op. Data 1, 2, and 3 of a Measurement project are used as coordinate data of 

the X-axis. 

 

◼ How to set the Op. Data (coordinates data) 
Op. Data allows you to set coordinate data of up to three patterns. 

Select Input CH of Channel Setting in the Measurement project where you 

plot a chart. 

Select the cell to input Op. Data, and then input a numeric value from the 

keyboard. 

 

Setting Example 

 

 

◼ How to plot a Vertical bar monitor chart 
When you select Vertical bar monitor... from the Monitor chart submenu of 

Chart menu after selecting a Measurement project, the dialog box is 

displayed for setting of a chart. 
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Setting items 

New line : Select this to create a new line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

"OK" button : The monitor chart is displayed. 

"Cancel" button 
 : Plotting is canceled. 

 

Plotting data 
Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project for plotting the chart. 

X-axis list : Select Op. Data for plotting. 

Y-axis list : Select data for plotting. 

 

Click the Drawing method tab to specify how to plot. 

 

Drawing method 
Construction order 
By Op.Data : The order of line connection is by Op.Data. 

By No. : The order of line connection is by NO of Input CH and 

Expanded CH. 

 
When you click the "OK" button after completion of setting, a vertical bar 

monitor chart is displayed, where data plotting is started simultaneously with 

the start of monitor measurement. 
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1-4 Drawing the Horizontal bar monitor chart 
In a horizontal bar monitor chart, a bar chart is drawn, with the data set on the 

horizontal axis and the coordinates specified on the vertical axis. 

 

Op. Data 1, 2, and 3 of a Measurement project are used as coordinate data of 

the Y-axis. 

When you select Horizontal bar monitor... from the Monitor chart submenu 

of Chart menu after selecting a Measurement project, the dialog box is 

displayed for setting of a chart. 

 

Setting items 

New line : Select this to create a new line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

"OK" button : The monitor chart is displayed. 

"Cancel" button 
 : Plotting is canceled. 

 

Plotting data 
Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project for plotting the chart. 

X-axis list : Select data for plotting. 

Y-axis list : Select Op. Data for plotting. 
For the Op.Data, refer to 
"1-3 Drawing the Vertical bar 
monitor chart ■How to set 
the Op. Data (coordinates 
data) (Page6-6)". 
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Click the Drawing method tab to specify how to plot. 

 

Drawing method 
Construction order 
By Op.Data : The order of line connection is by Op.Data. 

By No. : The order of line connection is by NO of Input CH and 

Expanded CH. 

 

When you click the "OK" button after completion of setting, a horizontal bar 

monitor chart is displayed, where data plotting is started simultaneously with 

the start of monitor measurement. 
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1-5 Drawing the X-distribution monitor chart 
In an X-distribution monitor chart, a distribution map is drawn, with the data 

set on the vertical axis and the coordinates specified on the horizontal axis. 

 

Op. Data 1, 2, and 3 of a Measurement project are used as coordinate data of 

the X-axis. 

 

When you select X-distribution monitor... from the Monitor chart submenu of 

Chart menu after selecting a Measurement project, the dialog box is displayed 

for setting of a chart. 

 

Setting items 

New line : Select this to create a new line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

"OK" button : The monitor chart is displayed. 

"Cancel" button 
 : Plotting is canceled. 

 

Plotting data 
Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project for plotting the chart. 

X-axis list : Select Op. Data for plotting. 

Y-axis list : Select data for plotting. 

 

For the Op.Data, refer to 
"1-3 Drawing the Vertical bar 
monitor chart ■How to set 
the Op. Data (coordinates 
data) (Page6-6)". 
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Click the Drawing method tab to specify how to plot. 

 

Drawing method 
Construction order 
By Op.Data : The order of line connection is by Op.Data. 

By No. : The order of line connection is by NO of Input CH and 

Expanded CH. 

 

When you click the "OK" button after completion of setting, an X-distribution 

monitor chart is displayed, where data plotting is started simultaneously with 

the start of monitor measurement. 
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1-6 Drawing the Y-distribution monitor chart 
In a Y-distribution monitor chart, a distribution map is drawn, with the data set 

on the horizontal axis and the coordinates specified on the vertical axis. 

 

Op. Data 1, 2, and 3 of a Measurement project are used as coordinate data of 

the Y-axis. 

 

When you select Y-distribution monitor... from the Monitor chart submenu of 

Chart menu after selecting a Measurement project, the dialog box is displayed 

for setting of a chart. 

 

Setting items 

New line : Select this to create a new line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

"OK" button : The monitor chart is displayed. 

"Cancel" button 
 : Plotting is canceled. 

 

Plotting data 
Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project for plotting the chart. 

X-axis list : Select data for plotting. 

Y-axis list : Select Op. Data for plotting. 

 

For the Op.Data, refer to 
"1-3 Drawing the Vertical bar 
monitor chart ■How to set 
the Op. Data (coordinates 
data) (Page6-6)". 
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Click the Drawing method tab to specify how to plot. 

 

Drawing method 
Construction order 
By Op.Data : The order of line connection is by Op.Data. 

By No. : The order of line connection is by NO of Input CH and 

Expanded CH. 

 

When you click the "OK" button after completion of setting, a Y-distribution 

monitor chart is displayed, where data plotting is started simultaneously with 

the start of monitor measurement. 
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1-7 Drawing the Frequency monitor chart 
In a frequency chart, monitor chart is displayed while frequency is measured. 

 

When you select Frequency chart... from the Chart menu after selecting a 

Measurement project, the dialog box is displayed for setting of a chart. 

 

Setting items 

Reference file name 
 : Select the file name which is referred to. 

When the measurement project is selected, monitor chart is 

plotted. 

However if you use the level-crossing method as the analysis 

method, no monitor display is shown. 

Graphic mode 
 : Select count data to plot a chart for each analysis method. 

List : Select frequency data to plot a chart. 

 

After selecting frequency data from the list, you can select the Graphic mode. 

 

 

To perform the frequency 
analysis using this software, 
the instrument shall be 
equipped with the function of 
executing the frequency 
analysis (option). 
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Select count data to plot a chart. 

 

When you click the "OK" button after completion of setting, a frequency chart 

is displayed. 

The measured value is displayed on the X-axis, and the count data is displayed 

on the Y-axis. 

 

 



 

 

 6-16 

2 Data chart 
When a measurement project is referred to, data chart is drawn by the latest 

measurement data. 

When a measurement data is referred to, data chart is drawn by its data. 

The data interval is based on A/D conversion setting at the time of the 

measurement. 

 

Following formats are available for data chart. 

Line  : Drawn with line by setting data for horizontal axis and 

vertical axis. 

Scatter : Drawn with dots by setting data for horizontal axis and 

vertical axis. 

Elapse diagram : This diagram is drawn by setting data for vertical axis 

and setting lapsed time of measurement for horizontal 

axis. 

History chart : This chart is drawn by setting the measurement date and 

time for horizontal axis and selecting maximum value, 

minimum value or average value for vertical axis. 

Only a measurement project can be referred to by this 

chart. 

Frequency chart : The result of frequency analysis which was recorded in 

frequency data file is drawn. 

Spectral chart : The chart of power spectrum or amplitude spectrum for 

which FFT analysis is implemented is drawn by 

selecting arbitrary one channel. 

The preprocessing for DC cut, trend cut, hamming 

window and hanning window are available 

Cycle chart : This chart is drawn by setting the measurement date and 

cycle count for horizontal axis and selecting maximum 

value, minimum value or average value for vertical axis. 

Only a measurement project can be referred to by this 

chart. 

Refer to "Chapter 12: 5-1 Drawing the Cycle chart" 
(Page 12-10) for more detail. 

 

 

To perform the frequency 
analysis using this software, 
the instrument shall be 
equipped with the function of 
executing the frequency 
analysis (option). 
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2-1 Drawing the Line chart 
The line chart is drawn with line by setting data for horizontal axis and vertical 

axis. 

 

When Line... is selected from Data chart submenu of Chart menu with the 

Measurement project or Measurement data file selected, the dialog box for 

setting chart is displayed. 

 

Setting items 

New line : Select this to create a new line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

"OK" button : The data chart is displayed. 

"Cancel" button 
 : Drawing is canceled. 

 

Plotting data 
Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project or Measurement data file to be drawn. 

X-axis list/Y-axis list 
 : Select data for plotting. 

 

When creating a new line, if two or more data are selected from either X-axis 

list or Y-axis list, only one data can be selected from another list. 

When changing an existing line, only one data can be selected from either list. 
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Click the Drawing method tab to specify how to plot. 

 

Drawing method 
Adjust the construction area automatically 
 : When this is enabled, all data are plotted. If this is disabled, 

construction area needs to be specified. 

Construction area 
 : Specify the step of data to be drawn. 

 

When "OK" button is clicked after setting, the line chart is drawn. 
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2-2 Drawing the Scatter chart 
The scatter chart is drawn with dots by setting data for horizontal axis and 

vertical axis. 

 

When Scatter... is selected from Data chart submenu of Chart menu with 

Measurement project or Measurement data file selected, the dialog box for 

setting chart is displayed. 

 

Setting items 

New line : Select this to create a new line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

"OK" button : The data chart is displayed. 

"Cancel" button 
 : Drawing is canceled. 

 

Plotting data 
Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project or Measurement data file to be drawn. 

X-axis list/Y-axis list 
 : Select data for plotting. 

 

When creating a new line, if two or more data are selected from either X-axis 

list or Y-axis list, only one data can be selected from another list. 

When changing an existing line, only one data can be selected from either list. 
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Click the Drawing method tab to specify how to plot. 

 

Drawing method 
Adjust the construction area automatically 
 : When this is enabled, all data are plotted. If this is disabled, 

construction area needs to be specified. 

Construction area 
 : Specify the step of data to be drawn. 

 

When "OK" button is clicked after setting, the scatter chart is drawn. 
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2-3 Drawing the Elapse diagram 
The elapse diagram is drawn by setting data for vertical axis and setting 

measurement time for horizontal axis. 

 

When Elapse diagram... is selected from Data chart submenu of Chart menu 

with the Measurement project or Measurement data file selected, the dialog box 

for setting chart is displayed. 

 

Setting items 

New line : Select this to create a new line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

"OK" button : The data chart is displayed. 

"Cancel" button 
 : Drawing is canceled. 

 

Plotting data 
Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project or Measurement data file to be drawn. 

X-axis list : Fixed to measurement time. 

Y-axis list  : Select data for plotting. 

 

When creating a new line, multiple data can be selected from Y-axis list. 
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Click the Drawing method tab to specify how to plot. 

 

Drawing method 
Adjust the construction area automatically 
 : When this is enabled, all data are plotted. If this is disabled, 

construction area needs to be specified. 

Construction area 
 : Specify the step of data to be drawn. 

The line is connected with the horizon by the perpendicular line. 
 : The chart can be drawn by linking the interval between data by 

horizontal and vertical lines. 

 

When "OK" button is clicked after setting, the data chart is drawn. 
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2-4 Drawing the History chart 
The history chart is drawn by setting data maximum value, minimum value, 

and average for vertical axis and setting measurement time for horizontal axis. 

 

When History chart... is selected from History chart submenu of Chart menu 

with Measurement project selected, the dialog box for setting chart is displayed. 

 

Setting items 

New line : Select this to create a new line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 

 : A new plot line is created. 

"Delete" button 
 : Selected plot line is deleted. 

"OK" button : The data chart is displayed. 

"Cancel" button 
 : Drawing is canceled. 

 

Plotting data 
Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project to be drawn. 

X-axis list  : Fixed to measurement time. 

Y-axis list  : Select data for plotting. 

 

When creating a new line, multiple data can be selected from Y-axis list. 
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Click the Drawing method tab to specify how to plot. 

 

Drawing method 
Adjust the construction area automatically 
 : When this is enabled, all data are plotted. If this is disabled, 

construction area needs to be specified. 

Construction area 
 : Specify the step of data to be drawn. 

 

When "OK" button is clicked after setting, the data chart is drawn. 
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2-5 Drawing the Frequency chart 
In a frequency chart, frequency data is displayed. 

 

When you select Frequency chart... from the Chart menu after selecting a 

Frequency data, the dialog box is displayed for setting of a chart. 

 

Setting items 

Reference file name 
 : Select a file which is referred to. 

When the Frequency data file is selected, a data chart is plotted. 

Graphic mode 
 : Select count data to plot a chart for each analysis method. 

List : Select frequency data to plot a chart. 

 

After selecting frequency data from the list, you can select the Graphic mode. 

 

To perform the frequency 
analysis using this software, 
the instrument shall be 
equipped with the function of 
executing the frequency 
analysis (option). 
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Select count data to plot a chart. 

 

When you click the "OK" button after completion of setting, a frequency chart 

is displayed. 

The measured value is displayed on the X-axis, and the count data is displayed 

on the Y-axis. 
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2-6 Drawing the Spectral chart 
Select one channel for FFT analysis. The power spectrum or amplitude 

spectrum is drawn. 

 

When Spectral chart... is selected from Chart menu with Measurement 

project selected, the dialog box for setting chart is displayed. 

 

Setting items 

Referential file name 
 : When multiple Measurement projects are opened, select the 

Measurement project or Measurement data file to be drawn. 

Name list  : Data to be drawn is selected. 

Shift 

None  : The process of shift is not implemented. 

DC cut  : The DC component (direct current component) of measurement 

data is removed. 

Trend  : The trend (least square) of measurement data is removed. 

Window function 
 : Window function is selected from Rectangular, Hamming and 

Hanning. 

Type : Select one of Power spectrum and Amplitude spectrum. 

Data words : Select the way to make the number of data to be a power of 2. 

Round down to the previous power of 2. 
Zero-padding to the next power of 2. 
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When "OK" button is clicked after the setting, the spectrum chart is drawn. 

The X-axis displays frequency, and the Y-axis displays the maximum value for 

the frequency. 

 

In the upper right of the screen, the maximum value of the spectrum and the 

frequency corresponding to the maximum value are displayed. 
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3 Note on drawing of measurement data 
For drawing the measurement data, the measurement data is drawn by 

referencing the measurement project or the measurement data of measurement 

result is drawn by referencing the measurement data file. 

 

3-1 Drawing the measurement data referencing the measurement 
project 

Here explains the example of elapse diagram. 

Open the elapse diagram data chart when the measurement project is opened. 

Open the measurement panel and start the measurement. 

 

Nothing is plotted during the measurement but when the measurement data is 

acquired after the measurement, a chart of the data is drawn. 

 

 

For the elapse diagram, 
refer to "2-3 Drawing the 
Elapse diagram (Page 
6-21)". 
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3-2 Drawing the measurement data referencing the measurement 
file 

The measurement data file can draw the line chart, scatter chart, elapse diagram 

and spectral chart. 

 

The measurement data file cannot be referred to by the history chart. 

 

Display the measurement history from measurement project. 

Select the cell of measurement data for drawing. Right click it and select 

"Show data file" from menu. 

 

The measurement data file is displayed. 

 

 

For more information of drawing other chart: 

Refer to "Chapter 6: 2-1 Drawing the Line chart" (Page 6-17). 
Refer to "Chapter 6: 2-2 Drawing the Scatter chart" (Page 6-19). 
Refer to "Chapter 6: 2-3 Drawing the Elapse diagram" (Page 6-21). 
Refer to "Chapter 6: 2-6 Drawing the Spectral chart" (Page 6-27). 
 

Select the measurement data file in reference file name when drawing a chart. 
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4 Creating the Blank form 
You can add numeric monitor, text, and picture to the blank sheet freely. 

When Blank form is selected from Chart menu, the blank form is created. 

 

 

5 Editing the Chart sheet and Blank form 
This section explains how to edit a chart sheet. 

 

5-1 Adding the data to chart 
For example, when comparing the previous data or design predicted value for 

the test of same content, the multiple data of Measurement projects or 

Measurement data files are added on one chart sheet. 

 

Open a chart sheet which data will be added to. 

 

Open a Measurement project or Measurement data file which contains the 

adding data. 
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Select the chart sheet, and select Set plotting data... from Chart menu. The 

dialog box is displayed. 

 

Select the Measurement project or Measurement data file which contains the 

adding data from Reference file name. And click the "Create" button. 

 

When the "OK" button is clicked after checking the setting, the data is added to 

the selected chart sheet. 
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5-2 Making a copy of a chart sheet 
The selected chart sheet or blank form is duplicated. 

 

Select a chart sheet which will be duplicated. 

 

Select Duplicate charts from Edit menu. 
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5-3 Specifying the chart scale 
You can specify the chart scale, sub scale, automatic scaling, and chart type. 

When Coordinate axes... is selected from Chart menu, the dialog box for 

setting axes is displayed. 

 

Setting items 

Chart type 
X-Y : The X-Y correlation chart is drawn. 

Log-Log : The XY chart of both logarithms is drawn. 

LogX-Y : Semi-logarithmic chart with the logarithm of X-axis is drawn. 

X-LogY : Semi-logarithmic chart with the logarithm of Y-axis is drawn. 

Automatic scaling 
 : When the measurement data exceeds the set chart scale during 

measurement, the chart scale is automatically updated 

depending on the measurement data. 

Left end value/Right end value 
 : The scale of X-axis when the automatic scale is not set. 

Lower end value/Upper end value 
 : The scale of Y-axis when the automatic scale is not set. 

Scale resolution 
 : The main scale intervals are set when the automatic scale is not 

selected. 

Sub scale : The number of division of the sub-scales is set when the 

automatic scale is not selected. 

Scale intervals or sub-scale intervals in a logarithmic chart is 

automatically set. 

Show scale 
None : Scales are not displayed. 

Fixed  : Scales are displayed in fixed-point arithmetic. 

Float  : Scales are displayed in floating-point arithmetic. 

"X-axis font" button 
 : The font for the X-axis scale is set.  

"Y-axis font" button 
 : The font for the Y-axis scale is set. 
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5-4 Specifying the drawing range to update data 
Specify the drawing range and re-draw the chart. 

When the chart sheet to be re-drawn is selected and Update construction 
area... is selected from Chart menu, the dialog box for making a setting is 

displayed. 

 

Setting items 

Reference file name 
 : When multiple data is displayed on selected chart sheet, select 

Measurement project or Measurement data file to be updated. 

Type : Select the type from Data chart and History chart. 

The chart of selected type is updated. 

Construction area 
 : Specify the step of data to be updated. 

"OK" button : The data is updated to that of specified drawing range for the 

chart sheet for which chart name is displayed. 

"Change All" button 
 : Update every opened sheet which relate to reference file. 

 

After the setting, click the "OK" button or "Change All" button. 
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5-5 Changing a reference file 
You can change the Measurement project which you are referring to for the 

chart plotted on the chart sheet. 

For example, if you perform a test with the same content as a previous test, you 

can use the chart sheet of the previous test, by referring to and then modifying 

it. 

 

First, open a Measurement project or Measurement data file you want to refer 

to. 

When you select the chart sheet to make changes and then Change reference 
file... from the Chart menu, the dialog box is displayed for setting. 

 

Setting items 

Reference file name 
 : If multiple data are displayed on the selected chart sheet using 

multiple Measurement projects, select the Measurement project 

or Measurement data file to be changed. 

Update file name 
 : Specify the opened Measurement project or Measurement data 

file for replacing by referential file. 

Change the legend name to the changed file name 
 : The legend name is replaced by the name that is set for 

referential file. 

"Change" button 
 : The referential file is changed for the chart sheet that has the 

chart name displayed. 

"Change All" button 
 : The referential file is changed for every opened chart sheet. 

 

Specify the fine name to be changed and click the "Change" button or 

"Change All" button. 
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6 Drawing the regression line 
Select the chart sheet for which regression line is drawn. 

 

When Regression expression... is selected from Chart menu, the dialog box 

for making a setting is displayed. 

 

Setting items 

Regression line/Regression curve 
 : Select regression line or regression curve. For regression curve, 

set the order of polynomial. Set it within the range of 2 to 9. 

Construction to the limit of axis 
 : The regression line is drawn up to the limit of axis. 

Show mathematical expression 
 : The mathematical expression of regression line is displayed on 

chart sheet. 

Left side/Right side 
 : Specify the left-hand member and right-hand member of 

formula. 

Show r^2 in place of r 
 : The linear correlation coefficient r and deviation coefficient r^2 

can be switched. 

Division of regress line 
 : Specify the division number within X-axis range where the 

regression line is drawn. 

Regression expression 
 : The mathematical expression of regression line is displayed. 

Point  : Specify the line thickness. 

1 point / 2 points / 3 points 

Color  : Specify the color of line. 

"Delete" button 
 : The drawn regression line is deleted. 

When the number of 
measurement data is large, 
it takes time to start the 
drawing. It is recommended 
not to implement it during 
the measurement. 
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After the setting, click the "OK" button. 

 

 

7 Creating the numeric monitor 
The numeric monitor is the parts to display monitor data on chart sheet and 

blank form. During the monitor measurement, the current value is displayed in 

real time. The color within frame changes when the condition of alarm value is 

fulfilled. 

Click where you want to add the value monitor on chart sheet. 

 

When Add numeric value monitor... of Chart menu is clicked, the dialog box 

for making a setting is displayed. 

 

Setting items 

Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project to create the numeric monitor. 

Width of view 
 : Input the number of characters of the numeric monitor. 

Determine alarm 
 : When the condition of alarm level that is set by Measurement 

project is fulfilled, the color of inside of frame changes to the 

selected background color. 

 

 

When the value monitor is 
clicked while holding down 
the Ctrl key, a copy of value 
monitor is created. 

For the setting of alarm, 
please read “Chapter 5 13 
Alarm function“(Page 5-25). 
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Select the measurement data to be created from name list. 

After the setting, click the "OK" button. The numeric monitor is created at the 

clicked position. 

 

 

8 Checking and changing the setting of parts 
When you check or change setting of a chart, legend, title, or any other part, 

you should double-click on the relevant part, or select Property... of the Chart 
menu. 

Dialog box for setting the relevant part will be opened. Perform setting in the 

dialog box. 
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9 Saving a chart sheet 
You can save a chart sheet either by selecting Save or Save AS... from the 

File menu, or by clicking the  "Save" button on the tool bar. 

 

Setting items 

Save : If you are saving a file that has not been saved before, the dialog 

box appears for you to input the sheet name and to specify 

where to store it. Once saved, the sheet is overwritten with the 

same name. 

Save As... : The dialog box appears always so as to enable input of the sheet 

name and specify where to store it. 

The dialog box appears for you to input the sheet name and to specify where to 

store it. 

 

Specify the name of the sheet and where to store it, and click the "Save" 
button. 

The name of the sheet is changed to the new name you specified. 
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This chapter explains functions related to data processing which you can 

perform using a Measurement project or a Measurement data file. 

 

1 How to display the Data list 
You can display a data list in the window of a Measurement project and of a 

Measurement data file. 

 

Being a list to show data of the last measurement, the Measurement project’s 

data list is updated every time you perform measurement. 

 

Select Data list from the "Measurement data" button menu. 

 

Measurement project  Measurement data file 

A data list is displayed. The maximum value, minimum value, and average of 

each channel are shown in the upper section of this list. 

 

 

1-1 How to edit the measurement data 
Data shown in the data list can be edited individually. 

 

Copy and Paste of Edit 
menu can be used. 
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1-2 How to set the column width 
The column width can be changed column by column. 

 

Select a column or a cell included in it. If you want to select more than one 

column, drag the pointer across cells. 

 

When you select Column width... from Project menu, a dialog box is 

displayed for setting of the column width. 

 

Set the column width in mm. Input a numeric value and click the "OK" button. 

The column width is changed into the size you specified. 
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2 How to display the list of progression charts 
You can display progression charts in the window of a Measurement project 

and of a Measurement data file. 

 

Being a list to show data of the last measurement, the Measurement project’s 

data list is updated every time you perform measurement. 

 

Select Chart list from the "Measurement data" button menu. 

 

Measurement project            Measurement data file 

A Chart list is displayed. 
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2-1 How to change coordinate axes of a chart list 
Coordinate axes of a chart list can be changed. 

When you select Coordinate axes... from the Chart menu, a dialog box for 

setting of the coordinate axes is displayed. 

 

Click the X-axis tab or Y-axis tab depending on for which you want to change 

the coordinate. 

The scale and scale resolution can be set channel by channel. 

 

Setting items 

Auto Scale : ON/OFF of automatic scaling is set. 

 

If you change the value or scale, Auto Scale is turned OFF. 

 

Left end value 
 : The left end value of chart when the Auto Scale is OFF is set. 

Right end value 
 : The right end value of chart when the Auto Scale is OFF is set. 

Upper end value 
 : The upper end value of chart when the Auto Scale is OFF is set. 

Lower end value 
 : The lower end value of chart when the Auto Scale is OFF is set. 

Scale resolution 
 : The scale resolution value of chart when the Auto Scale is OFF 

is set. 

Scale/number  
 : The number of divisions of chart when the Auto Scale is OFF is 

set. 

Show scale 
  None : Scale is not displayed. 

  Fixed : Displayed by fixed-point arithmetic. 

  Float : Displayed by floating-point arithmetic. 
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"Font..." button 
 : Specify the font of axis. 

The dialog box for specifying font is displayed. 

 
Specify the font, style and size, and click the "OK" button. 

Click the "OK" button after checking the setting. The Chart list is then updated. 
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2-2 How to change the label of the Chart list 
You can change the label of the Chart list. 

When you select Label setup... from the Chart menu, a dialog box is 

displayed for setting of a label. 

 

Setting items 

Auto label : If you set Auto label to ON, the name and unit of the channel 

are displayed in the Label and Unit respectively. 

 
If you change the Label or Unit, Auto label is turned OFF. 

 
Label : Specify the label when Auto label is OFF. 

Unit : Specify the unit when Auto label is OFF. 

"Legend font" button 
 : Specify the font for the legend which is displayed on the 

right-side of the Chart list. 

"X-axis font..." button 
 : Specify the font for the horizontal axis. 

"Y-axis font..." button 
 : Specify the font for the vertical axis. 

 

When you click each font button, a dialog box is displayed for setting of the 

relevant font. 

 

Specify the font, style and size, and click the "OK" button. 

 

Click the "OK" button after checking the setting. The Chart list is then updated. 
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3 History 
A Measurement project controls the history of measurements for which the 

project was used. 

The history consists of the following items; Measurement history, 

Maximum/Minimum/Average, Frequency history, and Voice history. Click the 

"History" button in the Measurement project. 

 

Measurement history 
 : File names of measurement data (waveforms), memory card file 

names, date and time of measurement, measurement methods, 

measurement titles, measurement time and units are shown for 

all measurements performed. 

Maximum/Minimum/Average 
 : Maximum, minimum, and average values for each channel are 

shown for all measurements performed. 

Frequency history 
 : File names of frequency data, memory card file names, start 

time and stop time of measurement, and test titles are shown for 

all measurements performed. 
Voice history 
 : Voice files which were recorded in measurement are listed. 

Refer to "Chapter 11: 5-8 Playing the Voice data" (Page 
11-29) for more detail. 
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3-1 How to display the Measurement history 
Measured data are displayed in a list. 

Select Measurement history from the "History" button menu. 

 

Measurement history is displayed. 
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3-2 How to display a data file 
You can specify a certain measurement data file from the Measurement history 

to display it. 

Select the measurement data cell you want to display, and right-click it. Select 

Show data file from the pop-up menu. 

 

The data file of the measurement data is displayed. 

 

You can also specify and display more than one measurement data files 

simultaneously. However, it may take time if measurement data to be displayed 

contain a large amount of data and consume a large volume of the capacity of 

the hard disk where OS is installed. Please take this into consideration when 

displaying multiple measurement data files. 
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3-3 How to change the file name of a measurement data file 
You can specify a certain measurement data file from the Measurement history 

to change its name. 

 

Select the measurement data cells you want to rename, and right-click it. Select 

Change data file name... from the pop-up menu. 

 

A dialog box is displayed for change of the data file name. 

 

If you add a "0" in front of the Start number, each serial number will have "0s" 

in the front so as to have the specified number of characters. 

Input the Leading character, Start number, and Ending character, and click the 

"OK" button. 

 

The data file names are changed by sequential numbers. 

If a new name is same as existing name while a progress, conversion is 

stopped. 
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3-4 How to convert a data file into text 
You can specify certain measurement data files from the Measurement history 

to change them into text. 

 

Select the measurement data cells you want to convert into text, and right-click 

it. Select Convert data file to text... from the pop-up menu. 

 

A dialog box is displayed to allow you to perform setting for text conversion of 

the specified measurement data files. 

 

The folder in which measurement data file is recorded is set for destination to 

save. When changing the destination to save, click the "Folder selection" 
button to display the dialog box for specifying the destination to save. 

 

Specify the destination to save and click the "OK" button. 
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Select the format of text file from format. 

Text format (TXT) 
 : Original format with tab-delimited text file. 

CSV : Original format with comma (, ) -delimited text file. 

DRA-7610 compatible (CSV) 
 : The format is same as that of CSV file for which text 

conversion is implemented by DRA-7610. When this format is 

used, the name of channel is not converted. 

DADiSP compatible (DAT) 
 : The file is converted to the text file that can be read the 

waveform analysis software DADiSP. For one data file, two 

files whose extensions are .HED and .DAT are created. 

 

Select items to be included in the header. The selectable item varies depending 

on the format. 

Test title : The title of measurement is inserted into text data. 

Name : The name of each channel is inserted into text data. 

Unit : The unit of each channel is inserted into text data. 

Name and unit in one line 
 : The name and unit of each channel are inserted into text data in 

one line. 

If this is not checked, unit is added to the line succeeding to the 

name. 

 

When the "OK" button is clicked, conversion is started. 

 

The text files will have the same file name as the data file. 

If the number of measurement data in the measurement data file is more than 

the number of steps, the text file is divided into some files by the number of 

steps. If the number of channels is more than CH/NO, the text file is divided 

into some files by the number of CH/NO. 

 

If there already is a file with the same name, it is overwritten during 

conversion. 

 

As for commercially 
available waveform analysis 
software, the DADiSP and 
the FlexPro can load the 
converted data. 
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3-5 How to change the measurement title 
You can specify a certain measurement data file from the Measurement history 

to rename its measurement title. 

 

Select the measurement data cells you want to rename the measurement title, 

and right-click it. Select Change the title of test... from the pop-up menu. 

 

A dialog box is displayed to allow you to rename the title. 

 

When deleting the existing title and defining it with new title, deselect "Add to 
title". 
When changing it in sequential number, change the Concatenation number to 

Consecutive No. 

If you add a "0" in front of the Start number, each serial number will have "0s" 

in the front so as to have the specified number of characters. 

Input the Leading character, Start number and Ending character, and click the 

"OK" button. 

 

The titles are changed so as to have sequential numbers. 
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3-6 How to update the Measurement history 
Data files are searched from the measurement data folder, and the Measurement 

history is updated. 

Normally, the history is automatically updated when a Measurement project is 

displayed. If you have moved or edited a measurement data file after displaying 

it, you have to update the Measurement history, because it is not automatically 

updated in such a case. 

 

When you select Update the Measurement history... from the Project menu, 

the following message is displayed for confirmation. 

 

Click the "Yes" button, and the Measurement history is updated. 
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4 How to display the Maximum/Minimum/Average 
The maximum, minimum, and average of each channel or each data number are 

shown for all the measurement data. 

Select Maximum/Minimum/Average from the "History" button menu. 

 

The maximum, minimum, and average of the measurement data are displayed 

for each channel or each data number. 
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5 How to display the Frequency history 
File names, start time and stop time of measurement, and measurement title are 

shown for all frequency data which have been measured. 

Select Frequency history from the "History" button menu. 

 

Frequency history is displayed. 
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5-1 How to display frequency data file 
You can specify a certain frequency data file from the Frequency history to 

display it. 

Select the frequency data cell you want to display, and right-click it. 

Select Show data file from the pop-up menu. 

 

The data file of the frequency data is displayed. 

 

 

5-2 How to change the file name of frequency data file 
You can change the file name of frequency data file. 

 

Refer to "Chapter 7: 3-3 How to change the file name of a measurement 
data file" (Page 7-10) for more detail. 
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5-3 How to convert a frequency data file into text 
You can specify certain frequency data files from the Frequency history to 

change them into text. 

 

Select the frequency data cells you want to convert into text, and right-click it. 

Select Convert frequency file to text... from the pop-up menu. 

 

A dialog box is displayed to allow you to perform setting for text conversion of 

the specified measurement data file. 

 

The folder in which measurement data file is recorded is set for destination to 

save. When changing the destination to save, click the "Folder selection" 
button to display the dialog box for specifying the destination to save. 

 

Specify the destination to save and click the "OK" button. 
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Select the format of text file from Format. 
Text format (TXT) 
 : Original format with tab-delimited text file. 

CSV : Original format with comma (,) -delimited text file. 

HR-7916 compatible (CSV) 
 : The format is same as the CSV file which is implemented by 

HR-7916 for text output of frequency data. 

 

If you select HR-7916 Compatible (CSV) format, you can select an item to 

add to the text file: 

Input CH : The settings of the Input CH used for the frequency analysis are 

added. 

Analysis condition 
 : The settings of the frequency number are added. 

M/M Data : The maximum and minimum values of the frequency number 

are added. 

 

When the "OK" button is clicked, conversion is started. 

The text files will have the same file name as the data file. 

In case of text format (TXT) or CSV format, a separate file is created for each 

frequency number, and the file name will be followed by underscore (_) and the 

frequency number. 

 

 

 

If there already is a file with the same name, it is overwritten during 

conversion. 

 

 

5-4 How to change the test title 
You can change the measurement title of frequency data file. 

 

Refer to "Chapter 7: 3-5 How to change the measurement title" (Page 
7-13) for more detail. 

 

5-5 How to update the Frequency history 
You can update the frequency history of frequency data files. 

 

Refer to "Chapter 7: 3-6 How to update the Measurement history" (Page 
7-14) for more detail. 
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6 Reading instrument data 
This software can load both waveform data and frequency data which were 

saved on a memory card or on the shared folder in an instrument. Therefore, 

even if measurement was performed by offline, you can display its result by a 

measurement data file. 

When you select Reading instrument data... from the File menu, the 

following dialog box is displayed 

 

Setting items 

Waveform data / Frequency data / Voice 
 : Select the type of data file to display. 

Selected files are read even if you have switched the display. 

Use the coefficient, unit and format of file. 
 : If you check this box, the settings of coefficient, unit and format 

included in the specified folder are applied for reading 

waveform data. If there are no such data, the setting of the 

Measurement project is used. 

"Reference..." button 
 : Select the folder that contains the data. 

Left list : For the measurement data that is in the referenced folder, the 

measurement date and time, sampling clock, number of data, 

etc. are displayed. 

Right list : The list of the measurement data to read is displayed. 

"Register" button 
 : The data selected from left list is registered in right list. 

"Release" button 
 : The data selected from right list is deleted from list. 
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When you click the "Reference" button, a dialog box appears to allow you to 

select the folder. 

Select a folder that contains the data. 

 

 

When you select the measurement data to be loaded from the left list and click 

the "Register" button, they will be displayed in the right list. 

 

If you want to load frequency data, click the Frequency data option button. 

 

Click the "OK" button, then the registered data are loaded. 

 

 

For reading voice data, refer to "Chapter 11: 5-1 Reading memory card 
data" (Page 11-17). 
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7 Processing of a measurement data file 
A measurement data file contains all data of one measurement. You can execute 

the following processes for all channels in the file: 

 

Thinning out of data 
 : Thin out data steps at regular intervals in order to decrease the 

number of data. Use this function when the sampling interval is 

too short for the phenomenon frequency. 

Display of the data cursor 
 : Display data cursors on the chart list in order to refer to the 

value for the same time point in each channel. 

Searching maximum and minimum values 
 : The maximum and minimum values within the specified range 

are searched. 

Display of the marker 
 : Display marker on the chart list. 

Deletion of data 
 : Delete unnecessary parts of the phenomenon waveform. 

Use this function when there is any unnecessary section at the 

beginning or at the end of the measurement data. 

Deletion of the first and last parts 
 : Take out only a certain part of the phenomenon waveform to use 

it. 

Use this function when there is any unnecessary section at the 

beginning and at the end of the measurement data. 

Change of the time unit 
 : Change the unit of the measurement time. 

Use this function when the measurement time has become short 

after data deletion or the like. 

Operation of measurement data 
 : Re-calculation is carried out based on the measurement data 

defined by input CH setting by defining Expanded CH. 

Text conversion 
 : Convert measurement data into a text file which can be read by 

any other software. You can also select any channel to convert 

its data. 
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7-1 Thinning out of data 
Thin out data steps at regular intervals in order to decrease the number of data. 

Use this function when the sampling interval is too short for the phenomenon 

frequency. 

 

Display the Data list or Chart list of the measurement data file. 

 

When you select Thin out... from the Edit menu, a dialog box is displayed for 

setting. 

 

Specify the number of thinning out. The data of steps for which 1 is added to 

the set number are remained. If 4 is set for example, the data of steps 1, 6, 11 

and so on are remained as data. The new sampling time is "sampling time x 
(the number of thinning out + 1)", and the measurement time is "(the 
number of remained data - 1) x new sampling time". 
Click the "OK" button after confirmation of the setting, and the data of all the 

channels are updated. 

 

You cannot undo this process. Please confirm the setting sufficiently before 

executing the process. 

 
If the update was processed 
with incorrect settings, close 
the measurement data file 
without saving it, and then 
display it again. 
 

For the details of display of 
Data list and Chart list, refer 
to "Chapter 7: 1 How to 
display the data list" 
(page7-1) and "Chapter 7: 2 
How to display the list of 
progression charts" 
(page7-3). 
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7-2 Range selection 
In order to delete data, you have to select the range to delete first. 

You can select the range from the Data list or Chart list. 

 

◼ Range selection from the Data List 
Select the data steps or data in Measurement time cells. 

 

◼ Range selection from the Chart list 
Select the relevant portion of data in one of the charts. 

 

The same range is selected for all the charts. 

In order to change the selected range, drag the ■ mark shown on the four 

corners of the selected range using the pointer. 
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◼ Range selection by a numeric value 
You can select the range by inputting the number of data steps or 

measurement time. 

When you select Selection... from the Edit menu, a dialog box is displayed 

for range setting. 

 

There are two ways to specify the range: Set by measurement time and Set 

by the number of data. 

 

Setting items 

Set by measurement time, Set by the number of data 
 : Select whether the range is set by measurement time or the 

number of data. 

Top : Set the beginning part to be selected. The unit when the range is 

set by measurement time depends on the unit of measurement 

time of measurement data file. 

End : Set the last part to be selected. The unit when the range is set by 

measurement time depends on the unit of measurement time of 

measurement data file. 

"Apply" button 
 : Apply the range without closing the dialog box. 

"Check" button 
 : When it is set by the measurement time, the number of data 

equivalent to the set value is displayed. When it is set by the 

number of data, the measurement time equivalent to the set 

value is displayed. 

 

When "OK" button is clicked, the set range is selected. 
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7-3 Display of the cursor information 
When the range is selected on the chart list, the ■ marks on the left end of the 

selected range are cursor 1 while the ■ marks on the right end of the selected 

range are cursor 2. The elapsed time and the measurement values at those 

positions are displayed. In addition, values subtracting cursor 1 values from 

cursor 2 values are also displayed. 

For display of the cursor information, select Cursor information display from 

the Measurement data menu. 

 

A third column is added to the Chart list to show the cursor information. 

 

The cursor 1 and cursor 2 can be moved by ← → keys and ↑↓ keys on 

keyboard, respectively. 

For closing the cursor information, select Cursor information display from 

Measurement data menu again. 

 

7-4 Searching the maximum and minimum values 
The specified data range is searched for the maximum and minimum values for 

each channel, and the positions and values are displayed. For the chart list, 

average value in the specified data range is also displayed. 

The chart list or data list of a measurement data file is used for this search. 

 

◼ How to search 
If you do not set any search range, all data will be the search range. 

In the data list, select data from the desired channels in the row direction. 

The search is performed on the selected rows. If you select only one row, all 

data will be the search range. 

To start the search, select "Search" from the "Maximum/minimum display" 
sub menu of the "Measurement data" menu. 

In the chart list, the maximum and minimum values are indicated by blue 

and red lines, respectively. 

The maximum, minimum and average values within the range are indicated 

in the fourth column of the chart list. 
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In the data list, the maximum and minimum value are indicated by cell color; 

light blue and light red, respectively. 

 

◼ Clearing the search results 
To clear the search results, select Clear from the Maximum/minimum 
display sub menu of the Measurement data menu. 

In the chart list, the blue and red lines disappear and the columns reduced 

back to two. 

In the data list, the cell color returns to white. 
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7-5 Display and editing of marker 
A specific location can be indicated on the chart list by the marker. 

This software creates a marker on the chart list; however, if a marker has been 

inserted into the measurement data by using a TMR-281 (which is the display 

unit for the TMR-211) during the measurement, the marker is automatically 

created when the measurement data are read by this software. 

 

To switch the display or non-display of the marker, click Indication of marker 
from the "Marker" button menu. 

 

There are two kinds of marker: One indicates ordinary location and another 

indicates recording start location of voice memo file. 

 

Ordinary marker  

 

Voice memo marker  

 

The voice memo marker is painted out in red and the voice memo is played by 

double-clicking on the marker. 

 

The marker can be created at the location of cursor for range selection. 

 

Move the cursor to the location where the marker is created. Select one from 

Create marker on cursor 1, Create marker on cursor 2 and Create marker 
on both cursors. The marker is created. 

 

When the TMR-251 is 
recording GPS data, a 
marker can be displayed on 
GPS trajectory and on GPS 
map. 
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◼ In case of Create maker on cursor 1 

 

◼ In case of Create maker on cursor 2 

 

◼ In case of Create maker on both cursors 

 

To delete the unnecessary marker, click the Select marker from the "Marker" 
button menu at first. 

 

If the mouse cursor is moved on the chart list while selecting marker, the cursor 

changes to     . In addition, a cursor is indicated on the "Marker" button. 

 

In case of selecting the marker one by one, click on the marker. 
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In case of selecting more than one marker together, drag the mouse and 

surround markers to be selected 

 

The selected markers are shaded. 

 

If the shift key on the keyboard is pressed when selecting, additional selection 

or the release of the selected marker becomes possible. 

For releasing all, click at a position without marker. 

 

For deleting the selected markers, click Delete marker from the "Marker" 
button menu. 

 

The selected markers are deleted. 

 

For the release of marker selection, click Select marker from the "Marker" 
button menu. 
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7-6 Operation of the axis of coordinates 
The magnification of display area and movement by mouse can be done for the 

chart list and the trajectory display of GPS data. 

For the magnification of the axes, select Enlarge coordinates axis from the 

"Working with axes" button which appears when the chart list is displayed. 

During operation of the axis, the cursor is changed into  by moving the 

cursor to the chart list, and changed into  by moving to the trajectory 

display of GPS data. Also, the cursor is displayed on the "Working with axes" 
button. 

 

By dragging the mouse on the trajectory display of GPS data, an area to be 

magnified is selected in square. 

 

The selected area is magnified by releasing the mouse button. 

 

By dragging the mouse on the chart list, an area to be magnified is selected in 

square. 

 

The selected area is magnified by releasing the mouse button. 

 

In the chart list, the time axis for all channels is changed to the selected area, 

and the vertical axis is so adjusted that the data within the area are shown for 

every channel. 

 

For releasing the magnification of the coordinate axis, select the Enlarge 
coordinates axis from the "Working with axes" button. 

About the trajectory display 
of GPS data, read "Chapter 
11: 5 Processing 
CAN/Voice/GPS 
measurement data". 
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For the movement of the axis, select Shift coordinates axis from the 

"Working with axes" button. 

During operation of the axis, the cursor is changed into  by moving the 

cursor to the chart list or the trajectory display of GPS data. Also, the cursor is 

displayed on the "Working with axes" button. 

 

By dragging the mouse on the chart list or the trajectory display of GPS data, 

the cursor is changed into  and the display area moves. 

The display area can be moved up or down and from side to side on the 

trajectory display of GPS data. 

 

The area can be moved from side to side on the chart list. 

 

The vertical axis is adjusted for each channel so that the data within the area are 

shown. 

For releasing the movement of the axis, select the Shift coordinates axis from 

the menu once more. 

 

For displaying all the data, click the "Working with axes" button and select 

Reset coordinate axis from the menu. In the chart list or the trajectory display 

of GPS data, the chart in the screen which is in operation (displayed with 

yellow frame) is reset. 
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7-7 Data deletion 
Delete unnecessary part of the phenomenon waveform. 

 

At first, select the unnecessary part of the measurement data. 

 

When you select Delete from the Edit menu, a dialog box appears for 

confirmation. 

 

Delete operation can be canceled by selecting Undo from the Edit menu. 

However, if the delete range or the number of channels is large, it may take 

very long time (several to dozens of minutes). 

If it is not necessary to undo the operation, or if it seems to take long time, click 

the "Yes" button. 

By clicking the "Yes" button or "No" button, the waveform within selected 

range is deleted. 

 

If you find any mistakes after 
performing the deletion by 
clicking "Yes" button, close 
the measurement data file 
without saving it. Then open 
the file again. 
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7-8 Deletion of the first and last parts of data 
You can cut out only a necessary part of the phenomenon waveform. 

 

At first, select the necessary part of the measurement data. 

 

When you select Delete before/after from the Edit menu, a dialog box appears 

for confirmation. 

 

Delete before/after operation can be canceled by selecting Undo from the Edit 
menu. However, if the delete range or the number of channels is large, it may 

take very long time (several to dozens of minutes). 

If it is not necessary to undo the operation, or if it seems to take long time, click 

the "Yes" button. 

By clicking the "Yes" button or "No" button, the waveform out of the selected 

range is deleted. 

 

If you find any mistakes after 
performing the deletion by 
clicking "Yes" button, close 
the measurement data file 
without saving it. Then open 
the file again. 
 



Chapter 7 Data Processing 

 7-35 

7-9 Change of the time unit 
Use this function when the measurement time has become short after data 

deletion or the like. 

In order to change the unit of measurement time, select Time unit of the 

Measurement data menu. 

When the time unit is changed, the measurement time on the data list, chart list 

and the progression charts referring to the Measurement data file are displayed 

in the new unit. 

 

 

7-10 Operation of measurement data 
Re-calculation is carried out according to the definition of the Expanded 

channel using the measurement data allocated to each input channel. 

It is also possible to set the formula of already defined sequence of functions 

again or to make a setting newly for the number that is not set. The 

measurement data that is defined by input CH does not carry out an operation. 

 

The Expanded CH of Measurement data file is displayed. 

 

As the setting method of Expanded CH is same as that of the Measurement 

project, refer to "Chapter 4: 9 Expanded CH" (Page 4-26). (There is no 

optional data) 

 

Set the Expanded CH, and select Recalculation from Edit menu. 

Every data of Expanded CH is calculated again. 

 

For details on function, 
please read "Chapter 13: 
Function". 
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7-11 Save as text 
Convert measurement data into a text file which can be read by any other 

software, and save the file. You can also select any channel to convert its data 

only. 

 

Display the Data list of the Measurement data file. 

 

When you select Save as text... from the File menu, a dialog box is displayed 

to allow you to perform setting for text conversion. 

Select a conversion method from the tabs in the upper section. 

 

Selection items 

Select to convert 
 : The arbitrarily selected channel and range of specified step are 

converted. 

Convert All : The data of every channel is converted. 

DRA-7610 compatible 
 : The format is same as that of CSV file for which text 

conversion is implemented by DRA-7610. When this format is 

used, the name of channel is not converted. 

DADiSP compatible 
 : The file is converted to the text file that can be read by the 

waveform analysis software DADiSP. For one data file, two 

files whose extensions are .HED and .DAT are created. 

 

As for commercially 
available waveform analysis 
software, the DADiSP and 
the FlexPro can load the 
converted data. 
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◼ Select to convert 
The channel and step range you selected are converted in the basically same 

format as the Data list which is displayed on the screen. 

 

In order to select channels, drag the pointer in such a way to enclose the 

names of channels. Or, click the name while pressing the Shift key or Ctrl 

key. 

If you wish to save a selected range in data list or chart list (data file only), 

you can change the step by clicking on "The selected range is set to the 
step" button. 

Select items to be included in the header, specify the range of the data steps, 

and click the "OK" button. 

The dialog box for setting the target folder and the file name of the text file 

is displayed. 

 

Select the destination to save and input the file name. For the type of file, 

CSV file (comma-separated) or text file (tab-separated) can be selected. 

 

Click the "Save" button after confirming the setting. 

A text file with the specified file name is created. 
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◼ Convert all 
Data of all the channels are converted in the basically same format as the 

Data list displayed on the screen. 

 

If the number of measurement data is bigger than the number of steps, the 

text file is divided into some files by the number of steps. 

In addition, if the number of channels is bigger than the number of CH/NO, 

the text file is divided into some files by the number of CH/NO. 

Select items to be included in the header, and click the "OK" button. 

The dialog box for setting the target folder and the file name of the text file 

is displayed. 

 

Select the destination to save and input the file name. For the type of file, 

CSV file (comma-separated) or Text file (tab-separated) can be selected. 

 

Click the "Save" button after confirming the setting. 

The file name will be the string you input followed by a serial number. 
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◼ DRA-7610 compatible 
The format is same as that of CSV file for which text conversion is 

implemented by DRA-7610. When this format is used, the name of channel 

is not converted. 

 

If the number of measurement data is bigger than the number of steps, the 

text file is divided into some files by the number of steps. 

In addition, if the number of channels is bigger than the number of CH/NO, 

the text file is divided into some files by the number of CH/NO. 

Set area of file partition, and click the "OK" button. 

The dialog box for setting the target folder and the file name of the text file 

is displayed. 

 

Select the destination to save and input the file name. For the type of file, 

only CSV file (comma-separated) can be selected. 

Click the "Save" button after confirming the setting. 

The file name will be the string you input followed by a serial number. 
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◼ DADiSP compatible 
The file is converted to the text file that can be read by the waveform 

analysis software DADiSP. For each data file, two text files are created, with 

an extension of .HED and .DAT, respectively. Maximum, minimum, and 

average values are not converted. 

 

If the number of measurement data is bigger than the number of steps, the 

text file is divided into some files by the number of steps. 

In addition, if the number of channels is bigger than the number of CH/NO, 

the text file is divided into some files by the number of CH/NO. 

Select items to be included in the header, and click the "OK" button. 

The dialog box for setting the target folder and the file name of the text file 

is displayed. 

 

Select the destination to save and input the file name. For the type of file, 

only DADiSP can be selected. 

Click the "Save" button after confirming the setting. 

The file name will be the string you input followed by a serial number. 

 

Files with the extensions of .HED and .DAT having the same name are 

created. 

 

As for commercially 
available waveform analysis 
software, the DADiSP and 
the FlexPro can load the 
converted data. 
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8 Processing of a frequency data file 
One frequency data file is created every time you perform frequency 

measurement. You can execute following processes of data of all the channels 

in the file: 

 

Change of the format 
 : The number of displayed digits for the maximum and minimum 

values of frequency data is changed. 

Display the physical quantity 
 : To switch the display or non-display of the physical quantity for 

each slice is available. 

Text conversion 
 : List and count data of frequency analysis are converted into a 

text file, so that they can be read by other software. 

Output in the HR7916CSV format 
 : The format is same as CSV file for text conversion which is 

implemented by HR-7916. You can also select any frequency 

number to convert its data. 

 

 

Frequency data file 

 

8-1 Displaying the Input CH 
Display the setting conditions of each channel at the time of frequency 

measurement: 

 

Click the Input CH tab, or click Input CH from the Switch to submenu of 

Frequency Data menu. 

Setting conditions of each channel are displayed. 

 

 

To perform the frequency 
analysis using this software, 
the instrument shall be 
equipped with the function of 
executing the frequency 
analysis (option). 
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8-2 Displaying frequency data 
Display the setting conditions and frequency data of each frequency number at 

the time of frequency measurement. 

 

Click the Frequency data tab, or click Frequency data from the Switch to 

submenu of Frequency data menu. 

 

 

◼ Numerical display 
Select Numerical tab in lower table, frequency data is displayed in number. 

 

 

◼ Horizontal bar display 
Select other than Numerical tab in lower table, frequency data is displayed 

by horizontal bar. 
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8-3 Changing the format 
Change the number of displayed digits for the full scale, maximum value, 

minimum value and physical quantity of the frequency data. 

 

Select the number of displayed digits from format. 

 

The number of displayed digits for the full scale, maximum value, minimum 

value and physical quantity of the frequency data is changed. 

 

 

8-4 Displaying the physical quantity 
To switch the display or non-display of the physical quantity for each slice is 

available. 
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8-5 Save frequency data as text 
Convert list and count data of frequency analysis into a text file which can be 

read by other software, and save the file. 

Right-click on the frequency data, and select Save as text... in the menu. 

 

A dialog box is displayed to allow you to perform setting for text conversion of 

the specified frequency data file.  

 

Selection items 

Saving frequency analysis listing 
 : The list of settings, including the frequency data analysis 

method, full scale, hysteresis, and number of slices, is 

converted. 

Saving the indicated count data 
 : Count data of the frequency number you have selected are 

converted. 

Saving all count data 
 : All the count data are converted, creating a file for each 

frequency number. 

 

After selecting a text conversion method, click the "OK" button. A dialog box is 

displayed to allow you to specify the destination to save the text file and file 

name. 

 

Select the destination and input the file name to save. The file type is selected 

between CSV file (comma-separated) and text file (tab-separated). Click the 

"Save" button to save the file. 

When Saving all count data is specified, separated file is created for each 

frequency No., and "_" and a number showing frequency No. are appended to 

the end of each file name. 
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8-6 Outputting the frequency data in HR7916CSV format 
Output the frequency data in the format same as a CSV file which is obtained 

by text conversion in HR-7916. You can also convert data of a selected 

frequency number. 

 

Right-click on the frequency data, and select Outputting HR7916 in CSV 
format... from the menu. 

 

A dialog box is displayed to allow you to perform setting for text conversion of 

the specified frequency data file in HR7916CSV format. 

 

Setting items 

Setting information 

Input ch. : The settings of the input CH used for the frequency analysis are 

added. 

Analysis condition 
 : The setting contents of the frequency number are added. 

M/M data : The maximum and minimum values of the frequency number 

are added. 

Frequency data 

Lump : If you check this box, frequency data of all the frequency 

number are stored in a horizontal structure. 

Separate : If you check this box, frequency data of the frequency number 

which was specified for the output are stored separately in a 

vertical structure. 

Select "Yes" in the Output column. 
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This chapter explains how to print each file. 

 

1 Selection of the printer and paper 
Specify the printer to use and paper before starting printing. 

When you select Printer Setup... from the File menu, the dialog box is 

displayed for setting of the printer. 

 

Specify the printer to use and size and orientation of the paper, and click the 

"OK" button. 

 

2 How to set the printing format 
In order to set conditions for printing, select Print Option... from the File menu. 

The dialog box is displayed. 

 

Setting items 

Print order of page 
 : For the setting and the data of Measurement project or 

Measurement data file, the print area on one sheet is determined 

in accordance with the size and direction of the paper. Specify 

the printing page order for the case where the content cannot be 

fitted in one sheet. 

 
Print with the paper size 
 : If you put a checkmark here, you can print out chart sheets in 

adjusting their size to the specified paper size. 
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Chart sheet is printed in a different manner, depending on the lock status of the 

plotting area and the size of the paper: 

 

 

 

 

 

 

 

 

 

 

 

 

When the parts layout is arranged to fit in the paper size, a section of parts may 

stick out of the printing area, because the size of parts are not changed. 

 

Click the "OK" button after completion of setting. 

 

3 How to print out 
Before you start to print out, the target window should be selected. For 

Measurement project, display the screen to print from among Channel setting, 

Automatic measurement setting, Measured data and History. Likewise, from 

among Channel setting and Measurement data for Measurement data file, and 

from among Input channel and Frequency data for Frequency data file. 

 

Select Print... from the File menu. Or click the     "Print" button on the tool 

bar. A dialog is displayed for setting of the print range. 

 

Setting item 

Print range : Set the page number to be printed. 

When the All is selected, all pages are printed. 

 

Click the "OK" button after completion of setting. 

Plotting 
area 

Print with 
the paper 
size 

Plotting area is smaller 
than the specified 
paper size 

Plotting area is larger 
than the specified 
paper size 

Locked 
ON The chart is printed in 

the same size as it is. 

The chart is printed on 
a reduced scale, with 
its part layout arranged 
with equal scaling in 
the horizontal and 
vertical directions. 

OFF The chart is printed on 
multiple sheets. 

Not 
locked 

ON The chart is printed with its parts layout arranged 
to fit in the specified paper size. 

OFF The chart is printed in 
the same size as it is. 

The chart is printed on 
multiple sheets. 

For the lock of plotting area, 
refer to "Chapter 9: 5-25 
Construction area lock" (Page 
9-109), 
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4 How to check before printing 
In order to check the sheet on the screen before printing on the paper, select 

Print Preview from the File menu. 

Image of a print is displayed on the screen, according to the specified paper size 

and print option. 
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5 Printing the chart sheets collectively 
Select the sheets to be printed from opened chart sheets, and print them 

collectively. 

 

When Print all charts... from File menu is selected, the dialog box for making 

a setting is displayed. 

 

Setting items 

Target chart : The list of opened chart sheets is displayed. 

Chart to print 
 : The list of chart sheets to be printed is displayed. 

"Register>>" button 
 : The sheet selected from the Target chart list is registered in the 

Chart to print list. 

"Insert>>" button 
 : The sheet selected from the Target chart list is inserted between 

sheets registered in the Chart to print list. 

"Release>>" button 
 : The sheet selected from the Chart to print list is deleted from 

list. 

"Release All>>" button 
 : Every sheet registered in the Chart to print list is deleted. 

"Setting" button 
 : The settings of the Chart to print and the Layout to print pages 

are recorded. When you open this dialog box again, recorded 

setting is retrieved. The setting will be canceled by restarting 

this software. 
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Layout to print pages 

Print with layout 
 : Multiple sheets are printed in one piece of paper. 

Set the vertical and horizontal division number and decide the 

printing area of sheet. 

When the drawing area is larger than paper size, the parts 

allocation is adjusted according to the printing area and it is 

printed. 

Print with the paper size 
 : One sheet is printed by adjusting it to the specified paper size 

and adjusting the parts allocation. 

 

When the parts layout is arranged to fit in printing area or in the paper size, a 

section of parts may stick out of the printing area, because the size of parts are 

not changed. 

 

When the sheets to be collectively printed are selected from Target chart list 
and "Register>>" button is clicked, they are displayed in Chart to print list. 
And click the "Print" button. The sheets are printed in the order that is 

registered in Chart to print list. 
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This chapter explains menus used in this software. 

Menus displayed in the Measurement project, the Measurement data file, the 

Frequency data file, and the Chart sheet are different. In this chapter, the menu 

items specific to each project are shown with the following indications. 

 

Items specific to the measurement project 

 : "Measurement project" 
Items specific to the measurement data file 

 : "Measurement data" 
Items specific to the frequency data file 

 : "Frequency data" 
Chart sheet : "Chart sheet" 
 

1 File menu 
Overview 

 Creating a new measurement project 

 Opening the existing file 

 Closing the selected window 

 Saving the selected window 

 Saving the selected window as other file 

 Saving as standard text format 

 Saving a chart as picture 

 Reading the data file saved in instrument 

 Creating setting file for instrument 

 Setting the paper size 

 Printing the selected window 

 Printing the specified chart sheets and blank forms collectively 

 Exit from this software 

 

 
"Measurement project" 

 
"Measurement data" 

 
"Frequencey data" 

 
"Chart sheet" 
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1-1 New  Ctr+N 
Function Creates a new measurement project. The number of 

measurement projects that can be opened depends on the 

available memory and hard disk space. 

 

Screen 

 

Description When a new measurement project is opened, the project name 

is set as "measurement project1". If a measurement project of 

the same name has been already opened, the subsequent 

measurement projects are named as "measurement project2", 

"measurement project3".... 

 

Operation 

1. Select New from the File menu. The measurement project 

as shown above is opened. 
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1-2 Open...  Ctrl+O 
Function Opens the existing file. The number of files that can be opened 

depends on the available memory and hard disk space. 

When the measurement project is opened, all the chart sheets 

stored in the StartUp folder are opened concurrently. 

 

Screen 

 

 

Description The four kinds of files for the Measurement project, 

Measurement data file, Frequency data file and Chart sheet can 

be opened. 

 "Measurement project" 

 "Measurement data file" 

 "Frequency data file" 

 "Chart sheet" 

 

By removing the checkmark placed in the box for "Open the 
chart stored in StartUp folder when opening the 
measurement project.", only the measurement project is 

displayed. 

 

Operation 

1. Select Open... from the File menu. The dialog box for 

selection is displayed. 

2. Select the target file from the file list. 

3. Click the "Open" button. 

The file selected in the step 2. will be displayed. 
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1-3 Close 
Function Closes the selected window. 

 

Screen 

 

 

Description 

"Yes" button : The file is saved under the current name and the window is 

closed. If the file has never been saved, the Save As dialog box 

is displayed. Type the file name, specify the target folder and 

click the "Save" button. 

The file is saved and the window is closed. 

"No" button : Without saving the file, the window is closed. 

 

Operation 

1. Select Close from the File menu. 

If the file has been changed, the dialog box is displayed. 

2. To save the file, click the "Yes" button. 

If you don’t save the file, click the "No" button. 
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1-4 Save  Ctrl+S 
Function Saves the selected window. 

 

Description The file saved once is saved with the same name. 

As for any Measurement project or Chart sheet that has not 

been saved, the Save As... operation is executed. 

 

Operation 

1. Select Save from the File menu to save the file. 

2. If the file has never been saved, the Save As... dialog box 

is displayed. 

 

 

 

 

1-5 Save As... 
Function Saves the selected window as other name. 

 

Screen 

  

Operation 

1. Select Save As... from the File menu. The Save As dialog 

box is displayed. 

2. Select the target folder in which the file should be saved 

from the file list. 

3. Type the file name. 

4. Click the "Save" button. 

5. The file is saved in the folder selected in the step 2. 
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1-6 Save as text... 
Function Saves the settings and the data of the Measurement project, the 

Measurement data file or the Frequency data file in a text 

format. 

 

Screen 

 

 

Description The settings and the data list being displayed on the selected 

window are saved in the standard text format. The saved text 

data can be used with commercially available spreadsheet and 

chart creating software. 

 

Operation 

1. Select Save as text... from the File menu. The dialog box 

for setting is displayed. 

 

2. When the data list is being displayed, the dialog box for 

selecting the data to be saved and the step is displayed. 

Goto to step 5. 

When any window other than the data list is displayed, the 

Save dialog box is displayed. 

 

3. Select the target folder from the file list. 

Input the file name. 

Select the type of the file from CSV (tab separation) or text 

(comma separation). 

 

 
"Measurement project" 

 

 
"Measurement data" 

 

 
"Frequencey data" 
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4. Click the "Save" button. 

The text file is saved in the selected folder. 

(Operation complate) 

5. If the data list is being displayed, the dialog box for 

conversion setting is displayed. 

 

Select the text file conversion method from the tabs on the top. 

 

Selection items 

Select to convert 
 : The arbitrarily selected channel and range of specified step are 

converted. 

Convert All : The data of every channel is converted. 

DRA-7610 compatible 
 : The format is same as that of CSV file for which text 

conversion is implemented by DRA-7610. When this format is 

used, the name of channel is not converted. 

DADiSP compatible 
 : The file is converted to the text file that can be read by the 

waveform analysis software DADiSP. For one data file, two 

files whose extensions are .HED and .DAT are created. 

 

Commercially available 
waveform analysis software 
can be read with the DADiSP 
and FlexPro. 
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◼ Select to convert 

 

Setting items 

List of name : The data name set by measurement project and measurement 

data file is displayed. 

Test title : The title is inserted into text data. 

Name : The channel name is inserted into text data. 

Unit : The unit is inserted into text data. 

Name and unit in one line 
 : The channel name and unit are inserted into text data in one line. 

If this item is not checked, the unit is appended to the line 

bellow the name. 

Step : The range of specified step is converted to text data. 

"OK" button : After the item is selected, the save dialog box is displayed. 

 

The "Save" dialog box as shown in Operation 2. is displayed. For the type of 

file, CSV file (comma-separated) or text file (tab-separated) can be selected. 

 

Click the "Save" button after confirming the setting. 

A text file with the specified file name is created. 
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◼ Convert All 

 

Setting items 

Number of CH/NO 
 : The converted text file is divided by each specified number of 

columns. 

Number of steps 
 : The converted text file is divided by each specified number of 

rows. 

Test title : The title is inserted into text data. 

Name : The channel name is inserted into text data. 

Unit : The unit set for each channel is inserted into text data. 

Name and unit in one line 
 : The channel name and unit are inserted into text data in one line. 

If this item is not checked, the unit is appended to the line 

bellow the name. 

"OK" button : After the item is selected, the save dialog box is displayed. 

 

The "Save" dialog box as shown in Operation 2. is displayed. For the type of 

file, CSV file (comma-separated) or text file (tab-separated) can be selected. 

 

If the number of measurement data is larger than that of steps, the text file is 

divided by the number of steps. If the number of channels is larger than that of 

CH/NO, the text file is divided by the number of CH/NO. 

Serial numbers are put after the character string entered as a file name. 
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◼ DRA-7610 compatible 

 

Setting items 

Number of CH/NO 
 : The converted text file is divided by each specified number of 

columns. 

Number of steps 
 : The converted text file is divided by each specified number of 

rows. 

"OK" button : After the item is selected, the save dialog box is displayed. 

 

The "Save" dialog box as shown in Operation 2. is displayed. The data 

separation is fixed as CSV file (comma separation). 

 

Serial numbers are put after the character string entered as a file name. 
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◼ DADiSP compatible 

 

Setting items 

Number of CH/NO 
 : The converted text file is divided by each specified number of 

columns. 

Number of steps 
 : The converted text file is divided by each specified number of 

rows. 

Name : The channel name is inserted into text data. 

Unit : The unit is inserted into text data. 

"OK" button : After the item is selected, the save dialog box is displayed. 

 

The "Save" dialog box as shown in Operation 2. is displayed. The file type is 

fixed as DADiSP. 

 

Select the target folder from the file list. 

Input the file name. 

Click the "Save" button. 

Serial numbers are put after the character string entered as a file name. 

 

Files with the extensions of .HED and .DAT having the same name are created. 

Commercially available 
waveform analysis software 
can be read with the DADiSP 
and FlexPro. 
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◼ Frequency data file 
1. When the frequency data of the frequency data file is being 

displayed, the dialog box for conversion setting is 

displayed. 

 

Selection items 

Saving frequency analysis listing 
 : The list of settings, including the frequency data analysis 

method, full scale, hysteresis, and number of slices, is 

converted. 

Saving the indicated count data 
 : Count data of the frequency NO you have selected are 

converted. 

Saving all count data 
 : All the count data are converted, creating a file for each 

frequency NO. 

 

After choosing the text conversion method, click the "OK" button. 

The dialog box for setting the target folder and the file name of the text file is 

displayed. 

Select the target folder and type the file name. For the type of file, CSV file 

(comma separation) or Text file (tab separation) can be selected. 

 

After checking the setting, click the "Save" button.  

A text file with the typed file name is created.  

If the Save all count data is selected, the files for each frequency NO are 

created and "_" and the frequency NO are added to the file name. 
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1-7 Reading instrument data... 
Function This software can read the waveform data and the frequency 

data stored in the memory card or the shared folder of the 

instrument. 

 

Screen 

 

 

Description Data can be displayed as data file even if the measurement has 

been conducted off-line. 

The waveform data and the frequency data can be concurrently 

read. 

 

Operation 

1. Select Reading instrument data... from the File menu. 

The memory card data acquisition dialog box is displayed. 

2. After setting, click the "OK" button. 

 

To perform the frequency 
analysis using this software, 
the instrument shall be 
equipped with the function of 
executing the frequency 
analysis (option). 
 

"Measurement project" 
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Setting items 

Waveform data/Frequency data/Voice 
 : Select the type of data file to display. 

Selected files are read even if you have switched the display. 

Use the coefficient, unit, and format of file. 
 : If you check this box, the settings of coefficient, unit and format 

included in the specified folder are applied for reading 

waveform data. If there are no such data, the setting of the 

Measurement project is used. 

If you uncheck the box, the setting of the measurement project 

is used. 

"Reference..." button 
 : Select the folder that contains the data. 

Left list : For the measurement data that is in the referenced folder, the 

measurement date and hour, sampling clock, number of data, etc. 

are displayed. 

Right list : The list of the measurement data to read is displayed. 

"Register" button 
 : The data selected from left list is registered in right list. 

"Release" button 
 : The data selected in the right list is deleted from the list. 

 

When the "Reference..." button is clicked, the dialog box to select folder is 

displayed. 

 

Select the folder where the data are stored. 
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Select the measurement data to be read from the left list and click the 

"Register" button. The selected data is displayed in the right list. 

 

To read the frequency data, click the optional button for Frequency data. 

 

Click the "OK" button, then the registered data are loaded. 
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1-8 Creating instrument setting file... 
Function  Creates a setting file for setting the instrument using the 

instrument setting in the measurement project. 

 

Screen 

 

Description Instrument reads the setting file described in the exclusive 

format and performs instrument setting. 

You can create the setting file from the Measurement project. 

 

Operation 

1. Select Creating instrumet setting file... from the File 
menu to display setting dialog box. 

2. Designate the name of setting file and storing place (folder) 

and click the "Save" button. 

You cannot use a double-byte character set (i.e. Chinese, Japanese, Korean, 

etc.) in file name. 

If the firmware version of TMR - 211 is older than 2.2A or the firmware version 

of TMR - 311 is older than 1.4A, then it cannot load the setting file. 

 

The contents stored in the setting file are as follows:  

 A/D conversion setting 

 Input CH 

SET, Input mode, Input range, Low-pass filter, High-pass filter, Balance, 

Reference junction, Coefficient, Rated output, Capacity, Format 

 Output CH 

 Frequency NO 

 Digital IN/OUT 

 CAN/ Voice/ GPS 

Basic setting, CAN data 

 Data trigger measurement 

 Program measurement 

 

"Measurement project" 
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1-9 Outputting HR7916 in CSV format... 
Function The converted file has the same format with that of the CSV 

file that was converted into a text file by HR-7916. 

 

Screen 

 

Description A CSV file is created in the same format with that of the CSV 

file of the frequency data created using the software HR-7916 

for the histogram recorder HR-916. 

The file also can be converted by selecting any frequency NO. 

 

Operation 

1. Select Outputting HR7916 in CSV format... from the File 
menu. The dialog box for setting is displayed. 

2. After setting, click the "OK" button.  

3. The dialog box for setting the target folder and the file 

name is displayed.  

4. After setting, click the "Save" button. 

 

Setting items 

Setting information 

Input CH : The settings for the input CH used for the frequency analysis 

are added. 

Analysis condition 
 : The settings for the frequency number are added. 

M/M Data : The maximum and minimum values for the frequency No. are 

added. 

 

"Frequencey data" 



File menu 

 9-18 

Frequency data 

Lump : If you check this box, frequency data of all the frequency 

numbers are stored in a horizontal structure. 

Separate : If you check this box, frequency data of the frequency number 

which is specified for the output are stored separately in a 

vertical structure. 

Select "Yes" from the Output column. 

 

 

1-10 Save pictures... 
Function  Saves the chart sheet as bitmap (BMP), extension metafile 

(EMF) or PNG (png) formats. 

Screen 

 

Description  The selected chart is saved as image file. The saved image file 

can be used by commercially available word processor, DTP or 

graphic software etc, that can read the format used for the 

saving. 

 

Operation 

1. When Save pictures… is selected from File menu, the 

save dialog box is displayed. 

2. Operate the file list and select the target destination to save. 

3. Input the file name. 

4. Select the format of image. 

5. Click the "Save" button. 

The image file is saved in the location selected by step 2. 

"Chart sheet" 
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1-11 Print...  Ctrl+P 
Function Prints the selected sheet. 

 

Screen 

 

Description Set the pages and the number of copies to be printed. 

 

Operation 

1. Select Print... from the File menu. The dialog box for 

setting is displayed. 

2. After setting, click the "OK" button. 

 

Setting items 

Print range : Set the page number to be printed. 

When All is selected, every page is printed. 

Copies : Set the number of copies to be printed. 
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1-12 Print preview 
Function Displays the print image of the current window on the screen. 

 

Screen 

 

Description Before printing on a paper, the print image can be checked on 

the screen. 

In the case two or more pages are printed like as a data list, you 

can check the page number you need before printing. 

Operation 

1. Select "Print preview" from the File menu. The print image 

is displayed. 

 

Setting items 

Print... : The dialog box for implementing printing is displayed. 

Next page : Next page is displayed. 

Prev page : Previous page is displayed. 

Two page : Two pages are displayed on screen. 

One page : One page is displayed on screen. 

Zoom In : Displayed by enlarging it. 

Zoom out : Displayed by reducing it. 

Close : The preview is closed and the display returns to the previous 

screen. 

 

If the print preview is executed during monitor measurement, the screen flickers. 

If the flickering is annoying, stop the monitor measurement and execute the 

print preview. 
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1-13 Print option... 
Function Displays the dialog box for setting the printing conditions. 

 

Screen 

 

Description The print order for the measurement project or the 

measurement data file and the print size for the chart sheet are 

set. 

Operation 

1. Select Print option... from the File menu. The dialog box 

for setting is displayed. 

2. After setting, click the "OK" button. 

 

Setting items 

Print order of page 
 : For the setting and the data of Measurement project or 

Measurement data file, the print area on one sheet is determined 

in accordance with the size and direction of the paper. Specify 

the printing page order for the case where the content cannot be 

fitted in one sheet. 

 

Print with the paper size 
 : The window size is changed according to the specified paper 

size and direction. 
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1-14 Printer setup... 
Function Displays the dialog box for setting the selected printer. 

 

Screen 

 

Description Set the printer to be used, paper size and orientation, and click 

the "OK" button. 

 

Operation 

1. Select Printer setup... from the File menu. The dialog box 

for setting is displayed. 

2. After setting, click the "OK" button. 

 

Setting items 

Name : Select the used printer. 

Size : Select the paper size. 

Orientation : Select the orientation of paper. 
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1-15 Print all charts... 
Function  Prints chart sheets selected from the opened chart sheets 

collectively. 

 

Screen 

 

Description  It is possible to divide one paper vertically and horizontally and 

print the chart sheets by allocating them. 

Operation 

1. Open the chart sheets to be printed. 

2. When Print all charts… is selected from File menu, the 

dialog box for making a setting is displayed. 

3. After the setting, click the "Print" button. 

 

Setting items 

Target chart : The list of opened chart sheets is displayed. 

Chart to Print 
 : The list of chart sheets to be printed is displayed. 

"Register>>" button 
 : The sheet selected from the Target chart list is registered in the 

Chart to print list. 

"Insert>>" button 
 : The sheet selected from the Target chart list is inserted between 

sheets registered in the Chart to print list. 

"Release" button 
 : The sheet selected from the Chart to print list is deleted from 

list. 

"Release all" button 
 : Every sheet registered in the Chart to print list is deleted. 

"Setting" button 
 : The settings of the Chart to print and the Layout to print pages 

are recorded. When you open this dialog box again, recorded 

setting is retrieved. The setting will be canceled by exiting this 

software. 
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Layout to print pages 

Print with layout 
 : Multiple sheets are printed in one piece of paper. 

Set the vertical and horizontal division number and decide the 

printing area of sheet. 

When the drawing area is larger than paper size, the parts 

allocation is adjusted according to the printing area and it is 

printed. 

Print with the paper size 
 : One sheet is printed by adjusting it to the specified paper size 

and adjusting the parts allocation. 

 

When the parts layout is arranged to fit in printing area or in the paper size, a 

section of parts may stick out of the printing area, because the size of parts are 

not changed. 

 

1-16 Exit application 
Function Closes all the open windows and exits this software. 

 

Screen 

 

Operation 
1. Select Exit application from the File menu. The dialog box 

is displayed. 

2. To save the sheet, click the "Yes" button. The Save process 

is executed and the window is closed. After closing all the 

windows, the software is exited.  

3. If you don’t save the sheet, click the "No" button. Without 

saving the sheet, the windows are closed and this software 

is exited. 
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2 Edit menu 
Overview 

 Canceling the last operation 

 Deleting a character string or image to save it in the clipboard 

 Saving the copy of character string or image in the clipboard 

 Pasting the data in the clipboard 

 Deleting character strings or images 

 Selecting all character strings and images 

 Inserting rows 

 Deleting rows 

 Downward copy 

 Changing the selected character to superscript character 

 Returning the selected superscript character to standard character 

 Recalculating the operation data 

 Cutting out of data 

 Thinning out of data 

 Duplicating chart sheets 

 Moving the selected parts on a chart to front 

 Moving the selected parts on a chart to back 

 Disabling the change 

 Displaying the OLE object which is in the selected chart or blank form 

 Checking the link of OLE object 

 Editing the OLE object 

・Displaying images which is in the selected chart or blank form 

 

 

"Chart sheet" 

 
"Frequency data" 

 
"Measurement data" 

 
"Measurement project" 
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2-1 Undo  Ctrl+Z 
Function The last operation is canceled and the screen is returned to the 

previous one. 

 

Description Cancel the last operation. If Undo is executed again, the screen 

is returned to the status before cancellation. 

 

2-2 Cut  Ctrl+X 
Function The selected cells or the character string in the input box are 

deleted and stored in the clipboard. 

 

Description  The Cut is used mainly for deleting the selected data and 

moving it to another place. 

Only one data can be stored in the clipboard. Any old data that 

was cut out and copied in the clipboard is abandoned and 

replaced with new one. 

 

2-3 Copy  Ctrl+C 
Function For the measurement project or the measurement data file, the 

character string in the selected cell or input box is stored in the 

clipboard. For the chart sheet, the selected parts are stored in 

the clipboard. 

 

Description The Copy is used mainly for copying any selected data. 

Only one data can be stored in the clipboard. Any old data that 

was cut out and copied in the clipboard is abandoned and 

replaced with new one. 

 

2-4 Paste  Ctrl+V 
Function The data in the clipboard is pasted to the specified place. 

 

Description Measurement project, Measurement data file:  

The character string in the clipboard is pasted in the cell or the 

input box. 

Chart sheet:  

The cut or copied parts are pasted. 

 

2-5 Clear  Ctrl+B 
Function Selected character string in a cell or an input box on the 

Measurement project, or selected title or picture in the Chart 

sheet is deleted. 

 

Description Differently from Cut, data is not stored in the clipboard. 
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2-6 Select All  Ctrl+A 
Function All characters, chart and pictures displayed on the open 

window are selected.  

 

Description This is used for moving all parts in the Chart sheet at a time. 

 

2-7 Insert 
Function  Rows are inserted in the data list. 
 

Screen 

 

 Before insertion   After insertion 

Description Rows (steps) are inserted in the data list. 
In some other settings, rows can be inserted in each column. 

 

2-8 Delete 
Function Rows are deleted from the data list. 
 

Screen 

 

Before deletion   After deletion 

Description Rows (steps) are deleted from the data list. 

In some other settings, rows can be deleted from each column. 

"Measurement project" 
"Measurement data" 

"Measurement project" 
"Measurement data" 
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2-9 Fill Down  Ctrl+D 
Function The data in the top row in the selected rows are copied 

downward to the cells in the selected rows. 

 

Screen 

 

Before fill down 

 

After fill down 

Description The Fill Down is used for entering the similar settings in a 

series of rows. 

 

2-10 Superscript 
Function  The selected characters are changed to superscripts. 

 

Description This is used to change the selected character to superscript 

while editing the unit display. 

 

Operation 

1. Select the character to be changed to superscript from the 

character string of the unit using Shift key and ← or → 

key. 

2. Select the Superscript in the Edit menu. 

 

"Measurement data" 

"Measurement project" 
"Measurement data" 
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2-11 Default 
Function Superscripts are changed to standard-size characters.  

 

Description This is used to change the selected character to standard-size 

character while editing the unit display. 

 

Operation 

1. Select the character to be changed to standard-size from the 

character string of the unit using Shift key and ← or → 

key. 

2. Select the Default in the Edit menu. 

 

2-12 Not editable 
Function This disables the change of the setting or the data in the 

Measurement project or the Measurement data file. 

It also disables the movement of the parts in the Chart sheet. 

 

Description If editing is disabled, it becomes impossible to enter with a 

keyboard and to move parts with a mouse. 

 
"Measurement data" 
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2-13 Selection... 
Function The dialog box for setting the field where insertion or deletion 

is executed in the data list or the chart list is displayed. 

 

Screen 

 

Description The field where insertion or deletion is executed in the data list 

or the chart list can be set with numeric values. 

 

Operation 

1. Select Selection... from the Edit menu. The dialog box for 

setting is displayed. 

2. After setting, click the "OK" button. 

There are two kinds of field selection methods; Setting by 

measurement time and setting by the number of data. 

 

Setting items 

Set by measurement time/Set by the number of data 
 : Select whether the range is set by measurement time or number 

of data. 

Top : Set the beginning part to be selected. The unit when the range is 

set by measurement time depends on the unit of measurement 

time of measurement data file. 

End : Set the last part to be selected. The unit when the range is set by 

measurement time depends on the unit of measurement time of 

measurement data file. 

"Check" button 
 : When it is set by measurement time, the number of data 

equivalent to the set value is displayed. When it is set by the 

number of data, the measurement time equivalent to the set 

value is displayed. 

 

"Measurement data" 
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2-14 Recalculation  F5 
Function Re-calculation of the expanded channel is carried out. This is 

used when arithmetic expression is added after the 

measurement. The chart that is drawn with changed and added 

operation data is also updated. 

 

Description  This is used when the arithmetic expression is changed or 

added for the measurement data file. 

 

2-15 Deletion before/after 
Function Data is cut out in the data list or the chart list. 

 

Screen 

 

Before deletion 

 

After deletion 

Description The data except the data selected in the data list or the chart list 

are deleted. 

 

For detailed description of 
recalculation, refer to "Chapter 
7: 7-10 Operation of 
measurement data" (Page 
7-35). 
 

"Measurement data" 
 

"Measurement data" 
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2-16 Thin out... 
Function The dialog box for setting the number of data to be thinned out 

at regular intervals in the data step is displayed. 

 

Screen 

 

Description The number of data is reduced by thinning out the data step at 

regular intervals. 

 

Operation 

1. Select Thin out... from the Edit menu. The dialog box for 

setting is displayed. 

2. After setting, click the "OK" button. 

 

The number of thin-out data 
 : The data of steps for which 1 is added to the set number are 

remained. If 4 is set for example, the data of steps 1, 6, 11 and 

so on are remained as data. The new sampling time is 

"sampling time x (the number of thinning out + 1)", and the 

measurement time is "(the number of remained data - 1) x 
new sampling time". 

 

2-17 Duplicate charts 
Function The sheet same as selected chart sheet and blank form is 

displayed. 

 

Description This is used for drawing a chart with different data in the same 

layout. 

 

For the detailed description of 
thinning out, refer to "Chapter 
7: 7-1 Thinning-out of the 
data". (Page 7-23). 
 

"Chart sheet" 

"Measurement data" 
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2-18 Move to the top face Ctrl+T 
Function The part selected in the chart sheet is moved to the front. 

 

Description This is used in superposing parts. 

The selected part is moved to the front. 

 

Operation 

1. Click a part to be selected. 

2. Select Move to the top face from the Edit menu. 

 

2-19 Move to the back face Ctrl+R 
Function The part selected in the Chart sheet is moved to the back. 

 

Description This is used in superposing parts. 

The selected part is moved to the back. 

 

Operation 

1. Click each part to select. 

2. Select Move to the back face from the Edit menu. 

 

"Chart sheet" 
 

"Chart sheet" 
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2-20 Create and paste a new object... 
Function  Picture and image etc. are displayed on chart sheet. 

Screen 

 

Description  The picture or image is created or inserted on chart sheet using 

the software that supports OLE function of Windows, and it is 

displayed. 

 

Operation 

1. The chart sheet or blank sheet is activated. 

2. Select Create and paste a new object... from Edit menu. 

The dialog box for creating the object is displayed. 

3. When creating the object newly, click Create New and 

select the format of object from Object type. 

4. When there is a file to be inserted already, click Create 
from File. 

The display of dialog box changes. 

 

5. Input the location of file and file name for file. 

When the "Browse..." button is clicked, the dialog box for 

referencing file is displayed, so select the file. 

6. When Link is checked, the file to be inserted is changed and 

the object created on chart sheet is also updated. 

7. When the "OK" button is clicked, the corresponding 

software is started up, and the screen changes to edit screen 

of object. 

"Chart sheet" 
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2-21 Link Setup... 
Function  Check the setting of linked object. 

Screen 

 

Description  When the original file of linked file is changed or its location is 

moved, the link is updated. 

 

Operation 

1. Select the object by clicking the mouse. 

2. When Link Setup… is selected from Edit menu, the dialog 

box for link is displayed. 

3. Click the button above and execute it. 

 

"Update Now" button 
 : The linked file is read and displayed. 

"Open Source" button 
 : The file is opened by corresponding software. 

"Change Source..." button 
 : The file to be linked is changed. 

"Break Link" button 
 : The link is released and file is not updated. 

Update : Select whether the file is automatically updated when the file is 

changed, or it is updated by "Update Now" button. 

 

2-22 Linked Bitmap Image Object 
Function  The linked object is edited. 

 

Description  The content displayed for menu varies depending on the object. 

Generally, the Edit menu for editing the object on chart sheet 

and Open menu for opening the object by corresponding 

software are added. 

 

 

"Chart sheet" 
 

"Chart sheet" 
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2-23 Paste image… 
Function  BMP, PNG and JPG format images are displayed on chart 

sheet. 

Screen 

 

Description  BMP, PNG and JPG format image are inserted on chart sheet. 

 

Operation 

1. The chart sheet or blank sheet is activated. 

2. Select Paste image... from Edit menu. 

The open file dialog box is displayed. 

3. Select images, and click “Open” button 

 

"Chart sheet" 
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3 Project menu 
Overview 

 Setting the instrument to be used 

 Setting the measurement time 

 Switching the display 

 The submenu items for setting of Input CH is displayed 

 The submenu items for setting of Output CH is displayed 

 The submenu items for setting of Frequency setting is displayed 

 The dialog box for inputting a function in the function column of Expanded 

CH is displayed 

 The submenu for setting ON/OFF is displayed 

 The submenu for setting the trigger mode of the data trigger is displayed 

 The submenu for setting the control of automatic measurement setting is 

displayed. 

 Selecting the data to be referred to for triggering data comparator 

measurement. 

 Adding sequential number to the name that is input in the name column of 

Input CH and Expanded CH 

 The submenu for making a setting for the unit column of Input CH and 

Expanded CH is displayed 

 The display format for displaying the measurement data by value is displayed 

in sub menu 

 Changing the width of column 

 Changing the width of column of Chart list 

 Displaying the data file in the history 

 Changing the data file name in the history 

 Converting the data file into a text file in the history 

 Changing the test title of data file in the history 

 Updating the history 

"Measurement project" 
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3-1 Meter setting... 
Function Sets the instrument on the measurement project. 

 

Screen 

 

Description Setting for the instrument and the interface to be used in the 

measurement project is executed. 

 

Operation 

1. Select Meter setting... from the Project menu. The dialog 

box for setting is displayed. 

2. After setting, click the "OK" button. 

 

Setting items 

Control Unit : Selects the control unit to use. (TMR-211 or TMR-311) 

Interface type 

 : Selects the interface to use. (LAN or USB) 

 

When using LAN: 

IP address : Sets the IP address of the instrument to use. 

Port number : Sets the port number of the instrument to use. 

 

Connection 

Confirm : Confirms whether connection is possible with the contents of 

interface that is connected to the computer and the instrument. 

Acquisition of unit name 
 : The information of the unit in use is obtained from the 

instrument and the unit's setting is renewed. 

IP address change 
 : Changes LAN setting of instrument. 

 

Create... : Creates the TMR_IPADDRESS file for the selected instrument. 

For the Meter setting, refer to 
"Chapter 4: 2 Setting of the 
instrument" (Page4-2). 
 

"Measurement project" 
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3-2 A/D setting... 
Function  Sets the data intervals and the number of data to be recorded in 

a single measurement. 

 

Screen 

 

Description Setting the data intervals and the number of data to be recorded 

in a single measurement is executed. 

The settings can be obtained with the number of data based on 

the measurement time. 

 

Operation 

1. Select A/D setting... from the Project menu. The dialog 

box for setting is displayed. 

2. After setting, click the "OK" button. 

 

Setting items 

Data words : Specify the number of data to be recorded. 

Pre data words 
 : For Data trigger measurement, specify the number of pre-trigger 

recording within the number of data words set above. 

Sample clock 
 : Set the interval of data recording in millisecond. 

External sample 
 : The external sample can be used when SCLK is input to digital 

IN of digital I/O unit. 

The external sample is valid when Digital I/O unit is used. 

 

Find from measuring time. 
 : Check this to set the A/D setting based on the measurement 

time. 

Measurement time 
 : Set the measurement time. The unit is selected from millisecond, 

second, minute, and hour. 

Time before trigger 
 : For Data trigger measurement, specify the recording time until 

the trigger is activated within the measurement time set above. 

The unit is same as that of measurement time. 

For the A/D setting, refer to 
"Chapter 4: 3 A/D setting" 
(Page4-6). 

The units set for the 
measurement time are 
reflected to the units of the 
elapsed time display and those 
of the horizontal axis of the 
chart displaying the progress 
during measurement. 
 

For the External sample, refer 
to "Chapter 12: Digital I/O unit". 
 

"Measurement project" 
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Phenomenal 
 : The inverse number of the sample clock time is displayed. 

Sample clock can be set by selecting frequency. 

"Calculation" button 
 : This displays the measurement time corresponding to the 

number of data that you set. If you have made a setting using 

the Find from measuring time method, the number of data 

corresponding to the values you have set is displayed. 

 

The time before trigger and the pre data words are enabled only for data 

trigger measurement. 
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3-3 Switch to 
Function Changes the display items of the active measurement project. 

 

Description  

Input CH  : Specify the conditions for the instrument to record data and the 

settings for this software to process the recorded data for each 

channel. 

Output CH : When voltage output from the instrument is enabled, the output 

settings are made for each channel. 

Frequency NO 

 : Specify the frequency analysis method for each frequency 

number when conducting frequency analysis at the same time 

with measurement by the instrument. 

Expanded CH 

 : Specify the calculation using the recorded data. Arithmetic 

operations and functions, and functions including rosette 

analyses can be used. 

Data trigger measurement 

 : Specify the measurement start with the instrument according to 

the level of input signal. 

Program measurement 

 : Specify the measurement system automatically starts 

measurement at the specified measurement date and hour and 

continues it for the specified duration. 

Interval measurement 

 : Specify starting measurement at certain intervals using the clock 

of computer. 

Data comparator measurement 

 : Specify starting measurement with variation of specific channel 

(including Expanded CH). 

Data list : Lists for all channels are created. 

Maximum value, minimum value and average value are 

displayed. 

Chart list : Progress charts for all channels are created. 

Maximum value, minimum value and average value are 

displayed. 

Measurement history 

 : File name, memory card file name, measured date and time, 

measurement method, test title, measurement duration and unit 

are displayed for all waveform data measured. 

Maximum/Minimum/Average 

 : Maximum, minimum and average values are displayed for each 

channel of all measurement data measured. 

Frequency history 

 : File name, memory card file name, starting and stopping time of 

measurement and test title are displayed for all frequency data 

measured. 

To perform the frequency 
analysis using this software, 
the instrument shall be 
equipped with the function of 
executing the frequency 
analysis (option). 

"Measurement project" 
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3-4 SET 
Function Sets Use/Not use of channel. 

 

Description Set "SET" for the channel to be measured, and set "OFF" for 

the channel not to be measured. 

 

Operation 

1. Select a cell in the SET column on the Input CH. 

2. Select SET or OFF from the SET submenu in the Input 
CH submenu. 

 

3-5 Input mode 
Function Sets the type of input signals (voltage, bridge voltage, and 

thermocouple). 

 

Description The resolution of strain changes depending on the setting of 

bridge voltage. 

  4G0.5V : Resolution is 4x10-6 strain 

  4G2.0V : Resolution is 1x10-6 strain 

Some input modes cannot be set depending on the unit. For the 

type of settable input modes, refer to the operation manual of 

each instrument. 

When measuring temperature using a thermocouple, a 

dedicated thermocouple unit (TMR-231, TMR-332) is 

required. 

 

Operation 

1. Select a cell in the Input mode column on the Input CH. 

2. Select the input mode from the Input mode submenu in the 

Input CH submenu. 

 

 
"Measurement project" 

 
"Measurement project" 
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3-6 Input range 
Function Sets the resolution of fixed range. 

 

Description Value covering the expected maximum value of input 

waveform is input for the measurement range. 

The smaller range provides less dispersion in the measured 

values. 

 

TMR-211 Strain Full Bridge 
Input 
range 

Input mode 
4G 2.0V 4G 0.5V VOLT (CR-4010) 

5000 -5,000～+5,000 (1×10-6) -20,000～+20,000 (4×10-6) -5,000～+5,000 (1mV) 
10000 -10,000～+10,000 (1×10-6) -40,000～+40,000 (4×10-6) -10,000～+10,000 (1mV) 
20000 -20,000～+20,000 (2×10-6) -80,000～+80,000 (8×10-6) -20,000～+20,000 (2mV) 

 

TMR-211 Voltage/Thermocouple 

Input 
range 

Input mode 

VOLT Thermocouple 
600  -200～+600 (0.1℃) 

1000 -1,000～+1,000 (0.1mV)  

1300  -200～+1,300 (0.2℃) 
※Not usable with a thermocouple T. 

5000 -5,000～+5,000 (0.5mV)  
10000 -10,000～+10,000 (1mV)  
20000 -20,000～+20,000 (2mV)  

 

TMR-311 Strain Full Bridge 

Input 
range 

Input mode 

4G 2.0V 4G 0.5V VOLT (CR-4010) 
2000 -2,000～+2,000 (0.1×10-6) -8,000～+8,000 (0.4×10-6) -2,000～+2,000 (0.1mV) 
5000 -5,000～+5,000 (1×10-6) -20,000～+20,000 (4×10-6) -5,000～+5,000 (1mV) 

10000 -10,000～+10,000 (1×10-6) -40,000～+40,000 (4×10-6) -10,000～+10,000 (1mV) 
20000 -20,000～+20,000 (1×10-6) -80,000～+80,000 (4×10-6) -20,000～+20,000 (1mV) 

 

TMR-311 Voltage Input 
Input 
range 

Input mode 
VOLT Thermocouple 

600  -200～+600 (0.1℃) 
1000 -1,000～+1,000 (0.1mV)  

1300  
-200～+1,300 (0.2℃) 

※Not usable with a thermocouple T. 
5000 -5,000～+5,000 (0.5mV)  

10000 -10,000～+10,000 (1mV)  
20000 -20,000～+20,000 (2mV)  
52000 -52,000～+52,000 (5mV)  

 

Operation 

1. Select a cell in the Input range column on the Input CH. 

2. Select the input range from the Input range submenu of the 

Input CH submenu. 

 

 
"Measurement project" 
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3-7 Low-pass filter 
Function Sets the frequency to be removed from the input signals. 

 

Description A digital filter is used as the low-pass filter. When PASS is set 

for the low-pass filter, an analog filter is used to remove the 

frequency component of 10kHz or higher. For thermocouple, 

only PASS can be selected. 

 

Operation 

1. Select a cell in the Lowpass filter column on the Input CH. 

2. Input frequency within the range of 0 to 1000Hz or select 

from the Lowpass filter submenu of the Input CH 

submenu. 

 

3-8 Characteristics 
Function Sets the characteristic of cut-off frequency of the digital filter. 

 

Description If PASS is set for the low-pass filter, Bessel is set. 

If Bessel is selected, the phase becomes flat. 

If Butterworth is selected, the amplitude becomes flat. 

 

Operation 

1. Select a cell in the Characteristic column of Lowpass 
filter on the Input CH. 

2. Select the filter characteristic from the Characteristic 

submenu of the Input CH submenu. 

 

3-9 High-pass filter 
Function Sets the frequency to be removed from the input signals. 

 

Description High-pass filter is available with Strain Full Bridge Unit 

(TMR-221/TMR-321), Strain 1G2G4G Unit 

(TMR-222/TMR-322) and Carrier type Strain Full Bridge unit 

(TMR-223/TMR-323). 

 

When the TMR-211 is used as a control unit, its firmware must be Ver. 2.2A or 

later. In addition, the firmware of the measurement unit (TMR-221/TMR-222) 

must be 1.2A or later. 

 

Operation 

1. Select a cell in the Highpass filter column on the Input 
CH. 

2. Select from the Highpass filter submenu of the Input CH 

submenu. 
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3-10 Balance 
Function Sets valid/invalid of the instrument balancing function. 

 

Description  The invalid channel becomes unavailable for balancing. A 

value including initial unbalance value is measured. 

 

Operation 

1. Select a cell in the Balance column on the Input CH. 

2. Select from the Balance submenu of the Input CH 

submenu. 

 

3-11 Reference junction 
Function Sets the reference junction for thermocouple measurement 

 

Description When RJC ON is selected, cold junction compensation is 

performed taking the surface temperature of the measurement 

unit as a reference. When an external cold junction is used, 

select RJC OFF. 

 

Operation 

1. Select a cell in the Reference junction column on the 

Input CH. 

2. Select from the Reference junction submenu of the Input 
CH submenu. 

 

3-12 Output voltage 
Function Sets the output voltage of the amplifier. 

 

Description The voltage output range for each channel of the voltage output 

unit (TMR-241) is selected from ±5V, ±10V and 0 to +5V. 

 

Operation 

1. Select a cell in the Output voltage column on the Output 
CH. 

2. Select the output level from the Output voltage submenu 

of the Output CH submenu. 
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3-13 Analysis method 
Function Sets the method of the frequency analysis which is conducted 

at the same time with the measurement. 

 

Description The following 6 kinds of analysis methods can be set. 

PEAK/V : Peak/valley method 

MAX/MIN : Maximum/minimum method 

AMP  : Amplitude method 

TIME  : Time method 

LEVEL : Level-crossing method 

RAIN  : Rain-flow method 

 

Operation 

1. Select a cell in the Analysis method column on the 

Frequency NO 

2. Select the analysis method from the Analysis method 

submenu of the Frequency setting submenu. 

 

3-14 Sampling 
Function If the time method is used for the analysis method, sets the 

sampling time. 

 

Description If the time method is used for the analysis method, the input 

signal is sampled and counted at every sampling interval set by 

this operation. 

 

Operation 

1. Select a cell in the Sampling/Cross level column on the 

Frequency NO 

2. Select the sampling time from the Sampling submenu of 

the Frequency setting submenu. 
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To perform the frequency 
analysis using this software, 
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of executing the frequency 
analysis (option). 
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3-15 Paste function... 
Function  Pastes the function into a cell. When a cell has been selected, 

the selected function is overwritten to the cell. When you are 

editing a cell, selected function is inserted into the editing 

position. 

 

Screen 

 

Description When the function is input using Paste function…, the 

function can be input more correctly than it is input from 

keyboard. And the comment is displayed for necessary 

argument. 

 

Operation 

1. Select a cell in the Function column on the Expanded CH. 

2. When Paste function… is selected from Project menu, the 

dialog box of function list is displayed. 

3. Select the function to be set and click the "OK" button. 

 

3-16 ON/OFF 
Function Sets the trigger ON/OFF of the Data trigger measurement. 
 

Description To enable the trigger of the Data trigger measurement, set 

ON. To disable it, set OFF. 
 

Operation 

1. Select a cell in the ON/OFF column on the Data trigger 
measurement.  

2. Select ON or OFF from the ON/OFF submenu of the 

Project menu. 
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3-17 Trigger mode 
Function Sets the trigger level judgment method of the Data trigger 

measurement. 
 

Description The trigger level judgment method of the Data trigger 
measurement is selected from Relative, Upper and Lower. 

 

Setting items 

Relative : The trigger is executed when the value changes by the set value 

for the trigger level from the value measured at the start of the 

data trigger measurement. 

Upper : The trigger is executed when the current value becomes larger 

than the trigger level. 

Lower : The trigger is executed when the current value becomes smaller 

than the trigger level. 

 

Operation 

1. Select a cell in the Trigger mode column on the Data 
trigger measurement. 

2. Select the trigger mode from the Trigger mode submenu of 

the Project menu. 

 

3-18 Control 
Function  Sets the measurement condition for a step of interval 

measurement and data comparator measurement. 

 

Description The measurement is performed for each step for interval 

measurement and data comparator measurement. Set the 

termination condition for each step. 

 

Operation 

1. Select a cell of the control row of interval trigger 

measurement or data comparator measurement. 

2. Select from the Control submenu of the Project menu. 

 

Setting item 

INFINITY  : Measurement is performed until the measurement is stopped 

manually. 

REPEAT  : Measurement is repeated for the number of times that is 

specified by Repeat. 
GOTO  : It shifts to the step that is specified by Repeat. Measurement 

start time and measurement interval are ignored. 
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3-19 Select data... 
Function  Sets the data of data comparator measurement. 

 

Screen 

 

Description It is possible to set the data by selecting name using Select 
data… 

 

Operation 

1. Select a cell in the Name (CH/NO) column on the Data 
comparator measurement. 

2. When Select data… is selected from Project menu, the 

dialog box of name is displayed. 

3. Select the name to be set and click the "OK" button. 
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3-20 Name... 
Function Adds serial numbers to the character string of the name. 

 

Screen 

 

Description To set characters to be added to the character string of name. 

This is useful when changing the serial numbers or when 

setting names for 2-axial/3-axial strain gauges. 

 

Operation 

1. Select some cells in the Name column on the Input CH or 

the Expanded CH. 

2. Select Name... from the Project menu. The dialog box for 

setting is displayed. 

3. After setting, click the "OK" button. 

 

Setting items 

 

Concatenation number 

Consecutive No 
 : Sequential number is added. 

Consecutive NoXY 
 : Sequential number is added for each two names. 

Consecutive NoXYZ 
 : Sequential number is added for each three names. 

 

"Measurement project" 

If the start number is set as 
000, the concatenation 
numbers are set as 
000,001,002... 
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3-21 Unit 
Function Sets the unit. 

 

Description It is also possible to input a unit from keyboard for the 

Expanded channel in the Measurement project. 

When the TMR-311 is used, it is possible to set up to ten 

one-byte characters optionally for the Input CH. 

 

Operation 

1. Select a cell in the Unit column on the Input CH or the 
Expanded CH. 

2. Select the unit from the Unit submenu of the Project menu. 

 

3-22 Format 
Function Selects display style and digit number of measurement data 

(numeric value, time, and calculation data). 

Screen 

 

Value  Exponent 

Description The format has an effect on the numerical display of data but 

internally keeps the accuracy. 

There are the following formats. 

0 to 0.0000000   : Value 

0e+00 to 0.0000000e+00  : Exponent 

 

Operation 

1. Select a cell in the Format column on the Input CH or the 
Expanded CH. 

2. Select the appropriate format from the Format submenu of 

the Project menu and select any of the displayed 

submenus. 
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3-23 Column width... 
Function Sets the width of the column including the selected cell in the 

unit of mm. 

Screen 

 

Description The width of all the columns displayed on the measurement 

project can be set. 

 

Operation 

1. Select a cell and select the Column width... from the 

Project menu. The dialog for setting is displayed. 

2. After setting, click the "OK" button. 

 

3-24 Chart column width... 
Function Sets the width of the columns where the chart is displayed on 

the Chart List in the unit of mm. 

 

Screen 

 

Description On the Chart List, columns cannot be selected. Therefore, by 

executing the Chart column width..., the width of the chart 

columns is changed. 

 

Operation 

1. Select Chart column width... from the Chart list width 

submenu of the Project menu. The dialog box for setting 

is displayed. 

2. After setting, click the "OK" button. 
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3-25 Legend column width... 
Function Sets the width of the column where the legends are displayed 

(at the right end) on the Chart list in the unit of mm. 

 

Screen 

 

Description On the Chart list, columns cannot be selected. Therefore, by 

executing the Legend column width..., the width of the 

legend column is changed. 

 

Operation 

1. Select the Legend column width... from the chart list 
width submenu of the Project menu. The dialog box for 

setting is displayed. 

2. After setting, click the "OK" button. 

 

3-26 Row height... 
Function On the chart list, sets the height of row in the unit of mm. 

 

Screen 

 

Description On the chart list, rows cannot be selected. Therefore, by 

executing the Row height..., the height of row is changed. 

 

Operation 

1. Select the Row height... from the Chart list width 

submenu of the Project menu. The dialog box for setting is 

displayed. 

2. After setting, click the "OK" button. 
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3-27 Show data file 
Function Displays the data file of the selected step in the measurement 

history, maximum/minimum/average value or frequency 

history. 

 

Description A number of measurement data files in the history can be 

displayed. 

 

Operation 

1. Select the step of the data file to be displayed in the 

Measurement history, the Maximum Minimum Average 
or the Frequency history. 

2. Select the Show data file from the Project menu. 

 

3-28 Change data file name... 
Function Changes the data file name of the step selected in the 

measurement history. 

 

Screen 

 

Description The file names of multiple data files in the measurement 
history or the frequency history are changed by adding serial 

numbers. 

 

Operation 

1. Select the step of the data files of which the file names 

should be changed in the Measurement history or the 

Frequency history. 

2. Select Change data file name... from the Project menu. 

The dialog box for setting is displayed. 

3. After setting, click the "OK" button. 

 

Setting items 
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If the start number is set as 
000, the concatenation 
numbers are set as 
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3-29 Convert data file to text... 
Function Converts the measurement data file of the selected step in the 

measurement history or the maximum/minimum/average 

value to text. 

 

Screen 

 

Description From the measurement history or the 

maximum/minimum/average value, the data stored in the 

files of two or more file names are converted to text in various 

styles. 

The file name is made up as follows: 

 

Operation 

1. Select the step of the measurement data file to be converted 

to text in the Measurement history or the Maximum 
Minimum Average. 

2. Select Convert data file to text... from the Project menu. 

The dialog box for setting is displayed. 

3. After setting, click the "OK" button. 
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Setting items 

"Folder selection" button 
 : The dialog box for specifying the destination to save is 

displayed. 

Number of CH/NO 
 : When the number of channels that are converted is larger than 

Number of CH/NO, the text file is divided by Number of 

CH/NO. 

Number of steps 
 : When the number of measurement data is larger than Number of 

steps, the text file is divided by Number of steps. 

Text format (TXT) 
 : The file is converted to tab-delimited text file of unique format. 

CSV : The file is converted to comma (,)-delimited text file of unique 

format. 

DRA-7610 compatible (CSV) 
 : The file is converted to a format same as that of CSV file for 

which text conversion is implemented by DRA-7610. When this 

format is used, the name of channel is not converted. 

DADiSP compatible (DAT) 
 : The file is converted to the text file that can be read by the 

waveform analysis software DADiSP. For one data file, two 

files whose extensions are .HED and .DAT are created. 

Test title : The title of test is inserted into text data. 

Name : The channel name is inserted into text data. 

Unit : The unit set for each channel is inserted into text data. 

Name and unit in one line 
 : The name and unit of each channel is added in one line. 

If this item is not checked, the unit is appended to the line 

bellow the name. 

 

Commercially available 
waveform analysis software 
can be read with the DADiSP 
and FlexPro. 
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3-30 Convert frequency file to text... 
Function By specifying the frequency data file in the frequency history, 

converts the specified frequency data file to text. 

 

Screen 

 

Description From the frequency history, the data stored in the files of two 

or more file names are converted to text in various styles. 

The file name of the text file will be the same as that of the 

data file. 

In the text (TXT) or CSV format, separated files will be created 

for each frequency No, and "_" and the frequency No are added 

to the end of the file name. 

 

Operation 

1. Select the step of the frequency data file to be converted to 

text in the frequency history. 

2. Select Convert frequency file to text... from the Project 
menu. The dialog box for setting is displayed. 

3. After setting, click the "OK" button. 

 

Setting items 

"Foloder Selection" button 
 : The dialog box for specifying the destination to save is 

displayed. 

Text format (TXT) 
 : The file is converted to tab-delimited text file of unique format. 

CSV : The file is converted to comma (,)-delimited text file of unique 

format. 

HR-7916 compatible (CSV) 
 : The file is converted to a format same as the CSV file of text 

output of frequency data created by HR-7916. 

If you select this format, you should select item(s) to be added 

to the text file. 

Input CH : The settings for the Input CH used for the frequency analysis 

are added. 

Analysis condition 
 : The settings for the frequency NO are added. 

M/M data : The maximum and minimum values of the frequency NO are 

added. 

"Measurement project" 
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3-31 Change the title of test... 
Function Changes the test title of the step selected in the measurement 

history or the frequency history. 

 

Screen 

 

Description The test title of the multiple measurement data files in the 

Measurement history or the Frequency history are changed. 

 

Operation 

1. Select the step of the measurement data file of which the 

test title should be changed in the Measurement history or 

the Frequency history.  

2. Select Change the title of test... from the Project menu. 

The dialog box for setting is displayed. 

3. After setting, click the "OK" button. 

 

Setting items 

Add to title : The set character string is added to the end of the test title that 

has been set for the data file. 

Concatenation number 
None : Sequential number is not added. 

Consecutive NO 
 : Sequential number is added. 

 

 

If the start number is set as 
000, the concatenation 
numbers are set as 
000,001,002... 
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3-32 Update the Measurement history... 
Function Searches data file in the measurement data folders and updates 

the history. 

 

Screen 

 

Description Usually, the history is automatically updated when the 

measurement project is displayed. If the measurement data file 

is moved or edited after the measurement project is displayed, 

the Measurement history is not automatically updated. In that 

case, execute the Update the Measurement history. 

 

Operation 

1. Display the Measurement history, the Maximum 
Minimum Average or the Frequency history, and select 

the Update the Measurement history... from the Project 
menu. The dialog box for confirmation is displayed. 

2. Click the "Yes" button. 
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4 Measurement data menu 
Overview 

 Switching the display 

 Adding sequential number to the name that is input in the name column of 

Input CH and Expanded CH 

 The submenu for making a setting for the unit column of Input CH and 

Expanded CH is displayed 

 The display format for displaying the measurement data by value is displayed 

in submenu 

 Changing the width of column. 

 Changing the width of column of Chart list. 

 Changing the height of row of Chart list 

 Displaying a cursor in Chart list 

 Searching a measurement data range for the maximum and minimum values 

 Displaying and editing the marker in Chart list 

 The submenu for setting the unit of lapsed time of measurement data is 

displayed 

 

 

4-1 Switch to 
Function Changes the display items of the active measurement data file. 

 

Description 

Input CH : Displays the conditions of each channel which were set to the 

instrument for recording data during the measurement. 

Name, unit and format can be changed. 

Expanded CH 

 : Make a setting for implementing calculation using recorded data. 

The functions such as four arithmetic operations, arithmetical 

function and rosette calculation can be used. 

Data list : Lists for all channels are created. 

Maximum value, minimum value and average value are 

displayed.  

Chart list : Progress charts for all channels are created. 

Maximum value, minimum value and average value are 

displayed. 
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4-2 Name... 
Function Adds successive numbers to the character strings of name. 

 

Screen 

 

Description To set characters to be added to the character string of name. 

This is useful when changing the serial numbers or when 

setting names for 2-axial/3-axial strain gauges. 

 

Operation 

1. Select some cells in the Name column on the Input CH or 

the Expanded CH. 

2. Select Name... from the Measurement data menu. The 

dialog box for setting is displayed. 

3. After setting, click the "OK" button. 

 

Setting items 

 

Concatenation number 
Consecutive No 
 : Sequential number is added. 

Consecutive NoXY  
 : Sequential number is added for each two names. 

Consecutive NoXYZ 
 : Sequential number is added for each three names. 

 

If the start number is set as 
000, the concatenation 
numbers are set as 
000,001,002… 
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4-3 Paste function... 
Function  Pastes the function into a cell. When a cell has been selected, 

the selected function is overwritten to the cell. When you are 

editing a cell, selected function is inserted into the editing 

position. 

 

Screen 

 

Description When the function is input using Paste function…, the 

function can be input more correctly than it is input from 

keyboard. And the comment is displayed for necessary 

argument. 

 

Operation 

1. Select a cell in the Function column on the Expanded CH. 

2. When Paste function… is selected from Measurement 
data menu, the dialog box of function list is displayed. 

3. Select the function to be set and click the "OK" button. 

 

4-4 Unit 
Function Pastes the unit. 

 

Description It is also possible to input the unit from the keyboard. 

 

Operation 

1. Select a cell in the Unit column on the Input CH or the 
Expanded CH. 

2. Select the unit from the Unit submenu of the 

Measurement data menu. 

 

 
"Measurement data" 
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4-5 Format 
Function Selects display style and digit number of measurement data 

(numeric value, time). 

Screen 

 

Value  Exponent 

 

Description The format has an effect on the numerical display of data but 

internally keeps the accuracy. 

There are the following formats. 

0 to 0.0000000  : Value 

0e+00 to 0.0000000e+00 : Exponent 

 

Operation 

1. Select a cell in the Format column on the Input CH or the 
Expanded CH.  

2. Select the appropriate format from the Format submenu of 

the Measurement data menu and select the displayed 

submenu. 

 

4-6 Column width... 
Function Sets the width of the column including the selected cell in the 

unit of mm. 

 

Screen 

 

Description The widths of all the columns displayed on the measurement 

data file can be set. 

 

Operation 

1. Select a cell and select the Column width... from the 

Measurement data menu. The dialog box for setting is 

displayed. 

2. After setting, click the "OK" button. 

"Measurement data" 
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4-7 Chart column width... 
Function Sets the width of the columns where the chart is displayed on 

the chart list in the unit of mm. 

 

Screen 

 

Description On the chart list, columns cannot be selected. Therefore, by 

executing the Chart column width..., the width of the chart 

columns is changed. 

 

Operation 

1. Select the Chart column width... from the Chart list width 

sub menu of the Measurement data menu. The dialog box 

for setting is displayed. 

2. After setting, click the "OK" button. 

 

 

4-8 Legend column width... 
Function Sets the width of the column where the legends are displayed 

(at the right end) on the Chart list in the unit of mm. 

 

Screen 

 

Description On the Chart list, columns cannot be selected. Therefore, by 

executing the Legend column width..., the width of the 

legend column is changed. 

 

Operation 

1. Select the Legend column width... from the Chart list 
width sub menu of the Measurement data menu. 

2. After setting, click the "OK" button. 
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4-9 Row height... 
Function Sets the height of row in the unit of mm on the chart list. 
Screen 

 

Description On the Chart list, rows cannot be selected. Therefore, by 

executing the Row heigth..., the height of row is changed. 

Operation 

1. Select the Row height... from the Chart list width sub 

menu of Measurement data menu. 

2. After setting, click the "OK" button. 

 

4-10 Cursor information display 
Overview When the range is selected on the chart list, the ■ marks on 

the left end of the selected range are cursor 1 while the ■ 

marks on the right end of the selected range are cursor 2. The 

elapsed time and the measurement values at those positions are 

displayed. In addition, values subtracting cursor 1 values from 

cursor 2 values are also displayed. 

 

Screen 

 

Description The cursor information column is added on the chart list and 

the data values for the both ends of the selected range are 

displayed. 

The cursor 1 can be moved by ← → keys on the keyboard, 

and the cursor 2 can be moved by ↑ ↓ keys on the 

keyboard. 

Operation 

1. Display the Chart list and select the Cursor information 
display from the Measurement data menu. The cursor 

information column is added.  

2. Select the range with the mouse or the keys ← → ↑↓on 

the keyboard to change the value.  

3. To clear the cursor information, select the Cursor 
information display from the Measurement data menu 

again. 

"Measurement data" 
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4-11 Search 
Overview Searches the maximum and minimum values of each channel 

from the specified data range. And displays those positions and 

values. 

Also displays an average in the specified range in chart list. 

Screen 

 

Overview The Chart list or data list of a measurement data file is used for 

this search. 

In the Chart list, the maximum and minimum values are 

indicated by blue and red lines, respectively. 

The maximum, minimum and mean values within the range are 

indicated in the fourth column. 

In the data list, the maximum and minimum value are indicated 

by cell color; light blue and light red, respectively. 

Operation 

1. In the Chart list, set the search range. 

If you do not set any search range, all data will be the 

search range. 

In the Data list, select data from the desired channels in the 

row direction. 

The search is performed on the selected rows. 

If you select only one row, all data will be the search range. 

2. Select Search from the Maximum/minimum display 

submenu of the Measurement data menu. 

3. In the Chart list, the maximum and minimum values are 

indicated by blue and red lines, respectively. 

The third column of the Chart list displays cursor 

information; the fourth column displays information on the 

maximum and minimum values and average values. 

In the Data list, the maximum and minimum value are 

indicated by cell color; light blue and light red, respectively. 
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4-12 Clear 
Overview  Clears the maximum and minimum values displayed by search. 

 

Description  In the Chart list, the red and blue lines disappear and the 

columns reduced back to two. 

In the data list, the cell color returns to white. 

 

Operation  

1. Select Clear from the Maximum/minimum display 

submenu of the Measurement data menu. 

 

4-13 Indication of marker 
Overview Displays or hides the markers on the chart list. 

 

Description The marker is displayed when Indication of marker is checked. 

The marker is not displayed when Indication of marker is not 

checked. 

 

Operation 

1. Display the chart list and select the Indication of marker 
from the Marker submenu of the Measurement data 
menu 

 

4-14 Create marker on cursor 1, Create marker on cursor 2, 
Create marker on both cursors 

Overview Creates marker on the chart list. 

 

Description Marker is created at the position of cursor for the range 

selection on the chart list. 

 

Operation 

1. Execute the range selection on the chart list. 

2. When creating the marker at cursor 1 on the left side of the 

range selection, select the Create marker on cursor 1 

from the Marker submenu of the Measurement data 

menu. 

3. When creating the marker at cursor 2 on the right side of 

the range selection, select the Create marker on cursor 2 
from the Marker submenu of the Measurement data 

menu. 

4. When creating the markers at cursor 1 and 2 on both sides 

of the range selection, select the Create marker on both 
cursors from the Marker submenu of the Measurement 
data menu. 
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4-15 Select marker 
Overview Selects a marker to be deleted. 

 

Description When deleting the unnecessary marker, the marker must be 

selected individually before the deletion. 

 

Operation 

1. Display the chart list and select the Select marker from 

the Marker submenu of the Measurement data menu. 

2. Move the mouse cursor onto the chart list and click the 

marker. While the marker is selected, the cursor turns to 

┼. 

3. For stopping selecting the marker, select the Select marker 
once more from the menu. 

 

4-16 Delete marker 
Overview Deletes the marker. 

 

Description The marker selected by "Select marker" is deleted. 

 

Operation 

1. Display the chart list and select the Delete marker from 

the Marker submenu of the Measurement data menu. 

 

 

4-17 Time unit 
Overview Changes the unit of the elapsed time in the measurement data 

file and converts the data of time according to the new unit. 

 

Description This is used when the measurement time is reduced after data 

is deleted. 

After the unit of time is changed, the measurement time in the 

data list and the chart list and the progress chart referring to the 

measurement data file are displayed in the new unit. 

 

Operation 

1. Display the Chart list and select the unit of time from the 

Time unit submenu of the Measurement data menu. 

2. The measurement time in the data list and the chart list 
and the progress chart referring to the measurement 
data file are displayed in the new unit. 
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5 Chart menu 
Overview 

 Displaying the monitor chart 

 Displaying the data chart 

 Displaying the frequency chart 

 Displaying the history chart 

 Displaying the spectral chart 

 Adding the value monitor 

 Adding the character 

 Changing the construction data 

 Changing the line type and color of data 

 Changing the line type and color of grid 

 Changing the chart type, scale and axis font 

 Drawing the regression expression 

 Fitting the scale to displayed data 

 Changing the title and unit of axis label 

 Displaying the legend 

 Changing the character of legend 

 Fixing and releasing the drawing area 

 Changing the drawing step and drawing it again 

 Changing the referential file 

 Changing the character style of the parts on the selected chart 

 Adding frame for the parts on the selected chart 

 Displaying the setting of the parts on the selected chart 

 Resetting the size of the parts on the selected chart 

"Chart sheet" 
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5-1 Line monitor... 
Function The monitor data are set to the horizontal axis and the vertical 

axis and a chart is plotted with lines. 

 

Screen 

 

Description A line chart is plotted using lines and symbols during the 

monitor measurement. 

 

Operation 

1. Select the window of measurement project. 

2. When Line monitor… is selected from Chart menu, the 

dialog box for making a setting is displayed. 

3. Specify the data of X-axis and Y-axis by Plotting data tab, 

and create the plot line by "Create" button. 

4. Click the "OK" button. 

 

Setting items 

New line : Select this to create a new plot line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

 

Plotting data 

Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project for plotting the chart. 

X-axis list/Y-axis list 
 : Select data for plotting. 

"Measurement project" 
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5-2 Elapse monitor... 
Function The elapsed time of the monitor measurement is set to the 

horizontal axis, the monitor data is set to the vertical axis, and a 

chart is plotted with a line. 

Screen 

 

 

Description A line chart is plotted using lines and symbols during the 

monitor measurement. 

The method for plotting a chart displaying all data during the 

monitoring time or the method for plotting a chart with the 

plotting range of the X-axis (time axis) being fixed and 

automatically scroll when the plotting range is exceeded can be 

selected. 

 

Operation 

1. Select the window of measurement project. 

2. When Elapse monitor… is selected from Chart menu, the 

dialog box for making a setting is displayed. 

3. Specify the data of Y-axis by Plotting data tab, and create 

the construction line by "Create" button. 

4. Select the drawing method by Drawing method tab. 

5. Click the "OK" button. 

"Measurement project" 
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Setting items 

New line : Select this to create a new plot line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

 

Plotting data 

Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project for plotting the chart. 

X-axis list : Fixed to Elapsed time. 

Y-axis list : Select data for plotting. 

 

Drawing method 

Scroll the X-axis automatically 
 : When this is enabled, the construction area of X-axis is fixed 

and when the construction area is exceeded, X-axis is 

automatically scrolled, and the latest monitor value is always 

displayed. 

The line is connected with the horizon by the perpendicular line. 
 : The chart is drawn in step-wise pattern by linking the interval 

between data by horizontal and vertical lines. 

 

For the plotting range, refer to 
"Chapter 9: 5-20 Coordinate 
axis... " (Page 9-100). 
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5-3 Vertical bar monitor... 
Function Coordinates to the horizontal axis and the monitor data to the 

vertical axis are set and a distribution map is plotted with bars. 

 

Screen 

 

 

Description A distribution map is plotted indicating the monitor data with 

vertical bars during the monitor measurement. 

 

Operation 

1. Select the window of measurement project. 

2. When Vertical bar monitor… is selected from Chart menu, 

the dialog box for making a setting is displayed. 

3. Specify the data of X-axis and Y-axis by Plotting data tab. 

4. Click the "OK" button. 

 

"Measurement project" 
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Setting items 

New line : Select this to create a new plot line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

 

Plotting data 

Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project for plotting the chart. 

X-axis list : Select Op. Data for plotting. 

Y-axis list : Select data for plotting. 

 

Drawing method 

Construction order 
By Op.Data : The order of line connection is by Op.Data. 

By No. : The order of line connection is by NO of Expanded CH. 
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5-4 Horizontal bar monitor... 
Function Monitor data to the horizontal axis and coordinates to the 

vertical axis are set and a distribution map is plotted with bars. 

Screen 

 

 

Description A distribution map is plotted indicating the monitor data with 

horizontal bars during the monitor measurement. 

 

Operation 

1. Select the window of measurement project. 

2. When Horizontal bar monitor… is selected from Chart 
menu, the dialog box for making a setting is displayed. 

3. Specify the data of X-axis and Y-axis by Plotting data tab. 

4. Click the "OK" button. 

 

"Measurement project" 
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Setting items 

New line : Select this to create a new plot line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

 

Plotting data 

Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project for plotting the chart. 

X-axis list : Select data for plotting. 

Y-axis list : Select Op. Data for plotting. 

 
Drawing method 

Construction order 
By Op.Data : The order of line connection is by Op.Data. 

By No. : The order of line connection is by NO of Expanded CH. 
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5-5 X-distribution monitor... 
Function Coordinates to the horizontal axis and the monitor data to the 

vertical axis are set and a distribution map is plotted with lines. 

 

Screen 

 

 

Description A distribution map is plotted indicating the monitor data with 

lines during the monitor measurement. 

 

Operation 

1. Select the window of measurement project. 

2. When X-distribution monitor… is selected from Chart 
menu, the dialog box for making a setting is displayed. 

3. Specify the data of X-axis and Y-axis by Plotting data tab. 

4. Set the Construction order by Drawing method tab, and 

create the plot line by "Create" button. 

5. Click the "OK" button. 

"Measurement project" 
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Setting items 

New line : Select this to create a new plot line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

 

Plotting data 

Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project for plotting the chart. 

X-axis list : Select Op. Data for plotting. 

Y-axis list : Select data for plotting. 

 

Drawing method 

Construction order 
By Op.Data : The order of line connection is by Op.Data. 

By No. : The order of line connection is by NO of Expanded CH. 
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5-6 Y-distribution monitor... 
Function The monitor data to the horizontal axis and coordinates to the 

vertical axis are set and a distribution map is plotted with lines. 

 

Screen 

 

 

Description A distribution map is plotted indicating the monitor data with 

lines during the monitor measurement. 

 

Operation 

1. Select the window of measurement project. 

2. When Y-distribution monitor... is selected from Chart menu, 

the dialog box for making a setting is displayed. 

3. Specify the data of X-axis and Y-axis by Plotting data tab. 

4. Set the Construction order by Drawing method tab, and 

create the plot line by "Create" button. 

5. Click the "OK" button. 

"Measurement project" 
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Setting items 

New line : Select this to create a new plot line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

 

Plotting data 

Reference file name 
 : When multiple measurement projects are opened, select the 

measurement project for plotting the chart. 

X-axis list : Select data for plotting. 

Y-axis list : Select Op. Data for plotting. 

 

Drawing method 

Construction order 
By Op.Data : The order of line connection is by Op.Data. 

By No. : The order of line connection is by NO of Expanded CH. 
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5-7 Line... 
Function  Sets the measurement data for horizontal axis and vertical axis 

and draws the figure with lines. 

Screen 

 

 

Description The measurement data of measurement project or measurement 

data file is drawn by line chart that uses line and symbol. 

Operation 

1. Select the window of measurement project or measurement 

data file. 

2. When Line… is selected from Chart menu, the dialog box 

for making a setting is displayed. 

3. Specify the data of X-axis and Y-axis by Plotting data tab. 

4. Set the drawing range by Drawing method tab, and create 

the plot line by "Create" button. 

5. Click the "OK" button. 

 

"Measurement project" 
"Measurement data" 
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Setting item 

New line : Select this to create a new plot line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

 

Plotting data 

Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project or the measurement data file for plotting 

the chart. 

X-axis list/Y-axis list 
 : Select data for plotting. 

 
Drawing method 

Adjust the construction area automatically 
 : When this is enabled, all data are plotted. When this is disabled, 

the range of the data to be plotted should be specified. 

Construction area 
 : Specify the step of data to be drawn. 
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5-8 Scatter... 
Function  Sets the measurement data for horizontal axis and vertical axis 

and draws the figure with dots. 

 

Screen 

 

 

Description The measurement data of measurement project or measurement 

data file is drawn with dots. 

 

Operation 

1. Select the window of measurement project or measurement 

data file. 

2. When Scatter... is selected from Chart menu, the dialog 

box for making a setting is displayed. 

3. Specify the data of X-axis and Y-axis by Plotting data tab. 

4. Set the drawing range by Drawing method tab, and create 

the plot line by "Create" button. 

5. Click the "OK" button. 

 

"Measurement project" 
"Measurement data" 
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Setting items 

New line : Select this to create a new plot line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

 

Plotting data 

Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project or the measurement data file for plotting 

the chart. 

X-axis list/Y-axis list 
 : Select data for plotting. 

Drawing method 

Adjust the construction area automatically 
 : When this is enabled, all data are plotted. When this is disabled, 

the range of the data to be plotted should be specified. 

Construction area 
 : Specify the step of data to be drawn. 

 

 



Chapter 9 Overview of Menus 

 9-85 

5-9 Elapse diagram... 
Function Sets the measurement time for horizontal axis and the 

measurement data to vertical axis, and draws the figure with 

lines. 

Screen 

 

 

Description The measurement data of measurement project or measurement 

data file is drawn by line chart that uses line and symbol. 

Operation 

1. Select the window of measurement project or measurement 

data file. 

2. When Elapse diagram… is selected from Chart menu, the 

dialog box for making a setting is displayed. 

3. Specify the data of Y-axis by Plotting data tab. 

4. Set the drawing range by Drawing method tab, and create 

the plot line by "Create" button. 

5. Click the "OK" button. 

 

"Measurement project" 
"Measurement data" 
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Setting item 

New line : Select this to create a new plot line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

 

Plotting data 

Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project or the measurement data file for plotting 

the chart. 

X-axis list : Fixed to measurement time. 

Y-axis list  : Select data for plotting. 

 

Drawing method 
Adjust the construction area automatically 
 : When this is enabled, all data are plotted. When this is disabled, 

the range of the data to be plotted should be specified. 

Construction area 
 : Specify the step of data to be drawn. 

The line is connected with the horizon by the perpendicular line. 
 : The chart is drawn in step-wise pattern by linking the interval 

between data by horizontal and vertical lines. 
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5-10 History chart... 
Function  Sets the measurement date and time for horizontal axis and 

maximum value, minimum value and average value for vertical 

axis and draws the figure with line. 

Screen 

 

 

Description The maximum value, minimum value, average value and 

measurement time from history data of measurement project 

are drawn by line chart that uses line and symbol. 

Operation 

1. Select the window of measurement project. 

2. When History chart… is selected from the History chart 
submenu of the Chart menu, the dialog box for making a 

setting is displayed. 

3. Specify the data of Y-axis by Plotting data tab. 

4. Set the drawing range by Drawing method tab, and create 

the plot line by "Create" button. 

5. Click the "OK" button. 

 

"Measurement project" 
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Setting item 

New line : Select this to create a new plot line. 

1 line ～ : Select this to change current setting of the existing line. 

"Create" button 
 : A new plot line is added. 

"Delete" button 
 : A selected line is deleted. 

 

Plotting data 
Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project for plotting the chart. 

X-axis list  : Fixed to Date/Time. 

Y-axis list  : Select data for plotting. 

 
Drawing method 
Adjust the construction area automatically 
 : When this is enabled, all data are plotted. When this is disabled, 

the range of the data to be plotted should be specified. 

Construction area 
 : Specify the step of data to be drawn. 
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5-11 Frequency chart... 
Function With the selected frequency data and count, a bar chart is 

plotted. 

 

Screen 

 

Description The frequency data and the monitor during the frequency 

measurement are displayed. 

By starting the frequency measurement while the measurement 

project is referenced, the monitor is displayed. If the level 

crossing method (LEVEL) is set for the analysis method, the 

monitor is not displayed. 

 

Operation 

1. Select the window of measurement project or frequency 

data file. 

2. When Frequency chart… is selected from the Chart menu, 

the dialog box for making a setting is displayed. 

3. Specify the frequency data and plotting mode to draw the 

chart. 

4. Click the "OK" button. 

 

Setting items 

Reference file name 
 : Select a file which is referred to. 

If the Measurement project is referred to, a monitor chart is 

plotted during measurement. If the Frequency data file is 

referred to, a data chart is plotted. 

However if you use the level-crossing method as the analysis 

method, no monitor display is shown. 

Graphic mode 
 : Select count data to plot a chart for each analysis method. After 

selecting the frequency data to be drawn from the list, you can 

select a plotting mode. 

List : Select the frequency data to draw the chart. 

"Measurement project" 
"Measurement data" 

 

To perform the frequency 
analysis using this software, 
the instrument shall be 
equipped with the function of 
executing the frequency 
analysis (option). 
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5-12 Spectral chart... 
Function  The chart of power spectrum or amplitude spectrum is drawn. 

Screen 

 

Description Select arbitrary one channel from measurement project or 

measurement data file and implement FFT analysis and draw 

the chart of power spectrum or amplitude spectrum. 

Operation 

1. Select the window of measurement project or measurement 

data file. 

2. When Spectral chart… is selected from Chart menu, the 

dialog box for making a setting is displayed. 

3. Specify the data and select the processing method. 

4. Click the "OK" button. 

 

Setting items 

Reference file name 
 : When multiple measurement projects are opened, select the 

measurement project or measurement data file for plotting the 

chart. 

Name list  : Select data for plotting. 

Shift 

None  : The process of shift is not implemented. 

DC cut  : The DC component (direct current component) of measurement 

data is cut. 

Trend  : The trend (least squares method) of measurement data is 

removed. 

Window functions 
 : Window function is selected from Rectangular, Hamming and 

Hanning. 

Type  : Select one of Power spectrum and Amplitude spectrum. 

Data words : Adjust the number of data to the power of 2. 

Round down to the previous power of 2. 
Zero-padding to the next power of 2. 

"Measurement project" 
"Measurement data" 
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5-13 Blank form 
Function Numeric monitor, text and picture can be added and arranged 

freely. 

Screen 

 

Operation  

1. When Blank form is selected from Chart menu, the blank 

form is displayed. 

 

5-14 Add numeric value monitor... 
Function  Create the numeric monitor. 

Screen 

 

Description The numeric value monitor is the part to display monitor data 

on chart sheet and blank form. During the monitor 

measurement, the current value is displayed in real time, and 

when the condition of alarm value is fulfilled, the color in the 

frame changes. 

Operation 

1. Select the chart sheet or blank form. 

2. Click where the numeric value monitor is added. 

3. When Add numeric value monitor… is selected from 

Chart menu, the dialog box for making a setting is 

displayed. 

4. After the setting, click the "OK" button. 

"Chart sheet" 
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Setting items 

Reference file name 
 : When multiple Measurement projects are opened, select the 

Measurement project for creation. 

Width of view 
 : Input the number of characters of the monitor data. 

Determine alarm 
 : When the condition of alarm level that is set by Measurement 

project is fulfilled, the color of inside of frame changes to the 

selected background color. 

 

5-15 Add text... 
Function  Displays arbitrary character string. 

 

Screen 

 

Description Arbitrary character string is displayed on chart sheet and blank 

form, and it can be used as a comment. 

 

Operation 

1. Select the chart sheet or blank form. 

2. Click where the character string is added. 

3. When Add text… is selected from Chart menu, the dialog 

box for making a setting is displayed. 

4. After the setting, click the "OK" button. 

 

Setting item 

Rotate by 90 degree 
 : The character string is rotated by 90 degrees and displayed. 

 

"Chart sheet" 
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5-16 Construction data Setup... 
Function Changes the data or step to be drawn. 

Screen 

 

For charts other than spectral and frequency charts 

 

Spectral chart 

 

Frequency chart 

Description The data for charting or the plotting method is changed without 

changing the layout of the Chart sheet. 

Operation 

1. Select the Chart sheet. 

2. Select Set plotting data... from the Chart menu. The 

dialog box for setting is displayed. 

3. After setting, click the "OK" button. 

"Chart sheet" 
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[For charts other than spectral and frequency charts] 
Setting items 

New line : Select this when new plot line is created. 

1 line ～ : Select the existing line to change current setting. 

Reference file name 
 : When multiple measurement projects are opened, the 

measurement project or measurement data file for plotting is 

selected. 

 

[In the case of Line monitor, Line chart or Scatter chart] 
X-axis list/Y-axis list 
 : Select data for plotting. 

[In the case of Elapse monitor] 
X-axis list : Fixed to elapsed time. 

Y-axis list : Select data for plotting. 

[In the case of Elapse diagram] 
X-axis list : Fixed to measurement time. 

Y-axis list : Select data for plotting. 

[In the case of Vertical bar monitor or X-distribution monitor] 
X-axis list : Select Op. Data for plotting. 

Y-axis list : Select data for plotting. 

[In the case of Horizontal bar monitor or Y-distribution monitor] 
X-axis list : Select data for plotting.  

Y-axis list : Select Op. Data for plotting. 

[In the case of History chart] 
X-axis list : Fixed to measurement time. 

Y-axis list : Select data for plotting. 

 

Click the drawing method tab and set the drawing method. 

◼ In case of Line, Scatter, Elapse diagram or History 

 

Adjust the construction area automatically 
 : The drawing range is automatically adjusted. When specifying 

the drawing range, deselect this. 

Construction area 

 : Specify the step of data to be drawn. 
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◼ In the case of Vertical bar monitor, Horizontal bar monitor, 
X-distribution monitor or Y-distribution monitor 

 

Construnction order (By OP.Data/By No.) 

 : The order of line that connects data is set. 

 

◼ In the case of Elaplse monitor 

 

Scroll the X-axis automatically 
 : When this is enabled, the construction area of X-axis is fixed 

and when the construction area is exceeded, X-axis is 

automatically scrolled, and the latest monitor value is always 

displayed. 

The line is connected with the horizon by the perpendicular line. 
 : The chart is drawn in step-wise pattern by linking the interval 

between data by horizontal and vertical lines. 

 

[Frequency chart] 
Setting item 

Reference file name 
 : When multiple measurement projects or frequency data files are 

opened, select the name of file to draw the chart. 

Graphic mode 
 : Select count data to be drawn for each analysis method. 

After selecting the frequency data to be drawn from the list, you 

can select a plotting mode. 

List : Select the frequency NO to draw the chart. 
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[Spectral chart] 
Setting item 

Reference file name 
 : When multiple measurement projects are opened, select the 

measurement project or name of measurement data file to be 

drawn. 

Name list  : Data to be drawn is selected. 

Shift 

None  : The process of shift is not implemented. 

DC cut : The DC component (direct current component) of measurement 

data is cut. 

Trend  : The trend (least squares method) of measurement data is 

removed. 

Window functions 
 : Window function is selected from Rectangular, Hamming and 

Hanning. 

Type  : Select one of Power spectrum and Amplitude spectrum. 
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5-17 Construction line Setup... 
Function Changes the kinds of lines or colors to be used in charting the 

data. 

Screen 

 

Line monitor, Elapse monitor, Line chart, Elapse diagram, 

Scatter chart, History chart, Spectral chart 

 

Vertical bar monitor, Horizontal bar monitor, 

X-distribution monitor, Y-distribution monitor 

Description After setting, the chart is updated and displayed. 

 

Operation 

1. Select the Chart list of chart sheet, measurement project or 

measurement data file. 

2. When Set plot line... is selected from Chart menu, the 

dialog box for making a setting is displayed. 

3. After the setting, click the "OK" button. 

 

Setting items 

Line : Display the number (1 line, 2 line...) of drawing line to be set. 

Select the line to be changed. 

Line style : Specify the type of line. 

Specify the thickness of line from none, 1 point, 2 points and 

3 points. 

Specify the color of line. 

Mark : Specify the type and color of marker that is attached to each 

point of data. This is not used for bar chart. 

Size : Specify the size of symbol or bar within the range of 2 to 10 

(dots from center). 

Interval of scale 
 : The symbol is displayed in the specified step. 

Fill pattern : Specify the painting pattern and color of bar chart. 

"Measurement project 
(Chart list)" 

"Measurement data 
(Chart list)" 

"Chart sheet" 

For the automatic scrolling of 
the elapse monitor, refer to 
"Chapter 6: 1-2 Drawing the 
Elapse monitor chart" (Page 
6-3). 
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5-18 Grid setting... 
Function Changes the kinds and colors of grid. 

 

Screen 

 

Description After setting, the chart is updated and displayed. 

 

Operation 

1. Select the Chart sheet, or chart list of Measurement project 

or Measurement data file. 

2. When Grid Setup… is selected from Chart menu, the 

dialog box for making a setting is displayed. 

3. After the setting, click the "OK" button. 

 

Setting items 

Frame : Specify the color and thickness of line of frame. 

Grid 
Main scale : Specify the color and thickness of each main scale of X-axis 

and Y-axis. 

Sub scale : Specify the color and thickness of each supplementary scale of 

X-axis and Y-axiss. 

Tick mark 
Line : Specify the color and thickness of each scale of X-axis and 

Y-axis. 

Position : Specify the display position of each scale of X-axis and Y-axis. 

 

The line thickness is selected from None, 1 point, 2 points and 3 points. 

"Measurement project 
(Chart list)" 

"Measurement data 
(Chart list)" 

"Chart sheet" 
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5-19 Regression expression... 
Function Draws regression line concerning line chart, scatter chart or 

elapse diagram. 

 

Screen 

 

Description After setting, the regression line and its mathematical 

expression is displayed for all data. 

 

Operation 

1. Select the Chart sheet. 

2. When Regression expression… is selected from Chart 
menu, the dialog box for making a setting is displayed. 

3. After the setting, click the "OK" button. 

 

Setting items 

Regression line/Regression curve 
 : Select regression line or regression curve. For regression curve, 

set the order of polynomial. Set it within the range of 2 to 9. 

Construction to the limit of axis 
 : The regression line is drawn up to the limit of axis. 

Show mathematical expression 
 : The mathematical expression of regression line is displayed on 

chart sheet. 

Left side/Right side 
 : Specify the left-hand member and right-hand member of 

formula. 

Show r^2 in place of r 
 : The linear correlation coefficient r and deviation coefficient r^2 

can be switched. 

Division of regress line 
 : Specify the division number within X-axis range where the 

regression line is drawn. 

Regression expression 
 : The mathematical expression of regression line is displayed. 

Point  : Specify the line thickness. 

1 point / 2 points / 3 points 

Color  : Specify the color of line. 

"Delete" button 
 : The drawn regression line is deleted. 

 

When the number of 
measurement data is large, it 
takes time to start the drawing. 
It is recommended not to 
implement it during the 
measurement. 
 

 
"Chart sheet" 
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5-20 Coordinate axis... 
Function Scales, grid intervals, automatic scaling, chart type and so on 

are set for the chart. 

 

Description By checking the Automatic scaling, the scale is automatically 

renewed when the scale is exceeded. 

 

Operation 

1. Select the chart list of the Chart sheet, the measurement 

project or the measurement data file. 

2. Select Coordinate axis... from the Chart menu. The dialog 

box for setting is displayed. 

3. After setting, click the "OK" button. 

 

[Line monitor, Elapse monitor, Line chart, Elapse diagram, Scatter chart, 
Frequency chart, Spectral chart] 
Screen 

 

 

In the case when the automatic scrolling is enabled  

on the elapse monitor 

"Measurement project 
(Chart list)" 

"Measurement data 
(Chart list)" 

"Chart sheet" 
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Setting items 

Chart type 

X-Y : The X-Y correlation chart is plotted. 

Log-Log : The XY chart of double logarithmic scale is plotted. * 

LogX-Y : Semi-logarithmic chart is plotted with logarithmic scale on 

X-axis. * 

X-LogY : Semi-logarithmic chart is plotted with logarithmic scale on 

Y-axis. 

Automatic scaling 
 : If the measured value exceeds the chart scale which is 

previously set, the chart scale is automatically renewed 

according to the measured value. * 

Left end value/Right end value 
 : The scale of X-axis is set when the automatic scaling is not 

selected. * 

Lower end value/Upper end value 
 : The scale of Y-axis is set when the automatic scaling is not 

selected. * 

Scale resolution 
 : The main scale intervals are set when the automatic scaling is 

not selected. 

Sub scale : The number of division of the sub-scales is set when the 

automatic scaling is not selected. 

Scale intervals or sub-scale intervals in a logarithmic chart is 

automatically set. 

 

◼ When the automatic scrolling is enabled on the elapse monitor. 
X-Y : The X-Y correlation chart is plotted. 

X-LogY : Semi-logarithmic chart is plotted with logarithmic scale on 

Y-axis. 

Construction area 
 : The display range of the X-axis is set. If the elapsed time of 

monitoring exceeds the display range, the monitor display time 

is automatically adjusted. 

Lower end value/Upper end value 
 : The scale of Y-axis is set when the automatic scaling is not 

selected. 

Scale resolution 
 : The main scale intervals are set when the automatic scaling is 

not selected. 

Sub scale : The number of division of the sub-scales is set when the 

automatic scaling is not selected. 

Scale intervals or sub-scale intervals in a logarithmic chart is 

automatically set. 

 
Show scale 
None : Scales are not displayed. 

Fixed  : Scales are displayed in fixed-point arithmetic. 

Float  : Scales are displayed in floating-point arithmetic. 

"X-axis font" button 
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 : The font for the X-axis scale is set. 

"Y-axis font" button 
 : The font for the Y-axis scale is set. 

 

[Vertical bar monitor, Horizontal bar monitor, X-distribution monitor, 
Y-distribution monitor] 
 
Screen 

 

Setting items 

Chart type 
Distribution chart 
 : By selecting Op.Data, a vertical bar chart and a distribution map 

are plotted. 

Automatic scaling 
 : If the measured value exceeds the chart scale which is 

previously set, the chart scale is automatically renewed 

according to the measured value. 

Left end value/Right end value 
 : The scale of X-axis is set when the automatic scaling is not 

selected. 

Lower end value/Upper end value 
 : The scale of Y-axis is set when the automatic scaling is not 

selected. 

Scale resolution 
 : The main scale intervals are set when the automatic scaling is 

not selected. 

Sub scale : The number of division of the sub-scales is set when the 

automatic scaling is not selected. 

Show scale 
None : Scales are not displayed. 

Fixed : Scales are displayed in fixed-point arithmetic. 

Float : Scales are displayed in floating-point arithmetic. 

"X-axis font" button 
 : The font for the X-axis scale is set. 

"Y-axis font" button 
 : The font for the Y-axis scale is set. 



Chapter 9 Overview of Menus 

 9-103 

[History chart] 
Screen 

 

Setting item 
Graph type 
X-Y : The X-Y correlation chart is plotted. 

Log-Log : The XY chart of double logarithmic scale is plotted. 

LogX-Y : Semi-logarithmic chart is plotted with logarithmic scale on 

X-axis. 

X-LogY : Semi-logarithmic chart is plotted with logarithmic scale on 

Y-axis. 

Automatic scaling 
 : If the measured value exceeds the chart scale which is 

previously set, the chart scale is automatically renewed 

according to the measured value. 

Left end value/Right end value 
 : The scale of X-axis is set when the automatic scaling is not 

selected. 

Lower end value/Upper end value 
 : The scale of Y-axis is set when the automatic scaling is not 

selected. 

Scale resolution 
 : The main scale intervals are set when the automatic scaling is 

not selected. 

Sub scale : The number of division of the sub-scales is set when the 

automatic scaling is not selected. 

Scale intervals or sub-scale intervals in a logarithmic chart is 

automatically set. 

 
Show scale 
None : Scale is not displayed. 

FIX : Displayed by value. 

FLOT : Displayed by index. 

y/m/d H:M:S 
 : Time year/month/day hour:minute:second 

y/m/d : Time year/month/day 

H:M:S : Time hour:minute:second 

m/d : Time month/day 

m/d H : Time month/day hour 
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H:M : Time hour:minute 

m/d/y H:M:S 
 : Time month/day/year hour:minute:second 

m/d/y : Time month/day/year 

Progress (unit) 
 : Select the unit of time scale. 

(sec)/(imin)/(hr)/(day) 

 

When setting the progress (unit), select the unit corresponding to the data of 

lapsed time. 

 
Reference date and time 
 : Set the time treated as initial time (time 0). 

When the process diagram format is drawn before starting the 

measurement, the referential point is not clear, so the referential 

time is displayed as "1899/12/30 0:0:0". When the measurement 

is performed once, the first step is treated as referential time. 

"X-axis font" button 
 : The font of X-axis scale is set. 

"Y-axis font" button 
 : The font of Y-axis scale is set. 

"Optimal base time" button 
 : The referential time of X-axis is automatically set and figure is 

drawn again. 
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[Chart list] 
Screen 

 

Click the X-axis tab to change the coordinate axis of the X-axis and the Y-axis 

tab to change the coordinate axis of the Y-axis. 

Scales and scale intervals can be set by channel. 

 

Setting items 

Auto Scale : ON/OFF of automatic scaling is set. 

Left end value 
 : The minimum value of X-axis is set when the automatic scaling 

is not set. 

Right end value 
 : The maximum value of X-axis is set when the automatic scaling 

is not set. 

Lower end value 
 : The minimum value of Y-axis is set when the automatic scaling 

is not set. 

Upper end value 
 : The maximum value of Y-axis is set when the automatic scaling 

is not set. 

Scale resolution 
 : The main scale intervals are set when the automatic scaling is 

not selected. 

Scale/number 
 : The number of divisions of the scale is set when the automatic 

scaling is not selected. 

 
Show scale 
None : Scale is not displayed. 

Fixed : Scales are displayed in fixed-point arithmetic. 

Float : Scales are displayed in floating-point arithmetic. 

"Font..." button 
 : Specify the font of displayed axis. 
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5-21 Reset of coordinate axis 
Function Adjusts the coordinate axis to the data being displayed. 

 

Description In the automatic scaling, if the display data exceeds the scale, 

the scale is renewed. However, if another measurement data is 

displayed and the data value is smaller than the original scale, 

the scale is not renewed. 

By executing the Reset of coordinate axis, the coordinate axis 

is renewed to the display data and the chart is re-plotted. 

 

5-22 Label Setup... 
Function Changes the title and unit of the coordinate axis label. 

 

Screen 

 

Chart sheet 

 

Chart list 

Description In the Unit, by right-clicking the mouse, the 

Superscript/Standard menu is displayed. 

On the Chart list, the font of legends can be set. 

 

Operation 

1. Select the Chart sheet, or the Chart list of measurement 

project or measurement data file. 

2. Select Label Setup... from the Chart menu. The dialog 

box for setting is displayed. 

3. After setting, click the "OK" button. 

"Measurement project 
(Chart list)" 

"Measurement data 
(Chart list)" 

"Chart sheet" 

"Chart sheet" 
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Setting items 

X-axis 

 Auto label : Set the X-axis label and unit automatically. 

 Label : Set the X-axis label. 

 Unit : Set the unit of X-axis label. 

Y-axis 

 Auto label : Set the Y-axis label and unit automatically. 

 Label : Set the Y-axis label. 

 Unit : Set the unit of Y-axis label. 

"X-axis font" button 
 : Set the font of X-axis label and unit. 

"Y-axis font" button 
 : Set the font of Y-axis label and unit. 

For Chart list 

"Legend font" button 
 : Set the font of legend column. 

 

 

5-23 Add legend 
Function Displays legend on a chart. 

 

Description This can be selected after the legend is erased from the Chart 

sheet. 

 

 

"Chart sheet" 
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5-24 Legend Setup... 
Function Sets the legend names. 

 

Screen 

 

Description Legend names are changed by each plotting line. 

 

Operation 

1. Select the Chart sheet. 

2. Select Legend Setup... from the Chart menu. The dialog 

box for setting is displayed. 

3. Click the Automatic setting to remove the checkmark.  

4. Click the legend name to be changed.  

5. Type the legend name. 

6. After setting, click the "OK" button. 

 

Setting items 

Automatic setting 
 : Set the legend name from the name of displayed data. 

"Initial state" button 
 : The selected legend name is reset to initial state. 

Rotate by 90 degrees 
 : Whole legend is rotated in 90 degrees counterclockwise and 

displayed. 

 

"Chart sheet" 
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5-25 Construction area lock 
Function The window size of the selected Chart sheet is locked for the 

plotting area. 

 

Screen 

 

After locking the plotting area, the chart size is not changed  
even if the window size is changed. 

 

If the window size is changed without locking the plotting area,  
the layout of the charts are changed. 

Description The size of chart is normally synchronized with the window 

size. If the window size is changed, the size of the chart is 

changed. This method is effective when multiple charts are 

displayed on the whole area of screen in monitor measurement. 

If the Construction area lock is executed for the print layout, 

the plotting area is fixed to the window size at the time of 

execution. Therefore, even if the window size is changed, the 

positions of parts are not displaced. 

If the area-locked Chart sheet is selected, the Construction area 

lock is checkmarked in the menu. By clicking the Construction 

area lock, the window size is returned to the plotting area size 

and the chart is displayed in synchronization with the window 

size. 

 

The construction-area-locked Chart sheet is printed in the same size as the 

window size. If the window size is larger than the paper size, the print size 

varies according to the settings for the print option. 

"Chart sheet" 
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5-26 Update construction area... 
Function Re-plots the chart sheet by specifying the construction area. 

Screen 

 

Operation 

1. Select the chart sheet to be updated. 

2. When Update construction area… is selected from Chart 
menu, the dialog box for making a setting is displayed. 

3. After the setting, click the "OK" button. 

 

Setting item 

Reference file name 
 : ‘When multiple data are displayed on selected chart sheet using 

multiple measurement projects or measurement data files, select 

measurement project or measurement data file to be updated. 

Type  : Select the type from Data chart and History chart. 
The chart of selected type is updated. 

Construction area 
 : Specify the step of data to be updated. 

"OK" button 
 : The data is updated to that of specified construction area for the 

chart sheet for which chart name is displayed. 

"Change All" button 
 : All chart sheets opened from the referenced file are updated. 

 

"Chart sheet" 
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5-27 Change reference file... 
Function Changes the measurement project or measurement data file 

which is referred to by the Chart sheet. 

 

Screen 

 

Description This is used when a test is conducted with the same content as 

that of the previous test. The chart sheet used for the previous 

test can be used for the next test by changing the reference file. 

 

Operation 

1. Select the chart sheet to change the reference file. 

2. Open the measurement project or measurement data to be 

referred to. 

3. Select Change reference file... from the Chart menu. The 

dialog box for setting is displayed. 

4. After setting, click the "Change" button. 

 

Setting items 

Reference file name 
 : If multiple measurement projects or measurement data files are 

used for the selected chart sheet, select the measurement project 

or measurement data file to be changed. 

Update file name 
 : Select the file for updated reference file from the opened 

measurement projects or measurement data files. 

Change the legened name to the changed file name 
 : The legend name is displayed according to the name set in the 

selected chart sheet. 

"Change" button 
 : The reference file is changed for the chart sheet which is 

displayed in the Chart name. 

"Change All" button 
 : The reference file is changed for every opened chart sheet. 

 

"Chart sheet" 
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5-28 Font... 
Function Sets font, size, style and color to the selected parts such as titles 

and legends in the Chart sheet. 

 

Screen 

 

Operation 

1. Click a part such as title or legend to be selected. 

2. Select Font... from the Chart menu. The dialog box for 

setting is displayed. 

3. After setting, click the "OK" button. 

 

Setting items 

Font : Select the font from the list. 

Font style : Select the style of character from the list. 

Size : Select the size of character from the list. 

Strikeout : A line is drawn at the center in vertical direction of the character 

string. 

Underline : A line is drawn below the character string. 

Color : Select the color of character. 

 

"Chart sheet" 
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5-29 Line and color... 
Function Sets the frame line of selected parts such as chart, title and 

legends in the Chart sheet. 

 

Screen 

 

 

Operation 

1. Click a part to be selected with a mouse. 

2. Select Line and color... from the Chart menu. The dialog 

box for setting is displayed. 

3. After setting, click the "OK" button. 

 

Setting items 

Left : A line is drawn on the left side of the part. 

Right : A line is drawn on the right side of the part. 

Top : A line is drawn on the upper side of the part. 

Bottom : A line is drawn on the lower side of the part. 

Thickness : Specify the thickness of frame line. 

Color : Select the color of frame line within the range of 1 to 10. 

Transparent 
 : The background color is disabled so that you can see the back of 

the part. 

Selectable for chart only. 

Background color 
 : Specify the color of the inside of the part. 

Shadow : Shade is added to the frame of the part. 

 

"Chart sheet" 
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5-30 Property...  Alt+Enter 
Function Displays the settings of parts. 

 

Description The dialog box for changing the setting of the selected part is 

displayed. The displayed dialog boxes are different in each part. 

This operation is equivalent to double-clicking the part. 

 

Chart : The same dialog box as that displayed when the Construction 
data Setup... is selected is displayed. 

Legend : The same dialog box as that displayed when the Legend 
Setup... is selected is displayed. 

 

Operation 

1. Click a part to be selected with a mouse. 

2. Select Property... from the Chart menu. The dialog box 

for setting is displayed. 

 

 

5-31 Reset size 
Function Resets the size of chart or parts except legend to the default. 

 

Description The size of part can be changed by dragging the mark 

displayed when the part is clicked. By selecting Reset size, 

the size can be returned to the default. 

 

Operation 

1. Click a part to be selected with a mouse. 

2. Select Reset size from the Chart menu. 

 

 

 

 

 

"Chart sheet" 

"Chart sheet" 
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6 Measurement menu 
Overview 

 Displaying the measurement panel 

 Displaying the measurement project 

 Balancing 

 Controlling the voltage output 

 Setting the monitor 

 Setting the data recording 

 Performing the monitor measurement 

 Resetting the peak values of monitor measurement 

 Performing the manual measurement 

 Performing the data trigger measurement 

 Performing the program measurement 

 Performing the interval measurement 

 Performing the data comparator measurement 

 Displaying an alarm 

 Setting and controlling the alarm 

 Automatically saving the data 

 Deleting data from the memory card in the instrument automatically 

 Reading data from the memory card in the instrument 

 Deleting data from the memory card in the instrument 

 Upgrading instrument firmware 
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6-1 Show measurement panel... 
Function Displays the measurement panel for performing measurement 

and monitoring data 

 

Screen 

 

Description The setting data for the instrument and the measurement 

project are made in agreement with each other so that the 

measurement can be conducted. 

 

Operation 

1. Select the measurement project to be used in the 

measurement. 

2. Select Show measurement panel... from the Measurement 

menu. The dialog box for selection is displayed. 

3. After selection, click the "OK" button. 

 

Selection items 

Transmit the setup information to measuring instruments. 
 : The setting contents of measurement project are sent to and 

reflected on the instrument. 

Receive the channel information in SET from the instrument. 
 : The setting contents of the instrument including channel 

condition and A/D setting are imported to the measurement 

project. 

 

6-2 Show measurement project 
Function Activates the measurement project whose measurement panel 

is displayed. 

 

Operation 

1. Display the measurement panel 

2. Select Show Measurement project menu from the 

Measurement menu, and the corresponding measurement 

project is activated. 

For the display of the 
measurement panel, refer to "1 
How to display the 
Measurement Panel" in 
Chapter 5 (Page 5-1). 
 

"Measurement project" 
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6-3 Balance... 
Function Before starting the measurement, zero adjustment of the sensor 

is executed. 

Screen 

 

Description Select the channel to be initialized. 

If you execute zero balancing for channels in 

Voltage/Thermocouple unit (TMR-231), Voltage Input unit 

(TMR-331) or Thermocouple/Voltage unit (TMR-332), current 

value is recorded in the Shift cell of each input channel of the 

referring Measurement project. 

 

Operation 

1. Select Balance... from the Measurement menu. The dialog 

box for setting is displayed. 

2. After checking the setting, click the "Execute" button. 

 

Setting items 

If the channel of strain exceeds the range of balance, current value is 
recorded in the shift to set channel condition. 
 : For the channel of strain that exceeds the balancing range of the 

instrument, the value does not become 0. When this item is 

enabled, the current value is recorded in the shift cell of the 

input CH of the measurement project that is referenced, zero 

adjustment is performed by calculation. 

Left list : List of channels available for balancing is displayed. 

The channel set invalid in the CH setting is not indicated. 

Right list : List of channels which are to be balanced is displayed. 

"Register>>" button 
 : Channels selected in the left list are registered in the right list. 

"Register All" button 
 : All channels in the left list are registered in the right list. 

"Release" button 
 : Channels selected in the right list are deleted from the list. 

"Release All" button 
 : All channels registered in the right list are deleted. 
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6-4 Calibration output... 
Function Outputs calibration value from the voltage output terminal of 

the instrument. 

 

Screen 

 

Description Calibration values set in the Output CH on the measurement 

project are output from the analog terminal of the instrument. 

 

Operation 

1. Select Calibration output... from the Measurement menu. 

The dialog box for Output calibration is displayed. 

2. Click the button to output the calibration value. 

 

Setting items 

"plus calibration" button 
 : The positive calibration is output. 

"zero calibration" button 
 : The 0 mV calibration is output. 

"minus calibration" button 
 : The negative calibration is output. 

"Close" button 
 : The dialog box of "Output calibration" is closed. 

 

The output button is displayed in red during output. 

 

The dialog box cannot be closed while the calibration value is being output. To 

close the dialog box, click the button displayed in red. 

For the setting of calibration 
values, refer to "7-4 How to set 
the calibration value" in 
Chapter 4 (Page 4-21). 
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6-5 Monitor setting... 
Function Sets the setting of monitor measurement. 

 

Screen 

 

Description The monitor data to be displayed on the measurement panel are 

selected and the display method is set. 

 

Operation 

1. Select Monitor setting... of the Measurement menu or click 

the "Set monitor" button on the measurement panel. The 

dialog box for setting is displayed. 

2. After setting, click the "OK" button. 

 

Setting items 

◼ Setting the monitor data of measurement panel 
Left list : List of channels available for monitor measurement is 

displayed. 

Right list : List of channels for which monitor measurement is performed is 

displayed. 

"Register>>" button 
 : Channels selected in the left list are registered in the right list. 

"Insert>>" button 
 : Select where to insert the channel, and insert the channel 

selected in the left list between the channels registered in the 

right list. 

"Release" button 
 : Channels selected in the right list are deleted from the list. 

"Release All" button 
 : All channels registered in the right list are deleted. 
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◼ Setting the moniter display position 
In the measurement panel 
 : The monitor value is displayed in the measurement panel. 

No display : The monitor value is not displayed. The size of the 

measurement panel gets smaller. 

Monitor panel display 
 : Monitor values are displayed in a monitor panel other than the 

measurement panel. 

 

◼ Setting the color of monitor display 
Color of character 
 : Specify the color of character of monitor display. 

Color of background 
 : Specify the color of background of monitor display. 

Size of character 
 : Specify the character size when the monitor values are 

displayed in the monitor panel. 

 

◼ Setting the peak data 
Display : The maximum and minimum peak data are displayed. 

Automatic reset 
 : The peak data is reset at specified time intervals. 

Reset at the start of measurement 
 : The peak data is reset when the measurement is started. 
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6-6 Setting recording data... 
Function Selects data to be recorded into the memory card during 

measurement. 

Screen 

 

Description The data to be recorded in the memory card during 

measurement are selected from waveform + frequency data, 

waveform data and frequency data. 

Only waveform data can be recorded if there is no Input CH 

setting for the Frequency NO on the measurement project or if 

the frequency analysis cannot be conducted due to the 

restriction of the sample clock. 

 

Operation 

1. Select Setting recording data... from the Measurement 
menu. The dialog box for setting is displayed. 

2. After setting, click the "OK" button. 

 

Selection items 

Waveform + Frequency data 
 : Waveform and frequency data are concurrently recorded. 

Waveform data only 
 : Only waveform data are recorded. 

Frequency data only 
 : Only frequency data are recorded. 

 

To perform the frequency 
analysis using this software, 
the instrument shall be 
equipped with the function of 
executing the frequency 
analysis (option). 
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6-7 Monitoring 
Function Starts monitor measurement. 

 

Operation 

1. Select Monitoring in the Measurement menu or click the 

"Monitor" button on the measurement panel. 

 

6-8 Peak reset 
Function Resets the maximum peak and minimum peak of the monitor 

data with the current values. 

 

Operation 

1. Select Peak reset in the Measurement menu or click the 

"P.R" button on the measurement panel. 

 

6-9 Start measurement  F1 
Function A single measurement is conducted at any given time and the 

measurement data is saved. 

 

Screen 

 

Description A single measurement is conducted at any given time. 

The "Start measurement" button on the measurement panel is 

changed to the "Stop measurement" button. By clicking it 

during measurement, the measurement stops. 

 

Operation 

1. Display the measurement panel 

2. Select Start measurement in the Measurement menu or 

click the "Start measurement" button on the measurement 

panel. 
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6-10 Free run... 
Function The free run measurement function of the instrument is used to 

conduct the measurement. 

 

Screen 

 

Description Measurement is conducted repeatedly. 

Measurement is conducted repeatedly until the "Stop 
measurement" button is pressed or no space is left in the 

memory card. 

On the high-speed mode, the free run measurement cannot be 

executed. 

 

Operation 

1. Display the measurement panel. 

2. Select the Free run... from the Auto measurement 
submenu of the Measurement menu. The dialog box for 

selecting the start method is displayed. 

3. Click the "Start" button or "Waiting" button. 

 

Setting items 

 By clicking the "Start" button, the free run measurement is 

started. 

By clicking the "Waiting" button, the free run mode is set in 

the instrument but the measurement doesn’t start. Click the 

"Start measurement" button on the measurement panel to 

start the measurement. 

For the free run measurement, 
refer to "Chapter 5: 7 Free run 
measurement" (Page 5-10). 
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6-11 Data trigger... 
Function The data trigger function of the instrument is used to conduct 

the measurement. 

 

Screen 

 

Description The instrument judges the input signal according to the trigger 

level and mode for the channel set in the Data trigger 

measurement of the measurement project, and the automatic 

measurement is conducted. 

The recording method of the data trigger measurement is set 

before starting the measurement. 

 

Operation 

1. Display the measurement panel 

2. Select the Data trigger... from the Auto measurement 
submenu of the Measurement menu. The dialog box for 

setting is displayed. 

3. Click the "1 time" or "Continue" button. 

 

Setting items 

 By clicking the "Continue" button, another data trigger 

measurement is executed continuously after the completion of 

the data trigger measurement. 

 

6-12 Program 
Function The program measurement function of the instrument is used to 

conduct the measurement. 

 

Description Automatic measurement is conducted according to the 

Date/Time of start and the Measurement time set in the 

Program measurement of the measurement project. 

The recording method of the program measurement is set 

before starting the measurement. 

 

Operation 

1. Display the measurement panel 

2. Select the Program from the Auto measurement 
submenu of the Measurement menu. 

3. Program measurement is started. 

For the data trigger 
measurement, refer to 
"Chapter 5: 8 Data trigger 
measurement" (Page 5-11). 
 

For the program 
measurement, refer to 
"Chapter 5: 9 Program 
measurement" (Page 5-15). 
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6-13 Interval 
Function  Starts the interval measurement. 

 

Description The interval measurement is started according to the setting of 

interval measurement of measurement project. 

 

Operation 

1. Open the measurement panel. 

2. Select Interval from Auto measurement submenu of 

Measurement menu. 

 

6-14 Data comparator... 
Function  Starts the data comparator measurement. 

Screen 

 

Description  The data comparator measurement is started according to the 

setting of data comparator measurement of measurement 

project. 

 

Operation 

1. Open the measurement panel. 

2. When Data comparator... is selected from Auto 
measurement submenu of Measurement menu, the 

confirmation dialog box is displayed. 

3. After the setting, click the "Start" button. 

 

Setting item 

Reference value for data comparator 
Set current value as reference value 
 : The data comparator measurement is performed setting the 

value of monitor data when "Start" button is clicked as the 

reference value. 

Set 0 for reference value 
 : The data comparator measurement is performed setting 0 as the 

reference value. 

 

For the interval measurement, 
refer to "Chapter 5: 10 Interval 
measurement" (Page 5-18). 
 

For the data comparator 
measurement, refer to 
"Chapter 5: 11 Data 
comparator measurement" 
(Page 5-21). 
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6-15 Alarm setting... 
Function Sets the method for resetting the alarm output and the alarm 

sound that is played when the alarm is generated. 

 

Screen 

 

Description  The operation when the alarm is generated is defined using 

alarm function. 

 

Operation 

1. Open the measurement panel. 

2. When Alarm setting... is selected from Alarm submenu of 

Measurement menu, the dialog box for making a setting is 

displayed. 

3. After the setting, click the "OK" button. 

 

Setting item 

Reset the alarm output level to fit the data 
 : After the alarm is generated, when the monitor data becomes the 

value out of alarm judgment, the alarm is released. 

If this is disabled, the alarm is kept displayed until the Release 

output button on the Alarm panel is pressed. 

Turn on the alarm 
 : It enables to play alarm from computer. 

 Button : Sound is played by the current setting. 

Specify the sound 
 : The specified sound file is set to the alarm sound. 

"Browse..." button 
 : Click this button when selecting the sound file to be used. 

 

For the alarm function, refer to 
"Chapter 5: 13 Alarm function" 
(Page 5-25). 
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6-16 Show alarm 
Function  Displays the alarm panel. 

 

Screen 

 

Description  The data in which an alarm is generated is displayed using 

alarm function. 

 

Operation 

1. Open the measurement panel. 

2. When Show alarm is selected from Alarm submenu of 

Measurement menu, the alarm panel is displayed. 

 

Setting item 

"Show alarm conditions" button 
 : The alarm condition of the Name that is selected with black 

background is displayed. 

"Release output" button 
 : All alarm outputs are released. 

Even if the alarm outputs are released, an alarm is output again 

during the monitor measurement if the alarm condition is met. 

 

For the alarm function, refer to 
"Chapter 5: 13 Alarm function" 
(Page 5-25). 
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6-17 Automatically save data... 
Function Disables the automatic saving of measurement data. 

 

Screen 

 

Description When it is not necessary to record the measurement data, it is 

possible to disable the function to save the measurement data 

automatically. 

 

Operation 

1. When Automatically save data... is selected from the 

Measurement menu, the dialog box for making a setting is 

displayed. 

2. After the setting, click the "OK" button. 

 

Setting item 

Disable automatic saving 
 : If this is enabled (checked), the data are not saved into a 

computer even though the measurement is performed. 

Record data in measurement history (Waveform data) 
 : When the automatic saving is not implemented, the maximum, 

minimum and average values are recorded in measurement 

history. 

 

When only "Disable automatic saving" is enabled and "Record data (Wave 
data) in measurement history" is disabled, data file is not created and no 

data are recorded in the history even if the measurement is performed. Use this 

setting only when you check the current phenomenon waveform. 
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6-18 Automatically deleting memory card data... 
Function  Deletes the file of the data, which are automatically acquired 

after the measurement, from the memory card to prevent 

capacity shortage of the card. 

 

Screen 

 

Description  If the remaining capacity of the memory card becomes short 

during automatic measurement, the measurement cannot be 

continued. 

Using this function, you can conduct measurement beyond the 

memory card capacity. 

Operation 

1. When Automatically deleting memory card data... is 

selected from the Measurement menu, the dialog box for 

making a setting is displayed. 

2. After the setting, click the "OK" button. 

 

Setting item 

Delete after getting the measuring data 
 : The file of the data which are automatically acquired after the 

measurement is deleted from the memory card. 
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6-19 Reading memory card data... 
Function The waveform data or the frequency data recorded in the 

memory card of the instrument are saved to a computer. 

 

Screen 

 

Description The data of off-line measurement recorded in the memory card 

can be read. 

The waveform data and the frequency data can be concurrently 

read. 

 

Operation 

1. Display the measurement panel 

2. Select the Reading memory card data... from the 

Measurement menu. The dialog box is displayed. 

3. After setting, click the "OK" button. 

 

Setting items 

Waveform data/Frequency data/Voice 
 : Select the type of the data file to be displayed. 

Use the coefficient, unit, and format of file. 
 : If you check this box, the settings of coefficient, unit and format 

included in the specified folder are applied for reading 

waveform data. If there are no such data, the setting of the 

Measurement project is used. 

Left list : The measurement data which are recorded in the memory card 

are listed. 

Right list : The measurement data to be read are listed. 

"Register" button 
 : The measurement data selected in the left list are registered in 

the right list.  

"Release" button 
 : The measurement data selected in the right list are deleted from 

the list.  
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6-20 Deleting selection of memory card data... 
Function The selected waveform data or frequency data recorded in the 

memory card of the instrument can be deleted. 

 

Screen 

 

Description If the free space of the memory card becomes small, the data 

files can be deleted to increase the free space. 

 

Operation 

1. Display the measurement panel. 

2. Select the Deleting selection of memory card data... 
from the Measurement menu. The dialog box is displayed. 

3. After setting, click the "Excute" button. 

 

Setting items 

Waveform data/Frequency data/Voice 
 : Select the type of the data file to be displayed. 

Delete : If "Yes" is selected, its file will be deleted. 

 

"Execute" button 
 : Selected file is deleted from the memory card. 
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6-21 Volume 
Function Sets the volume of the instrument. 

 

Description You can adjust the volume of the instrument while the 

measurement panel is displayed. 

 

Operation 

1. Display the measurement panel. 

2. Select volume level from Volume submenu of 

Measurement menu. 

 

Setting items 

OFF : Sets the volume level to mute. 

Low : Sets the volume level to low. 

Mid : Sets the volume level to middle. 

High : Sets the volume level to high. 

In case of using the TMR-211, 
the volume cannot be set. 
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6-22 Upgrading instrument... 
Function The instrument is upgraded. 

 

Screen 

 

Description Upgrades the instrument firmware by coping a file to memory 

card. 

 

Operation 

1. Copy the firmware for upgrading into the memory card. 

2. Insert the memory card in the instrument. 

3. Connect to a computer with LAN or USB and turn on the 

power.  

4. Start up the software and execute the interface setting on 

the Meter setting of the measurement project.  

5. Select Upgrading instrument... from the Measurement 
menu. The dialog box for upgrading is displayed. 

6. Click the "Confirmation" button on the dialog box. The file 

name of the firmware recorded in the memory card is 

displayed.  

7. After checking the file name, click the "Start" button.  

8. When the upgrading is completed normally, the dialog box 

is displayed. Click the "OK" button.  

9. Turn off the power of the instrument, then turn it on again. 

 

 

"Measurement project" 

In case of using the TMR-311, 
the instrument firmware 
cannot be upgraded by this 
operation. 
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7 Window menu 
Overview 

 Displaying single measurement project or measurement data on multiple 

windows.  

 Arranging the windows in cascade 

 Arranging the windows horizontally 

 Arranging the windows vertically 

 Arranging the iconized window 

 Display the names of opened measurement project, measurement data and 

chart sheet. 

 Displaying/not displaying the tool bar 

 Displaying/not displaying the status bar 

 Displaying/not displaying the trigger status bar 

 

 

7-1 Open a new window 
Function On the new window, the measurement project or the 

measurement data file is displayed. 

 

Screen 

 

Description One measurement project can be displayed on different 

windows. 

 

Operation 

1. Select the window to be displayed on multiple windows.  

2. Select Open a new window from the Window menu. 

Another window appears. 

"Measurement project" 
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7-2 Cascade 
Function When multiple windows for the measurement project, the 

measurement data file or the Chart sheet are opened, the 

windows are re-arranged in cascade. 

Screen 

 

Description All the windows being opened with this software are cascaded. 

The windows that fall outside the window of the software can 

be called up. 

 

7-3 Tile horizontally 
Function When multiple windows for the measurement project, the 

measurement data file or the Chart sheet are opened, the 

windows are re-arranged horizontally. 

Screen 

 

Description All the windows opened with this software are arranged so that 

each window size is horizontally oriented. The windows that 

fall outside the window of the software can be called up. 
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7-4 Tile vertically 
Function When multiple windows for the measurement project, the 

measurement data file or the Chart sheet are opened, the 

windows are re-arranged vertically. 

 

Screen 

 

Description All the windows opened with this software are arranged so that 

each window size is vertically oriented. The windows that fall 

outside the window of the software can be called up. 

 

7-5 Arrange icons 
Function Re-arrange the windows which are reduced to small icons 

 

Screen 

 

Description The windows reduced to small icons that are opened with this 

software are arranged. The windows that fall outside the 

window of the software can be called up. 
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7-6 Selection of windows 
Function The names of the opened measurement project, the 

measurement data file or the Chart sheet are listed. 

 

Description The names of the windows currently selected are checkmarked. 

By selecting the name, the window can be changed over. 

 

 

 

 

 

 

 

 

8 Help menu 
Overview 

 The version of this software is displayed. 

 

8-1 About TMR-7300... 
Function The version of this software is displayed. 

 

Screen 

 

Operation 

1. Select About TMR-7300... from the Help menu. The 

dialog box is displayed. 

2. After checking, click the "OK" button. 
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9 Frequency data menu 
Overview 

 Changing over the displays 

 Changing the number of displayed digits for the full scale, maximum value, 

minimum value and physical quantity 

 Displaying the physical quantity 

 Changing the width of column 

 

 

 

 

9-1 Switch to 
Function Changes the display items of the active frequency data file. 

 

Description 

Input CH : The conditions for recording data which were set in the 

instrument when executing frequency measurement are 

displayed for each frequency number. 

The number of display digits of the full scale, maximum 

number, minimum number and physical quantity of the 

frequency data can be changed. 

 

Frequency data 

 : The setting conditions and the frequency data of each frequency 

NO when the frequency measurement was conducted are 

displayed. 

The maximum value/minimum value of each frequency data are 

also displayed. 

 

To perform the frequency 
analysis using this software, 
the instrument shall be 
equipped with the function of 
executing the frequency 
analysis (option). 
 

 
"Frequency data" 

 
 

 
"Frequency data" 
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9-2 Format 
Function Changes the display digit number of the full scale, maximum 

value, minimum value and physical quantity of the frequency 

data.  

Screen 

 

Value  Exponent 

Description The format has an effect on the numerical display of data but 

internally keeps the accuracy. 

There are the following formats. 

0 to 0.0000000  : Value 

0e+00 to 0.0000000e+00 : Exponent 

 

Operation 

1. Select a cell in the Format column on the Input CH. 

2. Select from the formats displayed in the Format submenu 

of the Frequency data menu. 

 

 

9-3 Displaying the physical quantity 
Function Display or non-display the physical quantity in the frequency 

data. 

 

Description The physical quantity is displayed when Display physical 
quantity is checked. The physical quantity is not displayed 

when Display physical quantity is not checked. 

 

Operation 

1. Display the Frequency data and select the Display physical 
quantity from the Measurement data menu 

 

"Frequency data" 

 
"Frequency data" 
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9-4 Column width... 
Function Sets the width of the column including the selected cell in the 

unit of mm. 

 

Screen 

 

Description The width of all columns can be set separately for the input 

channel, setting conditions of the frequency data and the 

frequency data. 

 

Operation 

1. Select a cell and select the Column width... from the 

Frequency data menu. The dialog box for setting is 

displayed. 

2. After setting, click the "OK" button. 

 

 

 

 

 

 

 
"Frequency data" 
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This chapter describes settings and usage specific to the CAN unit 

(TMR-351). 

 

1 CAN Unit Selection 
Click "Meter setting..." button in the Measurement project. 

  

Select CAN unit from the Name column of unit port to which CAN unit 

(TMR-351) is connected and click the "OK" button. 

If the later unit port after the CAN unit (TMR-351) is not connected, 

the virtual unit "CAN Add. CH." is displayed. 

If another unit is connected, it will not be displayed thereafter. 

In the virtual unit, CAN receive signals can be additionally assigned 

to the CH of the virtual unit. (See p10-5 "Setting of virtual units") 

 

Only one CAN unit (TMR-351) can be connected to one control unit;  

 

CAN/Voice/GPS is added to the buttons displayed in the 

Measurement project. 

 

The setting screen inherent in CAN/Voice/GPS unit is displayed from 

this "CAN/Voice/GPS" button. 

 

For details on the setting of 
instrument, refer to "Chapter 
4: 2. Setting of the instrument" 
(Page 4-2). 
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2 Timing of data recording 
The CAN unit (TMR-351) records received data or transmits data in 

the following cycle. 

 

Recording of incoming data 
 : It records at the same period as the sampling of 

the A/D setting. 

The fastest clock is 1 ms. 

Data Transmission 

 : Sets a different cycle than the A/D setting. 

Select the transmission cycle from 

1/2/5/10/20/50/100/200/500/1000 ms. 

 

 

3 Data Recording 
Received data from the CAN unit (TMR-351) can be saved either by 

assigning some signals to input channels and saving them in a 

waveform file or by saving all signals as a CAN file. 

 

Save to waveform file 
 : Some signals can be assigned to input channels 

and saved as waveform files (dat) on the 

TMR-311's memory card. 

However, the signals assigned to the input 

channels must be less than 2 bytes (16 bits) in 

data length. 

Save to CAN file : The data of all messages received during 

measurement is stored in the internal memory 

(32Mbyte) of the CAN unit (TMR-351) and saved 

as a CAN file on the memory card of the 

TMR-311 at the end of measurement. 

Due to the above characteristics, free-run 

measurement and programmed measurement 

cannot be selected when the CAN file is set to be 

saved. 

 

 

Transmission cycle setting, 
refer to ”4-1Displaying the 
Basic setting screen”(Page 
10-3). 

Channel Assignment, refer 
to ”4-1Displaying the Basic 
setting screen”(Page 10-3). 
 

CAN file saving settings, refer 
to ”4-1Displaying the Basic 
setting screen”(Page 10-3). 
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4 CAN unit settings 
The setting of CAN/Voice/GPS unit is made on the input CH screen 

and the CAN/Voice/GPS screen. 

 

The setting of input CH cannot set items other than Name. 

 

4-1 Displaying the Basic setting screen 
In order to set CAN/Voice/GPS unit, select the Basic setting from the 

"CAN/Voice/GPS" button menu. 

 

The screen of basic setting is displayed. 

 

 

 

For details on the input CH, 
refer to "Chapter 4: 6. Input 
Channels" (Page 4-10). 
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⚫ CAN 

 

Communication speed 
 : Sets the baud rate of the communicating device. 

Transmission cycle: Select the cycle for sending messages from 

1/2/5/10/20/50/100/200/500/1000 milliseconds. 
Output ACK when receiving frame. 
 : Turns the transmit function ON (Normal mode) 

when enabled. 

Turns off the transmit function when disabled 

(Listen only). 

Save to CAN file : The data of received messages are stored in the 

internal memory of the CAN unit (TMR-351) 

during measurement, and CAN files are created 

in the memory card of the TMR-311 at the end of 

measurement. 

 

⚫ Input channel data 

 

Some signals can be assigned to input channels to record to a 

waveform file (dat) and monitor values. 

 

To assign to an input channel, click the "Not allocated." button and 

select the target signal from the following screen. 

 

Press "OK" to confirm your selection. 
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⚫ Setting of virtual units 
Normally, the number of channels in a measurement unit is the 

number of channels corresponding to sensor inputs (8 channels), but 

in the case of CAN, 8 channels may not be sufficient depending on the 

messages to be received. 

Therefore, by enabling channel assignment of incoming signals of 

CAN units to unused unit, up to 80 CH can be recorded per sampling. 

 

 

 

Since the virtual unit is a function that assigns receive signals set by 

the CAN unit (TMR-351), only "Input channel data" can be set for the 

virtual unit. 

The following section, "Setting of sent/received data" also cannot be set 

for the virtual unit. 
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4-2 Setting of sent/received data 
To set the data to be received or transmitted by the CAN unit 

(TMR-351), select CAN data from the "CAN Voice GPS" button. 

 

Make a setting of CAN data on the CAN data screen according to the 

transmission/reception data. 

 

⚫ Message and signal 
The CAN unit (TMR-351) uses the concepts "message" and "signal". 

In CAN, data are discriminated by an identifier called ID. In CAN 

unit (TMR-351), the setting is made by allocating the ID to 64 

messages. An ID that is not set to a message is not recorded. 

Recording is not performed even if the ID is just set to the message. 

The preparation for recording is completed when the message and the 

signal are set. For the signal, more than one data can be input in one 

ID for CAN. For example, it is like a case that the data of strain, 

voltage and thermocouple are input in the same ID. However, in this 

case, you cannot see where the strain data ends. Therefore it is 

necessary to set where the data (signal) ends. It is the signal setting. 

The relationship between the message and the signal is shown in the 

figure below. 
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⚫ Setting the CAN reception 
Select "Receiving message" on the CAN data screen. 

 

The screen of receiving message is displayed. 

Make settings in order of message and signal. 

 

The maximum number of messages that can be received is 64, 
including outgoing messages. 

 

Message setting 

Message Name : Input the name of message. Input an arbitrary 

name which is easy to understand. 

CAN ID number : Input the ID number in hexadecimal number. 

The ID number is arbitrarily set by each device 

(data). Check and input the ID number of output 

device. 

ID Type : Select the ID type between standard and 

extended. The standard and the extended are 

sometimes represented as 11Bit ID and 29Bit ID 

or CAN2.0A and CAN2.0B respectively. Check 

the setting of output device and make a selection. 

Length(bytes) : Set the data length of ID. 1 byte is 8 bits. Check 

the specification of output device and make a 

selection. 

Remote Frame : It cannot be set. 

Node Name : It cannot be set. 
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Signal setting 

Signal Name : This is for inputting the name of the signal. 

Input an arbitrary name. 

Type : This is to select between the integer with sign 

and integer without sign for the data. It is 

sometimes represented as Signed and Unsigned 

for with sign and without sign, respectively. 

Check the specification of the output device and 

make selection.  

Format : This is to select between Intel format and 

Motorola format for the data. This setting shows 

whether the upper byte of the data is on the 

beginning of the data or the end of the data. The 

Intel format and the Motorola format are also 

represented as little endian and big endian, 

respectively. Check the specification of the 

output device and make selection. 

Start Bit : This is to specify the first bit of the data. The bit 

array varies between the Intel format and the 

Motorola format. Refer to the example shown in 

the figure below. 

Length(bits) : This is to specify the length of the signal (data) 

by the number of bits. The length of data varies 

depending on the device (data). Check the 

specification of output device and make a 

selection. 

Factor : The data are multiplied by this factor 

(coefficient) and recorded. If you want to record 

data without change, set 1 to the Factor.  
Offset : This offset value is added to the data and the 

sum is recorded. If you want to record data 

without change, set 0 to the Offset. The CAN 

data do not become 0 even if balancing is 

executed. If you want to make the input data to 

0, set an appropriate value to the Offset. 

Unit : Specify the unit for display and recording. You 

can select the unit from 41 units such as μStrain, 

m/s2 and rpm. 

Format : Select the data display format for display and 

recording. If the format is set to 0, the digits after 

the decimal point are not recorded. Make a 

selection in combination with Factor. 

 

If the number of bits is 43 or 
more, the data is rounded to 16 
significant digits when 
converted to physical quantity. 
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⚫ Setting the CAN transmission 
Select "Sending message" on the CAN data screen 

 

The screen of sending message is displayed. 

Make settings in order of message and signal. 

 

You can send up to 62 messages. 

Up to 4 signals can be set per message. 

 

 

Message setting 

Message Name : Input the name of message. Input an arbitrary 

name which is easy to understand. 

CAN ID number : Input the ID number in hexadecimal number. 

The ID number is arbitrarily set by each device 

(data). Input the ID number by checking that the 

number is not overlapping with that of other 

devices. 
ID Type : Select the ID type between standard and 

extended. The standard and the extended are 

sometimes represented as 11Bit ID and 29Bit ID 

or CAN2.0A and CAN2.0B respectively. Check 

the specification of the device to be recorded. 

Length(bytes) : Set the data length of ID. It is fixed to 2 bytes for 

output. 

Remote frame : Sets the content and timing of data 

transmission. 

“Data transmission" sends data at each set 

transmission cycle. 

“Transmit data on receipt" transmits data when a 

remote frame is received, regardless of the 

transmission cycle. 

“Remote frame transmission" sends remote frames 

instead of data. 

Node Name : It cannot be set. 
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Signal setting 

Signal Name : Input the name of signal. Input an arbitrary 

name which is easy to understand. 

Input ch. : Select the channel to be transmitted from the 

measurement unit. 

Type : It cannot be set. 

Format : It cannot be set. 

Start Bit : Specifies the first bit of data. 

Length(bits) : It cannot be set. 

Factor : It cannot be set. 

Offset : It cannot be set. 

Unit : It cannot be set. 
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5 CAN file processing 
Received data stored in the internal memory of the CAN unit 

(TMR-351) is created as a CAN file in the memory card of the 

TMR-311 at the end of measurement. 

If the measurement was taken online with a computer, the CAN file 

is automatically imported into the computer as well as the waveform 

file (dat). 

However, if the measurements were taken offline, they must be 

imported manually. 

 

5-1 Reading memory card data 
You can save the measurement data stored in the memory card in the 

instrument to a computer. 

 

◼ "Reading memory card data..." 
Select "Reading memory card data..." in the Measurement menu 

 

The data recorded in the memory card is displayed. 

 

◼ "Reading instrument data..." 

Insert the memory card in the memory card slot of computer and 

select "Reading instrument data..." in the File menu. 

 

If you click "Reference" button and select the folder in which the data 

are recorded, the data recorded in that folder are displayed. 

For details, please read 
“Chapter 5: 16Reading 
memory card data” (Page 
5-30). 
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CAN data is registered by selecting waveform data. 

 

If you click the "OK" button, the data are read and displayed in the 

history. 
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5-2 Display of CAN data 
If a data file is displayed from the history and it contains data from a 

CAN file, the "CAN Voice GPS" button will appear and CAN data can 

be selected. 

 

A list of CAN data is displayed. 

 

The CAN data displays the value of the received signal and the 

measured time at which the message was received. 

 

For details on displaying data 
files, see "Chapter 7, 3-2 
Displaying Data Files" 
(Page7-9). 
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5-3 Displaying CAN chart list 
When a data file is displayed from the history and it contains data 

from a CAN file, the "CAN Voice GPS" button appears and the CAN 
chart list can be selected. 

 

A chart list of CAN data is displayed. 

 

The CAN chart list draws the received signals in a transitional 

graph. 

 

 

 

 

For details on displaying data 
files, see "Chapter 7, 3-2 
Displaying Data Files" 
(Page7-9). 
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GPS unit 
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This chapter describes settings and usage specific to the GPS unit 

(TMR-354). 

 

1 GPS Unit Selection 
Click "Meter setting..." button in the Measurement project. 

  

Select GPS unit from the Name column of unit port to which GPS unit 

(TMR-354) is connected and click the "OK" button. 

If the unit port behind the GPS unit (TMR-354) is not connected, the 

virtual unit "GPS Add. CH." is displayed. (Up to 3 units are 

displayed) 

If another unit is connected, it will not be displayed thereafter. 

In the virtual unit, GPS reception data can be additionally assigned 

to the CH of the virtual unit. (See p11-6 "Settings of virtual unit.") 

 

Only one GPS unit (TMR-354) can be connected to one control unit;  

 

CAN/Voice/GPS is added to the buttons displayed in the 

Measurement project. 

 

The setting screen inherent in CAN/Voice/GPS unit is displayed from 

this "CAN/Voice/GPS" button. 

 

For details on the setting of 
instrument, refer to "Chapter 
4: 2. Setting of the instrument" 
(Page 4-2). 
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2 Data Recording 
The measurement data of the GPS unit (TMR-354) includes a 

waveform file that records the reception data assigned to each input 

channel and a GPS file that records fixed reception parameters. 

 
Waveform file : 
By assigning some received data to input channels, the data is saved 

as a waveform file (dat) on the TMR-311's memory card. 

Depending on the receive data assigned to the input channel, the 

data length is 16 bits and 32 bits, respectively.  

The 32-bit data occupies 2 channels. 

The data that can be assigned to the input channels are as follows. 

Item Number of 
occupied CHs Remarks 

Time 2 
Cumulative time in 1 ms with reference to 
00:00:00.000 
0～85,399,999 (00:00:00.000～23:59:59.999)※ 

Date 2 Date in yymmdd 
ex) In case 10/1/2022 : 221001 

Latitude 2 0.0000001°increments. 
North is positive. 

Longitude 2 0.0000001°increments. 
East is positive. 

Elevation 1 1m increments. 
Speed 1 0.1km/h increments. 
Distance 2 1m increments. 
Direction 1 0.1°increments. 
Roll 1 0.1°increments. 
Pitch 1 0.1°increments. 
Heading 1 0.1°increments. 
Acceleration - x 1 0.001m/s2 increments. 
Acceleration - y 1 0.001m/s2 increments. 
Acceleration - z 1 0.001m/s2 increments. 
Angular Rate - x 1 0.01deg/s increments. 
Angular Rate - y 1 0.01deg/s increments. 
Angular Rate - z 1 0.01deg/s increments. 

※ The "Time"(T) is shown as a cumulative time in  

1 ms increments relative to midnight (0:00 AM).  

To display the time as hours:minutes:seconds, the following 

calculations must be made, respectively. 

Hours:H = T / 3600000 

Minutes:M = T / 60000 - 60 × H 

Seconds:S = T / 1000 - (3600 × H + 60 × M) 

Each value should be calculated as an integer and rounded down 

to the nearest whole number. 

For seconds (S), after the decimal point can be treated as a 

millisecond. 

 

If extended CH is used for data that occupies two channels, the 
extended CH data cannot be recorded. 

 

GPS file : 

Specific data received during measurement is saved as a GPS file 

(gps) on the TMR-311's memory card. 

The GPS unit (TMR-354) must be set to "binary" or "binary + CSV" as 

the recording format. 
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3 GPS unit settings 
The setting of GPS unit is made on the input CH screen and the 

CAN/Voice/GPS screen. 

 

The setting of input CH cannot set items other than Name. 

 

3-1 Displaying the Basic setting screen 
In order to set GPS unit, select the Basic setting from the 

"CAN/Voice/GPS" button menu. 

 

The screen of basic setting is displayed. 

After selecting the corresponding Port, please configure the settings. 

 

 

 

 

For details on the input CH, 
refer to "Chapter 4: 6. Input 
Channels" (Page 4-10). 
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3-2 GPS data measurement settings 
⚫ GPS 

  

 

GPS terminal : Set the terminal that the GPS receiver are 

connected to from among "RS-232C" and "CAN". 

 
Communication speed 
 : Select the communication speed with the GPS 

receiver from the following options. 

 RS-232C:(4800/9600/19200/38400/57600/115200) 

CAN:(100k/125k/250k/500k/800k/1M) 

 

Stop bit : Select stop bit from 1 and 2. (RS-232C) 

 

Parity : Select parity from (NONE/ODD/EVEN). 

(RS-232C) 

 

Flow Control : Select Flow Control from (NONE/HARDWARE). 

(RS-232C) 

 

Recording format : Select file recording format for TMR-354 from 

(No Record/ Binary / Binary + CSV). 

 

Clock Adjustment : This function adjusts the clock of TMR-311 using 

GPS. 

Select whether or not to adjust the clock, and 

enter the time difference from UTC. 

The range of time difference setting is  

-12:59:59 to +12:59:59. 

 



Chapter 11 GPS unit 

 

 11-5 

⚫ Input channel data 

 

By assigning some GPS data to input channel, it is possible to record 

the data to a waveform file (dat) and monitor the values. 

 

To assign to an input channel, click the "Not allocated." button and 

select the target signal from the following screen. 

 

Press "OK" to confirm your selection. 
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⚫ Setting of virtual units 
Although a maximum of 8 CHs can be recorded per unit, it is 

assumed that the GPS unit (TMR-354) can acquire more than 8 CHs 

of received data, so that one unit will not be sufficient. 

Therefore, by enabling channel assignment of the GPS unit's received 

data to unused unit numbers, all items can be recorded. 

 

 

 

Only "Input channel data" can be set for the virtual unit 
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4 Processing GPS measurement data 
If the measurement was taken online with a computer, the GPS file is 

automatically imported into the computer as well as the waveform 

file (dat). 

However, if the measurements were taken offline, they must be 

imported manually. 

 

4-1 Reading memory card data 
You can save the measurement data stored in the memory card in the 

instrument to a computer. 

 

◼ "Reading memory card data..." 
Select "Reading memory card data..." in the Measurement menu 

 

The data recorded in the memory card is displayed. 

 

◼ "Reading instrument data..." 
Insert the memory card in the memory card slot of computer and 

select "Reading instrument data..." in the File menu. 

 

If you click "Reference" button and select the folder in which the data 

are recorded, the data recorded in that folder are displayed. 

For details, please read 
“Chapter 5: 16Reading 
memory card data” (Page 
5-30). 
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GPS data is registered by selecting waveform data. 

 

If you click the "OK" button, the data are read and displayed in the 

history. 
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4-2 Display of GPS data 
If a data file is displayed from the history and it contains data from a 

GPS data file, the "CAN Voice GPS" button will appear and GPS data 

can be selected. 

 

If the GPS data is selected, only the GPS data is displayed. 

 

The display is divided in three parts and the trajectory is drawn in 

upper left using the data of latitude and longitude. Nothing is 

displayed if there is no data of latitude and longitude. 

In the upper right area and the lower area, the data list and the chart 

list are displayed, respectively. 

If you drag the chart in the chart list, the selected part is highlighted 

in each area. 

 

 

If the latitude and longitude are got with multiple CHs, the trajectory 
is drawn using the latitude and longitude with the smallest CH 
number. 

For details on the input CH, 
refer to “Input channel data” 
(Page 11-5) in “Chapter 11: 3-2 
Setting the GPS data 
measurement”. 

On the display of the GPS data, 
the editing of marker can be 
done. 
For editing marker, refer to 
"Chapter 7: 7-5 Display and 
editing of marker" (page 7-28). 
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◼ Saving the selected part as text 
In order to save the selected part as text, right-click the chart list or 

the data list and select Save as text... from the displayed menu. 

 

 

The dialog box for text conversion is displayed. 
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If you click the "The selected range is set to the step", the step changes 

to the selected range.  

 

If you select the data and click the "OK" button, the selected part is 

saved as text. 

 

◼ Printing the area 
If you click each area, a yellow frame is displayed in that area. 

If you implement the printing while this frame is displayed, the 

content displayed in that area is printed. 
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4-3 Displaying the GPS raw data 
GPS raw data is data recorded as a GPS file. 

The GPS unit (TMR-354) must be set to "binary" or "binary + CSV" as 

the recording format. 

If a GPS file is recorded, the "CAN Voice GPS" button will appear and 

GPS raw data can be selected. 

 

The list of GPS raw data is displayed. 

 

The following items are displayed in the GPS raw data. 

 

gps_lat_abso_deg ：Latitude, in 0.0000001° increments. 

gps_lon_abso_deg ：Longitude, in 0.0000001° increments. 

gps_date ：Date and time. 

gps_ele_abso : Elevation, in 1m increments. 

gps_vel : Speed, in 0.1k/h increments. 

gps_trk : Direction, in 0.1° increments. 

gps_roll : Rotation, in 0.1° increments. 

gps_pitch : Pitch, in 0.1° increments. 

gps_heading : Heading, in 0.1° increments. 

gps_acc_x : X-axis acceleration, in 0.001m/s2 increments. 

gps_acc_y : Y-axis acceleration, in 0.001m/s2 increments. 

gps_acc_z : Z-axis acceleration, in 0.001m/s2 increments. 

gps_ang_x : X-axis angular rate, in 0.01deg/s increments. 

gps_ang_y : Y-axis angular rate, in 0.01deg/s increments. 

gps_ang_z : Z-axis angular rate, in 0.01deg/s increments. 
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4-4 Display of GPS map 
The trajectory can be drawn on the map according to the latitude and 

longitude recorded with GPS unit. 

 

The use of this function needs an environment where the computer is 
connected to Internet. The maps are drawn using Google Maps API. 

 

Display the data file of the latitude and longitude. 

 

 

Select the GPS Map on the "CAN/Voice/GPS" button menu. 

 

 

Screen for setting the size of the map and the number of trajectory 

data drawn on the map is displayed. 
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As the number of trajectory data increases, drawing will take much 

time or may be made incorrectly. Set the number of data between 50 

and 5000. 

If the number of recorded data is more than the set value, the data 

are thinned out at even intervals to approximate the set value. In 

case that the number of data is less, all the data are used. 

The size of the map can be changed by shifting the slider. 

The browser is launched when you click the button "The map display 
in the browser", and the trajectory is drawn on the map. 
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This chapter explains the settings and the usage inherent in the 

CAN/Voice/GPS unit (TMR-251). 

 

1 Selecting CAN/Voice/GPS unit  
Click "Meter setting..." button in the Measurement project. 

 

Select CAN/Voice/GPS from the Name column of unit port to which 

CAN/Voice/GPS unit (TMR-251) is connected and click the "OK" button. 

 

CAN/Voice/GPS is added to the buttons displayed in the Measurement project. 

 

The setting screen inherent in CAN/Voice/GPS unit is displayed from this 

"CAN/Voice/GPS" button. 

 

For details on the setting of 
instrument, refer to "Chapter 4: 
2. Setting of the instrument" 
(Page 4-2). 
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2 Note on the timing for recording the data 
With CAN/Voice/GPS unit (TMR-251), the setting of sampling clock is 

reflected as shown below. 

 

CAN data 
As for the data reception, the received data are recorded in the same cycle as 

the sampling clock. As for the data transmission, data are output as the same 

cycle as the sampling clock. 

For example, if the sampling clock is set to 1ms, the received data are 

recorded at intervals of 1ms and the data are output at intervals of 1ms. 

However, if the remote frame is set for the output data, the sampling clock 

setting for the output is ignored. 

GPS data 
The data are recorded in the same cycle as sampling clock setting. 

Voice data 
The sampling clock setting is ignored. 

 

For the sampling clock of CAN/Voice/GPS unit (TMR-251), 1ms is the 

minimum. The smaller value can be set, however, the interval for updating the 

data of CAN/Voice/GPS unit (TMR-251) is 1ms. 

 

 

3 Note on the recording of data 
There are two methods for recording the data of CAN/Voice/GPS unit 

(TMR-251); the method for recording the data in TMR-211 in real time and the 

method for recording the data in the internal memory of CAN/Voice/GPS unit 

(TMR-251). 

 

Recording in TMR-211 
The selected measurement data from CAN data and GPS data which are 

received by CAN/Voice/GPS unit (TMR-251) is recorded to memory card in 

TMR-211. As the data capacity depends on the memory card, the 

long-duration recording is available. However, the number of data (number 

of items) that can be recorded at the same time is limited. 

Recording in CAN/Voice/GPS unit (TMR-251) 
Record the data in the internal memory of CAN/Voice/GPS unit (TMR-251). 

The data capacity of the internal memory is 6MB and it can be allocated to 

CAN, Voice and GPS. However, this method is not suitable for high-speed 

recording of data or long-duration data recording. This internal memory 

should be used supplementarily. 
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4 Setting the CAN/Voice/GPS unit 
The setting of CAN/Voice/GPS unit is made on the input CH screen and the 

CAN/Voice/GPS screen. 

 

The setting of input CH cannot set items other than Name. 

 

4-1 Displaying the Basic setting screen 
In order to set CAN/Voice/GPS unit, select the Basic setting from the 

"CAN/Voice/GPS" button menu. 

 

The screen of basic setting is displayed. 

 

For details on the input CH, 
refer to "Chapter 4: 6. Input 
Channels" (Page 4-10). 
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4-2 Setting the GPS data measurement 
These are the items to be set relevant to GPS data in the Basic setting. 

 

 Memory allocation 

 

Input the number of memory areas used for the measurement of GPS data. 

The total memory of CAN, Voice and GPS should be 6,000,000Byte or less. 

For example, if CAN and Voice are not used, GPS can be set to 

6,000,000Byte and others can be set to 0Byte. If the internal memory of 

CAN/Voice/GPS unit (TMR-251) is not used, set every item to 0Byte. If the 

internal memory is used, the received data of GPS are recorded in the 

internal memory when the measurement is started. The interval of recording 

is set by Measurement position interval. 
 

The data to be recorded in the internal memory are shown below. 

Header Longitude Latitude Time Altitude Speed Azimuth 

4Byte 4Byte 4Byte 6Byte 2Byte 2Byte 2Byte 
 

If the measurement position interval is set to 1 second, the recording time is 

as shown below. 

GPS memory   Recording time 

1000000    1,000,000Byte / 24Byte ＝ 41,666 seconds 

2000000    2,000,000Byte / 24Byte ＝ 83,333 seconds 

6000000    6,000,000Byte / 24Byte ＝ 250,000 seconds 
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 GPS 

 

GPS receiver 
 : Select the receiver used for receiving the GPS data. If GPS is 

not used, select [Unconnection]. 

Measurement position interval 
 : Select the interval for receiving the GPS data. The interval at 

which the GPS data can be received varies depending on the 

GPS receiver. The fastest interval of TMR-251-1 and 

TMR-251-2 is 0.05 second and 0.25 second, respectively. If the 

positioning interval is made faster, more detailed data can be 

obtained, however, the total recordable time becomes less. 

 

If the data are recorded in TMR-211, the positioning interval is set to the 

update interval of GPS data. If the data are recorded in the internal memory of 

CAN/Voice/GPS unit (TMR-251), it is set to the sample interval of GPS data. 

 

Do correction and distance measurement 
 : This setting is valid only when the data is recorded in TMR-211. 

The following operations are made by enabling this function. 

1.The latitude and longitude data are supplemented using the internal 

accelerometer. The data between the positioning intervals is supplemented at 

100Hz. With this function, the data on a curve gets closer to the actual 

smooth driving data. 

2.The speed data measured by the GPS receiver is supplemented using the data 

of internal accelerometer. 

3.The travel distance calculated from the corrected speed is output. This data is 

reset when the balancing is implemented or the measurement is started. 

The speed equal to or less than the value which is set by "The lower value 
of speed to be neglected at distance conversion" is neglected. 

4.The digital signal input function is mounted on the GPS receiver. This 

function is mainly used as a marker. 

 

This correction function cannot be used at the same time with the CAN data 

input. 
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 Input channel data 
Set this item when the data is recorded or monitored by TMR-211 or the 

voltage output, the alarm or the trigger function is used. If you click the "Not 
allocated" of the measurement monitor channel for displaying the received 

data of GPS, the data screen for input CH as shown below is displayed. 

Select the GPS data to be allocated to the channel, and click the "OK" 
button. 

 

The number of channels that can use this function is limited to 8 channels 

collectively. With the GPS data, the number of channels that are allocated to 

each item varies as shown below. 

GPS data GPS Corrected data 

Data item Num of CH Data item Num of CH 

Longitude 2 Corrected longitude 2 

Latitude 2 Corrected latitude 2 

Elevation 1 Corrected elevation 1 

Velocity 1 Corrected velocity 1 

Azimuth 1 Distance 2 

  Voltage input 1 
 

 

 

If extended CH is used for data that occupies two channels, the extended CH 

data cannot be recorded. 
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4-3 Setting the CAN data measurement 
This is the item to be set related to CAN data in the Basic setting. 

 

 Memory allocation 

 

Input the number of memory areas used for the measurement of CAN data. 

The total memory of CAN, Voice and GPS should be 6,000,000Byte or less. 

For example, if GPS and Voice are not used, CAN can be set to 

6,000,000Byte and others can be set to 0Byte. If the internal memory of 

CAN/Voice/GPS unit (TMR-251) is not used, set every item to 0Byte. If the 

internal memory is used, the received data of CAN are recorded in the 

internal memory when the measurement is started. The recording interval is 

set by "A/D setting". 
 

The data to be recorded in the internal memory are shown below. 

Received time Message number Number of data Data 

4Byte 1Byte 1Byte 1 to 8 Byte variable 
 

The latest message is recorded in every recording interval. 

 

The shortest recording time when the recording interval is 1 second and the 

data length is 8Byte is shown below. 

CAN memory  Recording time 

1000000   1,000,000Byte / 14Byte - 1 ＝ 71,427 seconds 

2000000   2,000,000Byte / 14Byte - 1 ＝ 142,856 seconds 

6000000   6,000,000Byte / 14Byte - 1 ＝ 428,570 seconds 

 

Take note that the data recorded in TMR-211 is the signal and the data 

recorded in the internal memory of CAN/Voice/GPS unit (TMR-251) is the 

message. 

 

For details on the A/D setting, 
please read “Chapter 4. 3. A/D 
setting” (Page 4-6). 
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 CAN 

 

Communication speed 
 : Set the communication speed according to the used instrument. 

Does not re-send due to bus error. (Single shot) 
 : If the data cannot be sent due to lost arbitration when sending 

the data from CAN/Voice/GPS unit (TMR-251), the 

transmission is tried again until the data can be sent. Take note 

that the timing deviates from the normal transmission timing. If 

this item is checked (enabled), the retransmission is not 

implemented. The transmission timing does not deviate, 

however, the data fails. 

 

 

Forcibly restored even with BUS OFF 
 : In CAN, the communication state is monitored to detect an error. 

If the number of errors exceeds a certain level, the operation 

mode is shifted. There are three modes; "error active", "error 
passive" and "bus off". The system is separated from the CAN 

network in the "bus off" state. This setting decides whether to 

return to the network promptly or not, after the operation mode 

is shifted to bus off state. Before making this setting, check the 

followings. 

・Cause of bus off is known 
・Release of bus off does not affect the network 

 

Output ACK when receiving frame. 
 : The ACK signal is output when a communication is performed 

properly regardless of the setting (message, ID, signal) of 

CAN/Voice/GPS unit (TMR-251). 

If the ACK signal is not output, the sending side decides that an 

error occurred. Generally, when the connection is made on 

one-to-one basis, set this to output ACK. When connecting to an 

existing network, it is safer not to output ACK because the 

output may have a serious influence on the network. 
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 Input channel data 
Make a setting when the data is recorded or monitored by TMR-211, or the 

voltage output, the alarm or the trigger function is used. If you click "Not 
allocated" button of the measurement monitor channel for displaying the 

received data of CAN, the data screen for the input CH shown in the figure 

below is displayed. Select the CAN data to be allocated to the channel and 

click "OK" button at upper right of screen. 

 

If the check box of "Do correction and distance measurement" in the setting 

of GPS data measurement is checked, the input of CAN data is disabled. 
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4-4 Setting the CAN transmission/reception data 
In order to set the data to be received or sent by CAN/Voice/GPS unit 

(TMR-251), select CAN data from the "CAN/Voice/GPS" button menu. 

 

Make a setting of CAN data on the CAN data screen according to the 

transmission/reception data. 

 

 Message and signal 
The CAN/Voice/GPS unit (TMR-251) uses the concepts "message" and 

"signal". In CAN, data are discriminated by an identifier called ID. In 

CAN/Voice/GPS unit (TMR-251), the setting is made by allocating the ID to 

64 messages. An ID that is not set to a message is not recorded. Recording is 

not performed even if the ID is just set to the message. The preparation for 

recording is completed when the message and the signal are set. For the 

signal, more than one data can be input in one ID for CAN. For example, it 

is like a case that the data of strain, voltage and thermocouple are input in 

the same ID. However, in this case, you cannot see where the strain data 

ends. Therefore it is necessary to set where the data (signal) ends. It is the 

signal setting. The relationship between the message and the signal is shown 

in the figure below. 
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 Setting the CAN reception 
Select "Receiving message" on the CAN data screen. 

 

The screen of receiving message is displayed. 

Make settings in order of message and signal. 

 

The number of receivable messages is up to 64 messages including the sending 

message. 

 

Message setting 

Message Name 
 : Input the name of message. Input an arbitrary name which is 

easy to understand. 

CAN ID number 
 : Input the ID number in hexadecimal number. The ID number is 

arbitrarily set by each device (data). Check and input the ID 

number of output device. 

ID Type : Select the ID type between standard and extended. The standard 

and the extended are sometimes represented as 11Bit ID and 

29Bit ID or CAN2.0A and CAN2.0B respectively. Check the 

setting of output device and make a selection. 

Length(bytes) 
 : Set the data length of ID. 1 byte is 8 bits. Check the 

specification of output device and make a selection. 

Remote Frame 
 : Set the data reception by the remote frame between ON and 

OFF. The remote frame means the data output request and in 

this case, the output of specified ID data to other device from 

CAN/Voice/GPS unit (TMR-251) is requested. The remote 

frame is requested from CAN/Voice/GPS unit (TMR-251) in the 

timing of sample interval. 

Node Name : This is the setting for expansion. 
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Signal setting 

Signal Name 
 : This is for inputting the name of the signal. Input an arbitrary 

name. 

Type : This is to select between the integer with sign and integer 

without sign for the data. It is sometimes represented as Signed 

and Unsigned for with sign and without sign, respectively. 

Check the specification of the output device and make selection. 

Format : This is to select between Intel format and Motorola format for 

the data. This setting shows whether the upper byte of the data 

is on the beginning of the data or the end of the data. The Intel 

format and the Motorola format are also represented as little 

endian and big endian, respectively. Check the specification of 

the output device and make selection. 

Start Bit : This is to specify the first bit of the data. The bit array varies 

between the Intel format and the Motorola format. Refer to the 

example shown in the figure below. 

Length(bits) : This is to specify the length of the signal (data) by the number 

of bits. The length of data varies depending on the device (data). 

Check the specification of output device and make a selection. 

Factor : The data are multiplied by this factor (coefficient) and recorded. 

If you want to record data without change, set 1 to the Factor. 

Offset : This offset value is added to the data and the sum is recorded. If 

you want to record data without change, set 0 to the Offset. The 

CAN data do not become 0 even if balancing is executed. If you 

want to make the input data to 0, set arbitrary value to the 

Offset. 

Unit : Specify the unit for display and recording. You can select the 

unit from 41 units such as μStrain, m/s2 and rpm. 

Format : Select the data display format for display and recording. If the 

format is set to 0, the digits after the decimal point are not 

recorded. Make a selection in combination with Factor. 

 

If the number of bits is 43 or 
more, the data is rounded to 16 
significant digits when 
converted to physical quantity. 
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 Setting the CAN transmission 
Select "Sending message" on the CAN data screen 

 

The screen of sending message is displayed. 

Make settings in order of message and signal. 

 

Up to 8 messages can be sent. 

 

Message setting 

Message Name 
 : Input the name of message. Input an arbitrary name which is 

easy to understand. 

CAN ID number 
 : Input the ID number in hexadecimal number. The ID number is 

arbitrarily set by each device (data). Input the ID number by 

checking that the number is not overlapping with that of other 

device. 

ID Type : Select the ID type between standard and extended. The standard 

and the extended are sometimes represented as 11Bit ID and 

29Bit ID or CAN2.0A and CAN2.0B respectively. Check the 

specification of the device to be recorded. 

Length(bytes) 
 : Set the data length of ID. It is fixed to 2 bytes for output. 

When the data is sent, it is fixed to 1 message and 1 signal. 

 

Remote Frame 
 : Set the data by remote frame between ON/OFF. The remote 

frame means the data output request and in this case, output of 

specified ID data from other device to CAN/Voice/GPS unit 

(TMR-251) is requested. In this case, the sampling interval of 

CAN/Voice/GPS unit (TMR-251) is disabled. 

Node Name : This is the setting for expansion. 
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Signal setting 

Signal Name 
 : Input the name of signal. Input an arbitrary name which is easy 

to understand. 

Input ch. : Select the data to be sent. The measurement unit other than the 

voltage output unit TMR-241 can be selected. 

Type : This is to select between the integer with sign and integer 

without sign for the data. When sending data, it is fixed to the 

integer with sign. 

Format : This is to select between Intel format and Motorola format for 

the data. When sending data, it is fixed to Motorola. 

Start Bit : This is to specify the first bit of the data. When sending data, it 

is fixed to 8. 

Length(bits) : This is to specify the length of the signal (data) by the number 

of bits. When sending data, it is fixed to 16. 

Factor : The data are multiplied by this factor (coefficient) and output. 

When sending the data, it is fixed to 1. 

Offset : This offset value is added to the data. When sending the data, it 

is fixed to 0. 

Unit : The unit is specified for display and recording. When sending 

data, no unit is added. 
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 Notes on CAN transmission data 
The CAN/Voice/GPS unit (TMR-251) can send the data of measurement 

unit to be connected. 

For example, the data such as strain, voltage and temperature can be sent. 

The data sent to CAN by CAN/Voice/GPS unit (TMR-251) is sent based on 

the rule shown below. 

 

However, this rule is not applied to TMR-253 pulse-count. 

The formula above shows that "10000" is output to CAN when a value equal to 

the set range of the measurement unit is input to the unit. 

 

The table below shows some examples of CAN transmission data of each 

measurement unit. 

 

 

 

 

 

 

 

 

 

 

 

 

 

F

or TMR-253 pulse-count only, the value without change is output. 

Measurement 
Unit Range Measured 

value 
CAN trans- 
mission data 

Measurement 
Unit Range Measured 

value 
CAN trans- 
mission data 

TMR-221 
(TMR-222)  

5,000μ 5,000μ 10,000 TMR-253 
 
 
 
 
  

100kHz 1kHz 100 

5,000μ 1μ 2 10kHz 1kHz 1000 

10,000μ 5,000μ 5,000 1kHz 1kHz 10000 

10,000μ 1 1 Pulse- 
count* 1 1 

20,000μ 5,000 2,500 

20,000μ 2 1 Pulse- 
count* 29,999 29,999 

TMR-231  20V 1.000V 500 

10V 1.000V 1000     

5V 1.000V 2000     

1V 1.000V 10000     

T(400℃) 100.0℃ 2500     

K(1300℃) 100.0℃ 769     
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4-5 Setting the Voice recording 
These are the items to be set relevant to Voice data in the Basic setting. 

 

 Memory allocation 

 

Input the number of memory areas used for recording the Voice data. The 

total memory of CAN, Voice and GPS should be 6,000,000Byte or less. For 

example, if CAN and GPS are not used, Voice can be set to 6,000,000Byte 

and others can be set to 0Byte. If the internal memory of CAN/Voice/GPS 

unit (TMR-251) is not used, set every item to 0Byte. The Voice data is 

recorded in TMR-211 when the measurement is not performed. It is recorded 

in the internal memory of CAN/Voice/GPS unit (TMR-251) during the 

measurement. The Voice recording time is fixed to 20 seconds. 

 

The Voice data to be recorded in the internal memory is shown below. 

Time data 1 Time data 2 Data 
4Byte 4Byte Approximately 200,000Byte 

 

The number of times available for recording Voice file of 20 seconds in the 

measurement is calculated as follows. 

Voice memory  Number of recording times 

1000000       1,000,000Byte / 200,000Byte - 1 ＝ 4 times 

2000000       2,000,000Byte / 200,000Byte - 1 ＝ 9 times 

6000000       6,000,000Byte / 200,000Byte - 1 ＝ 29 times 

 

 Voice 

 

Volume trigger is used. 
 : Check the box when you record the Voice. 

Recording start level 
 : Set the sound volume of recording trigger by Voice. Set the 

trigger level by operating the slide bar. The recording trigger 

level goes down in order of High, Medium and Low. The Voice 

trigger is the function for recording the Voice depending on the 

Voice level. 
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5 Processing CAN/Voice/GPS measurement data 
If the measurement is performed by connecting the computer and TMR-211, 

the data of CAN and GPS are automatically read after the measurement is 

terminated and the data file is created. 

The Voice data is not read automatically, so make a selection from Reading 
memory card data... or Reading instrument data... to read the data. 

 

5-1 Reading memory card data 
You can save the measurement data stored in the memory card in the instrument 

to a computer. 

 

◼ "Reading memory card data..." 
Select "Reading memory card data..." in the Measurement menu 

 

The data recorded in the memory card are displayed. 

 

◼ "Reading instrument data..." 
Insert the memory card in the memory card slot of computer and select 

"Reading instrument data..." in the File menu. 

 

If you click "Reference" button and select the folder in which the data are 

recorded, the data recorded in that folder are displayed. 

For details, please read 
“Chapter 5: 16 Reading 
memory card data” (Page 
5-30). 
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For the data of CAN and GPS, select Waveform data to register. 

 

For the Voice data, click the "Voice" button to display the list of Voice data, and 

then select and register the Voice data. 

 

If you click the "OK" button, the data are read and displayed in the history. 
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5-2 Displaying the GPS data 
The GPS data that has been set as an input channel of TMR-211 is displayed. 

 

In order to display the GPS data, display the Measurement data file. 

 

In case of the data for which the GPS data is selected for input CH, 

"CAN/Voice/GPS" button is displayed to enable the selection of GPS data. 

 

If the GPS data is selected, only the GPS data is displayed. 

 

For details on the input CH, 
refer to “Input channel data” 
(Page 12-6) in “Chapter 12: 4-2 
Setting the GPS data 
measurement”. 

On the display of the GPS data, 
the editing of marker can be 
done. 
For editing marker, refer to 
"Chapter 7: 7-5 Display and 
editing of marker" (page 7-28). 
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The display is divided in three parts and the trajectory is drawn in upper left 

using the data of latitude and longitude. Nothing is displayed if there is no data 

of latitude and longitude. 

In the upper right area and the lower area, the data list and the chart list are 

displayed, respectively. 

If you drag the chart in the chart list, the selected part is highlighted in each 

area. 

 

If the latitude and longitude are got with multiple CHs, the trajectory is drawn 

using the latitude and longitude with the smallest CH number. 

 

◼ Saving the selected part as text 
In order to save the selected part as text, right-click the chart list or the data 

list and select Save as text... from the displayed menu. 

 

The dialog box for text conversion is displayed. 

  

For details on the text 
conversion, please read 
"Chapter 7. 7-11 Save as text" 
(Page7-36). 
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If you click the "The selected range is set to the step", the step changes to 

the selected range. 

 

If you select the data and click the "OK" button, the selected part is saved as 

text. 

 

◼ Printing the area 
If you click each area, a yellow frame is displayed in that area. 

If you implement the printing while this frame is displayed, the content 

displayed in that area is printed. 

For example, if you click the area where the upper left trajectory is displayed 

and implement the printing, the trajectory is printed. 
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5-3 Displaying the GPS raw data 
The GPS raw data is the data received by the GPS unit, which is recorded in the 

internal memory of CAN/Voice/GPS unit (TMR-251). This data is recorded 

even if it is not set to the input CH in the basic setting. 

In case of the data file in which the raw data of GPS is recorded, 

"CAN/Voice/GPS" button is displayed to enable the selection of GPS raw 
data. 

 

The list of GPS raw data is displayed. 

 

In the GPS raw data, following items are displayed. 

gps_date : Measurement date and hour 

Time : Elapsed time sec 

gps_lon_abso_deg 
 : Longitude, 0.0000001°unit 

gps_lat_abso_deg 
 : Latitude, 0.0000001°unit 

gps_ele_abso 
 : Altitude, 1m unit 

gps_vel : Speed, 0.1km/h unit 

gps_trk : Clockwise azimuth orientation from north, 0.01゜unit 
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5-4 Display of GPS map 
The trajectory can be drawn on the map according to the latitude and longitude 

recorded with CAN/Voice/GPS unit. 

 

The use of this function needs an environment where the computer is connected 

to Internet. The maps are drawn using Google Maps API. 

 

For the data of the latitude and longitude, corrected values are used. If corrected 

values are not available, GPS raw data are used. 

 

Display the data file of the latitude and longitude. 

 

Select the GPS Map on the "CAN/Voice/GPS" button menu. 

 

Screen for setting the size of the map and the number of trajectory data drawn 

on the map is displayed. 
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As the number of trajectory data increases, drawing will take much time or may 

be made incorrectly. Set the number of data between 50 and 5000. 

If the number of recorded data is more than the set value, the data are thinned 

out at even intervals to approximate the set value. In case that the number of 

data is less, all the data are used. 

The magnification of the map can be changed by shifting the slider. 

The browser is launched when you click the button "The map display in the 
browser", and the trajectory is drawn on the map. 

 



Chapter 12 CAN/Voice/GPS unit 

 12-25 

5-5 Displaying the CAN data 
The CAN data is the message that has been defined as a received message by 

the setting of CAN, which is received by CAN/Voice/GPS unit (TMR-251) and 

recorded in the internal memory of CAN/Voice/GPS unit (TMR-251). 

In case of the data file in which the CAN data is recorded, "CAN/Voice/GPS" 
button is displayed to enable the selection of CAN data. 

 

The list of CAN data is displayed. 

 

For the CAN data, the value of received signal and the measurement time of 

receiving the message are displayed. 

 

For details on the received 
message, refer to “Setting the 
CAN reception” (Page 12-10) 
in "Chapter 12: 4-4 Setting 
CAN transmission/reception 
data". 
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5-6 Displaying the CAN chart list 
The CAN data is the message that has been defined as a received message by 

the setting of CAN, which is received by CAN/Voice/GPS unit (TMR-251) and 

recorded in the internal memory of CAN/Voice/GPS unit (TMR-251). 

For a data file in which CAN data are recorded, "CAN/Voice/GPS" button is 

displayed to enable the selection of CAN chart list. 

 

The chart list of CAN data is displayed. 

 

The CAN chart list draws the received signal as an elapse chart. 

 

For details on the received 
message, refer to “Setting the 
CAN reception” (Page 12-10) 
in “Chapter 12: 4-4 Setting the 
CAN transmitted and received 
data”. 
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5-7 How to draw the chart 
Data are sometimes generated stepwise like a pulse in CAN data or some other 

data. 

If you draw such data as an elapse chart, data points are connected with 

diagonal lines and the chart may not be exactly equal to the actual 

phenomenon. 

In such a case, the chart can be drawn by connecting each two adjacent data 

points with horizontal and vertical lines 

If you right-click the chart list, the menu is displayed. 

 

If you select Drawing method..., the dialog box for setting the drawing 

method is displayed. 

 

Select the data for changing the drawing method. 

 

Select Stair to connect each two adjacent data points with horizontal and 

vertical lines. 

If you select Mountain, each two adjacent data points are connected with 

diagonal line. 
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If you click the "OK" button, the chart is drawn in the selected method. 

 

Mountain 

 

Stair 
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5-8 Playing the Voice data 
The voice data is played by Voice history. 

Select the Voice history from the "History" button in the measurement project. 

 

The list of recorded Voice files is displayed. 

 

In the Voice history, following items are displayed. 

File name : File name of Voice file 

Recording time 
 : Date and time when the recording was started 

Destination : Name of folder in which the Voice file is saved 

The Voice file whose destination is VOICE was recorded while 

measurement was not performed, and it is saved in the VOICE 

folder in the DATA folder related to the measurement project. 

The Voice file whose destination is a data file name was 

recorded while measuring the data file, and it is saved in the 

folder in which the data file is saved. 

 

If the Voice history of data files is displayed, the Voice files that were recorded 

during the measurement are displayed 

 

In the Voice history of data file, the recording start time is displayed. 

The recording start time indicates the time when the recording was started, and 

it is the relative time after the measurement was started. 
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In order to play the Voice data, click the  button displayed beside the file 

name. 

 

Or right-click the Voice list to display the menu and select Play. 

 

In order to stop the playing of Voice, click the  button again or right-click 

the Voice list to display the menu and select Stop. 
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This chapter explains the settings and the usage inherent in the Digital I/O unit 

(TMR-253/TMR-353). 

 

1 Selecting the Digital I/O unit 
Click the "Meter setting..." button in the Measurement project. 

 

Select Digital I/O from the Name column of unit port to which the Digital I/O 

unit (TMR-253/TMR-353) is connected and click the "OK" button. 

 

For details on the setting of 
instrument, refer to "Chapter 4: 
2. Setting of the instrument" 
(Page 4-2). 
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2 Setting the Digital I/O unit 
The setting of the Digital I/O unit is made on the input CH screen and the 

Digital I/O screen. 

 

The setting of the input CH has following restrictions. 

 Input mode, Input range, Low-pass filter, High-pass filter and 
Reference junction cannot be set. 

 For the 8th channel, Calibration, Unit and Format cannot be set too. 
 

2-1 Displaying the Digital I/O screen 
In order to make a detailed setting of the Digital I/O unit, select the Digital I/O 

from "Channel setting" button menu. 

 

The Digital I/O screen is displayed. 

 

 

For details on the input CH, 
refer to "Chapter 4: 6 Input 
Channels" (Page 4-10). 
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2-2 Input mode 
For the input mode of the Digital I/O unit, the settable items vary depending on 

the channel. 

 

1 to 2 : FREQ/COUNT (Unsigned)/COUNT (32bit) 

COUNT (32bit) can only be used with TMR-353, and is set for 

both channels 1 and 2. 

3 to 4 : FREQ/COUNT (Unsigned) 

5 to 6 : COUNT (Unsigned) / COUNT (Singed) 

7 : Fixed to COUNT (Unsigned) 

8 : CH8 handles the control signal per bit. 

Bit 0 to Bit 3 are assigned to DIGITAL IN1 to DIGITAL IN4 as 

input bits and the following functions can be set. 

NONE/MARK/TRIG/SCLK/BAL/RUN/HLT/PAUSE/ 

CAL+/CAL-/CAL0 

For other than NONE, the same setting cannot be made for 

more than one DIGITAL IN. 

 

MARK : "1" is recorded in the data of CH8 every time when 

the marker signal is input. 

TRIG : Trigger signal input 

SCLK : External sampling input 

BAL : Balancing signal input 

RUN : Start of measurement 

HLT : Stop of measurement 

PAUSE : Pause of measurement 

CAL+/CAL-/CAL0 
 : Calibration signal input (Plus/Minus/Zero)  

 

For the details of the input 
mode, refer to the operation 
manual of Digital I/O unit 
(TMR-253/TMR-353). 
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2-3 Input range 
For the input range of the Digital I/O unit, the settable items vary depending on 

the channel and the input mode. 

 

1 to 4 : Setting is not available for COUNT (Unsigned) or COUNT 

(32bit). 

For FREQ, make a selection from 

100/500/1000/5000/10000/50000/100000. 

5 to 7 : For COUNT (Unsigned), input the value arbitrarily within the 

range of 2 to 30000. 

 
Setting is not available for COUNT (Signed). 

8 : Setting is not available. 

 

2-4 Threshold value 
For the threshold value, set the level for recognizing the signal input to CH1 to 

CH4 of the Digital I/O unit as waveforms. 

 

The level of threshold value depends on the mode. 

Edit : To be input between -10000mV and +10000mV by 100mV step 

Low : Fixed to +15mV and -15mV 

Mid : Fixed to +100mV and -100mV 

High : Fixed to +1000mV and -1000mV 

TTL : Fixed to +2000mV and +800mV 

CMOS : Fixed to +3500mV and +1500mV 

 

When input mode is set to COUNT (32bit), this setting is ignored because 

channel 2 is not used as an input. 

 

For the details of the input 
range, refer to the operation 
manual of Digital I/O unit 
(TMR-253/TMR-353). 
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3 External sampling 
The external sampling implements the sampling of data by inputting a signal 

for sampling of data to the Digital I/O unit. 

In order to use the external sampling, set SCLK to any one of input modes of 

DIGITAL IN 1 to DIGITAL IN 4 on the Digital I/O screen. 

 

The A/D conversion setting dialog is displayed when A/D setting... in the 

measurement project is selected. 

 

In order to enable the external sampling, click "More than 1 msec". 

 

Setting items 

Invalidity : The external sampling signal is not used. 

The sampling is implemented by the set Sample clock. 

More than 1 msec 
 : The external sampling signal is used. 

 

The items which were displayed by measurement time are now displayed by 

count. 

 

 

 

 

 

 

 

For details on the A/D setting, 
refer to "Chapter 4: 3 A/D 
setting" (Page 4-6). 
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4 Cycle trigger measurement 
The automatic measurement is performed using the counter value of counter 

function of measurement system following the start cycle, step cycle and 

condition. 

To use this function, one or more units using the COUNT(32bit) mode are 

required. 

 

4-1 Setting the cycle trigger measurement 
It is set by cycle trigger measurement in automatic measurement setting of 

measurement project. 

 

Setting item 

Start cycle : Input the count value when the measurement is started. 

Stop cycle : Input the measurement interval with number of counts. 

Condition : The control is selected from INFINTY, REPEAT and GOTO. 

INFINITY : The measurement is performed until the measurement is 

 stopped manually. 

REPEAT : The measurement is repeated for the number of times that is 

 specified by Repeat. 
GOTO : It shifts to the step that is specified by Repeat. The Name and 

 Variation are ignored. 
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4-2 Example of Cycle trigger measurement 
◼ When the start cycle is set 

 

With the setting shown in the figure above, when the count value reaches 1000, 

the measurement is performed, and then the measurement is performed in 1000 

count intervals for 10 times in total, and the cycle trigger measurement is 

terminated. 

 

 

◼ When the start cycle is omitted 

 

With the setting shown in the figure above, the measurement is performed once 

when the cycle trigger measurement is started, and the measurement is 

performed in 1000 count intervals for 10 times based on the count value at that 

time, and the cycle trigger measurement is terminated. 

 

 

When the count gains speedily, the count may increase after judging the count 

value till the measurement is actually started, so the count value of 

measurement result may differ from count value when it is judged. 

 

If the actual count value is greater when the judgment of count value is started, 

the measurement is started immediately 
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4-3 Start of Cycle trigger measurement 
For starting the cycle trigger measurement, click "Cycle trigger..." from button 

menu of "Auto measurement" of measurement panel or select "Cycle 
trigger..." from "Auto measurement" sub menu of "Measurement" menu. 

 

The dialog box of cycle count initialization setting is displayed. 

 

Setting item 

Count to initialize with 

 : The initial value of cycle count is set when the cycle trigger 

 measurement is performed after initializing the cycle count 

 value. 

Count when displaying dialogue 
 : The count value when the dialog box of cycle count 

 initialization setting is displayed is displayed. 

Count to initialize with 

 : The initial value of cycle count is set when the cycle trigger 

 measurement is performed after initializing the cycle count 

 value. 

When "Continue" button is clicked, the cycle trigger measurement is started 

without changing the count value of measurement system. When "Initialize" 

button is clicked, the cycle trigger measurement is started after initializing the 

count value of measurement system with the count value that is set by 

initialization count. 

 

The cycle trigger measurement automatically stops when the count value 

exceeds 899,999,999. 

 

 

 

4-4 Stop of Cycle trigger measurement 
To stop the data comparator measurement, click the Cycle trigger... from 

"Auto measurement" button menu on the Measurement panel. 

 

Refer to "5: 6 Stop of manual measurement" (Page5-9) for stopping the 

measurement. 

 

 



Chapter 13 Digital I/O unit 

 13-9 

5 Processing Cycle trigger measurement data 
The data file containing the channel measured as COUNT(32bit) nide records 

the number of cycles. The number of recorded cycles can be checked at the 

following. 

If there is a channel measured by COUNT(32bit) mode, the number of cycles is 

recorded even by a measurement method other than cycle trigger measurement. 

 

◼Measurement history 
If there is a data file with the number of cycles recorded, or if there is a digital 

input/output unit (TMR-353) in the meter settings, a column for the number of 

cycles is displayed. 

 

 

◼Maximum/Minimum/Average 
If there is a data file with the number of cycles recorded, or if there is a digital 

input/output unit (TMR-353) in the meter settings, a column for the number of 

cycles is displayed. 

 

 

◼Data file opened from measurement history 
The number of cycles is displayed next to the measurement method when the 

data file contains it. 
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5-1 Drawing the Cycle chart 
When "Cycle chart..." is selected from "History chart" sub menu of "Graph" 

menu with the measurement project selected, the dialog box for setting chart is 

displayed. 

 

Setting item 

Count to initialize with 

 : The initial value of cycle count is set when the cycle trigger 

 measurement is performed after initializing the cycle count 

 value. 

Count when displaying dialogue 
 : The count value when the dialog box of cycle count 

 initialization setting is displayed is displayed. 

Count to initialize with 

 : The initial value of cycle count is set when the cycle trigger 

 measurement is performed after initializing the cycle count 

 value. 

When new line is selected, multiple lines can be selected for Y-axis list. 
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Click the construction method to set it. 

 

Drawing method 

Adjust the construction area automatically 

 : When this is enabled, all data are plotted. If this is disabled, 

 construction area needs to be specified.  

Construction area 

 : Specify the step of data to be drawn. 

 

When "OK" button is clicked after setting, the data chart is drawn. 
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This chapter introduces the function formulas used in this software, and 

explains the meaning of function and how to use it. 

 

1 Inputting function formula 
The method for inputting function formula is the same as inputting a 

calculation formula of general spreadsheet software. It is also possible to 

combine the calculation formula and function. The function can be selected 

using "Paste Function…" menu or directly input. 

Either capital letter or small letter is available for the function name. 

 

1-1 Argument 
The argument is the data used for the function. The argument used for this 

software is widely categorized in three types;  

To use a value or other function formula 

 : General function such as SIN and COS  

To use data of channel number or data number 

 : CH function, NO function  

To use data number 

 : CNT32 function, Function such as NAVE and NAADD 

whose name starts from "N" 

 

The "data NO" in this chapter is the CH number that is indicated in input 
CH or the NO number that is indicated in expanded CH. 

When the CH number of input CH is used as argument, input the number 

after "CH". For example, the CH number 20 is input as "CH20". 

When the NO number of expanded CH is used as argument, input the 

number after "NO". For example, the NO number 20 is input as "NO20". 

 

1-2 Description of function 
The omission mark ([, ...]) in the formula indicates that an argument of the 

same type as the preceding argument can be specified repeatedly. For 

example, the formula of NAVE( ) function is described as follows. There is 

no limitation for the number of repetitions provided that the arithmetic 

formula is within 255 characters. 

 

NAVE (data NO[, data NO, ...]) 
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2 List of function 
Each function is classified according to its usage as listed below. 

◼ Information function 

NO(extended CH NO number) 

 

◼ Value calculation function 

ABS(value or formula) 

LN(value or formula) 

LOG10(value or formula) 

PI() 

SQRT(value or formula) 

IROUND(value or formula) 

SGN(value or formula) 

 

◼ Statistics function 

NAVE(data NO1[, data NO2, ...]) 

NMAX(data NO1[, data NO2, ...]) 

NMIN(data NO1[, data NO2, ...]) 

NSUM(data NO1[, data NO2, ...]) 

 

◼ Trigonometric function 

ACOS(value or formula) 

ASIN(value or formula) 

ATAN(value or formula) 

COS(value or formula) 

NATAN(X coordinate data NO, Y coordinate data NO) 

SIN(value or formula) 

TAN(value or formula) 

 

◼ Measurement information function 

CH(CH number of measurement CH) 
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◼ Special calculation function 

CNT32(First CH data NO of unit) 

NAADD(data NO) 

NDEVI(data NO, step number of initial value) 

NEMAX(X-axis data NO, Y-axis data NO, Z-axis data NO, Young’s 

modulus, Poisson’s ratio) 

NEMIN(X-axis data NO, Y-axis data NO, Z-axis data NO, Young’s 

modulus, Poisson’s ratio) 

NEX(X-axis data NO, Y-axis data NO, Young’s modulus, Poisson’s ratio) 

NEY(X-axis data NO, Y-axis data NO, Young’s modulus, Poisson’s ratio) 

NF3DT(temperature data NO, step number of initial value, coefficient of 

cubic expression a, b, c, d) 

NF4DT(temperature data NO, step number of initial value, coefficient of 

quartic expression a, b, c, d, e) 

NFX5(data NO, coefficient of quintic expression a, b, c, d, e, f) 

NFADD(data NO) 

NFSUB(data NO) 

NPDEG(X-axis data NO, Y-axis data NO, Z-axis data NO) 

NSMAX(X-axis data NO, Y-axis data NO, Z-axis data NO) 

NSMIN(X-axis data NO, Y-axis data NO, Z-axis data NO) 

NTEMAX(X-axis data NO, Y-axis data NO, Z-axis data NO, Young’s 

modulus, Poisson’s ratio) 

NTSMAX(X-axis data NO, Y-axis data NO, Z-axis data NO) 

NTR(data NO, cycle) 
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3 Function reference 
Function (argument(s)) 

Describes the function. 

 

Example Describes the usage of the function using an example. 

 

Reference Function which is used or related in example is shown. 

 

ABS(value or formula) 
This function returns the absolute value. The absolute value is the value 

itself excluding sign (+, -). 

 

Example The value of data NO1: -135 

The result of =ABS(NO(1)) is 135 

 

Reference  NO() function 

 

ACOS(value or formula) 
This function returns the arccosine of specified value or formula in the 

range 0 to π radians. 

 

Example The result of =ACOS(-0.5) is 2.09 (2π/3 radian) 

The result of =ACOS(-0.5)*180/PI() is 120(degree) 

 

Reference  NO() function, PI() function 

 

ASIN(value or formula) 
This function returns the arcsine of specified value or formula in the 

range –π/2 to π/2 radians. 

 

Example The result of =ASIN(-0.5) is -0.52 (-π/6 radian) 

The result of =ASIN(-0.5)*180/PI() is -30 (degree) 

 

Reference  NO() function, PI() function 

 

ATAN(value or formula) 
This function returns the arctangent of specified value or formula in the 

range –π/2 to π/2 radians. 

 

Example The result of =ATAN(1) is 0.79 (π/4 radian) 

The result of =ATAN(1)*180/PI() is 45 (degree) 

 

Reference  NO() function, PI() function 
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CH(CH number) 
This function returns the measured value of specified CH number. 

The same CH number can be used for other arithmetic expression. 

 

Example The value of CH1: -646 

The result of =CH(1)*0.5 is -323 

 

Reference  NO() function 

 

CNT32 (First CH data NO of unit) 
This function returns the converted count value from data measured in 

the COUNT(32bit) mode. 

For the argument, specify the data NO of the first channel of the unit that 

uses in the COUNT(32bit) mode. 

 

CNT32(Data NO) ＝ Data１ ＋ ( Data2 × 30000 ) 

Data1 : Data of CH given by argument 

Data2 : Data of the next CH given by the argument 

 

 

Example The value of CH1 : 1500 

The value of CH2 : 12 

The result of =CNT32(CH1) is 361500 

 

An error will occur if anything other than the first CH of the unit is 

specified. 

 

An error does not occur even if data NO is set for an input mode other 

than COUNT(32bit), and the calculation result is returned according to 

the above formula. 

 

When calculating the count using the CNT32 function, do not set a 

coefficient or offset for the input CH. 

 

If the same calculation is performed on the expanded channel without 

using the CNT32 function, the correct value will not be gotten. 

 

COS(value or formula "radian") 
This function returns the cosine of "radian" which is specified by value 

or formula. 

 

Example The result of =COS(1.047) is 0.5 

The result of =COS(60*PI()/180) is 0.5 

 

Reference  ACOS() function, PI() function 
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IROUND(value or formula) 
This function returns the value rounded off for specified value or 

formula. 

 

Example The result of =IROUND(1.3) is 1 

The result of =IROUND(2.6) is 3 

Application When the tens place of data NO1 is rounded off and the 

value of data NO1 is 1053; 

The result of =IROUND(NO(1)/100)*100 is 1100 

 

Reference  NO() function 

 

LN(value or formula) 
This function returns the natural logarithm of value that is given as 

argument. 

When the value is 0 or less, the result is not returned. 

 

Example The result of =LN(86) is 4.45 

 

Reference  LOG10() function 

 
LOG10(value or formula) 

This function returns the common logarithm (logarithm with base 10) of 

value. 

When the value is 0 or less, the result is not returned. 

 

Example The result of =LOG10(86) is 1.93 

 

Reference  LN() function 

 

NAADD(data NO) 
This function returns the summation of data NO that is given as 

argument. 

If the argument contains error, blank cell or disconnection data, the value 

is not returned. 

 

Example The values of data NO1 are 0, 10, 20, 30, 40, 50 in order 

The result of =NAADD(NO1) are 0, 10, 30, 60, 100, 150 

in order 
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NATAN(X coordinate data NO, Y coordinate data NO) 
This function returns the arctangent of X-Y coordinate that is expressed 

by specified X coordinate and Y coordinate. 

 

Example The value of data NO1 (X coordinate): 0 

The value of data NO2 (Y coordinate): 1 

The result of =NATAN(NO1,NO2)*180/PI() is 90 

(degree) 

 

Reference  PI() function 

 

NAVE(data NO1 [, data NO2, ...]) 
This function returns the average value of data NO that is given as 

argument. 

If the argument contains error, blank cell or disconnection data, the value 

is not returned. 

 

Example The values of data NO1 to data NO4: 

-135,-125,-153,-127 

The result of =NAVE(NO1, NO2, NO3, NO4) is -135 

 

Reference  NSUM() function 

 

NDEVI(data NO, step number of initial value) 
This function returns the variation from initial value with the data NO, 

that is given as argument. 

When the actual number of measurements does not reach the number of 

measurements of initial value, the value is not returned. 

For argument, input data NO and step number of initial value in order. 

 

Example The reference data NO: NO1 

Step number of initial value: 1 

Initial value: 30 

Data at measurement: 100 

The result of =NDEVI(NO1,1) is 70 
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NEMAX(X-axis data NO, Y-axis data NO, Z-axis data NO, Young’s 
modulus, Poisson’s ratio) 

This function returns the maximum principal stress of rectangular rosette 

gauge. 

For argument, input X-axis data NO, Y-axis data NO, Z-axis data NO, 

Young’s modulus and Poisson’s ratio in order. 

 

Example Young’s modulus=205,900 (MPa) 

Poisson’s ratio=0.3 

The value of data NO1 (X-axis): -561 

The value of data NO2 (Y-axis): 1561 

The value of data NO3 (Z-axis): -801 

The result of =NEMAX(NO1, NO2, NO3, 205900, 0.3) 

is 413.0 (MPa) 

 

Reference  NEMIN() function, NSMAX() function, NSMIN() 

function, NPDEG() function 

 

NEMIN(X-axis data NO, Y-axis data NO, Z-axis data NO, Young’s 
modulus, Poisson’s ratio) 

This function returns the minimum principal stress of rectangular rosette 

gauge. 

For argument, input X-axis data NO, Y-axis data NO, Z-axis data NO, 

Young’s modulus and Poisson’s ratio in order. 

 

Example Young’s modulus = 205,900 (MPa) 

Poisson’s ratio = 0.3 

The value of data NO1 (X-axis): -561 

The value of data NO2 (Y-axis): 1561 

The value of data NO3 (Z-axis): -801 

The result of =NEMIN(NO1, NO2, NO3, 205900, 0.3) is 

-118.8 (MPa) 

 

Reference  NEMAX() function, NSMAX() function, NSMIN() 

function, NPDEG() function 
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NEX(X-axis data NO, Y-axis data NO, Young’s modulus, Poisson’s 
ratio) 

This function returns the X-axis principal stress of 2-axis gauge. 

For argument, input X-axis data NO, Y-axis data NO, Young’s modulus 

and Poisson’s ratio in order. 

 

Example Young’s modulus = 205,900 (MPa) 

Poisson’s ratio = 0.3 

The value of data NO1 (X-axis): -561 

The value of data NO2 (Y-axis): 1561 

The result of =NEX(NO1, NO2, 205900, 0.3) is -21.0 

(MPa) 

 

Reference  NEY() function, NEMAX() function, NEMIN() function, 

NPDEG() function 

 

NEY(X-axis data NO, Y-axis data NO, Young’s modulus, Poisson’s 
ratio) 

This function returns the Y-axis principal stress of 2-axis gauge. 

For argument, input X-axis data NO, Y-axis data NO, Young’s modulus 

and Poisson’s ratio in order. 

 

Example Young’s modulus = 205,900 (MPa) 

Poisson’s ratio = 0.3 

The value of data NO1 (X-axis): -561 

The value of data NO2 (Y-axis): 1561 

The result of =NEY(NO1, NO2, 205900, 0.3) is 315.1 

(MPa) 

 

Reference  NEX() function, NEMAX() function, NEMIN() function, 

NPDEG() function 

 

NF3DT(temperature data NO, step number of initial value, coefficient 
of cubic expression a, b, c, d) 

This function returns the zero shift (by cubic expression). 

When the actual number of measurements does not reach the step 

number of initial value, the value is not returned. 

For argument, input temperature data NO, step number of initial value, 

and coefficient of cubic expression a, b, c, d in order. 

 

Example Temperature data NO: data NO1 

Step number of initial value: 1 

Initial temperature: 20 

Temperature at measurement: 28 

Coefficient of cubic expression a: -1.27 x 10-4 

Coefficient of cubic expression b: 0.0226 

Coefficient of cubic expression c: 0.97 

Coefficient of cubic expression d: -30 

The result of 

=NF3DT(NO1, 1, -1.27e-4, 0.0226, 0.97, -30) is 15 
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NF4DT(temperature data NO, step number of initial value, coefficient 
of quartic expression a, b, c, d, e) 

This function returns the zero shift (by quartic expression). 

When the actual number of measurements does not reach the step 

number of initial value, the value is not returned. 

For argument, input temperature data NO, step number of initial value, 

and coefficient of quartic expression a, b, c, d, e in order. 

 

Example Temperature data NO: data NO1 

Step number of initial value: 1 

Initial temperature: 20 

Temperature at measurement: 28 

Coefficient of quartic expression a: -1.95 x 10-6 

Coefficient of quartic expression b: 5.96 x 10-5 

Coefficient of quartic expression c: 0.0202 

Coefficient of quartic expression d: 1.02 

Coefficient of quartic expression e: -31 

The result of 

=NF4DT(NO1, 1, -1.95e-6, 5.96e-5, 0.0202, 1.02, -31) 

is 16 

 

NFX5(data NO, coefficient of quintic expression a, b, c, d, e, f) 
This function returns the result of quintic expression of data No given as 

argument. 

 

Example The value of data NO1: 28 

Coefficient of quintic expression a: 1.6 x 10-11 

Coefficient of quintic expression b: -3.1 x 10-8 

Coefficient of quintic expression c: 2.1 x 10-5 

Coefficient of quintic expression d: -5.6 x 10-3 

Coefficient of quintic expression e: 1.2 

Coefficient of quintic expression f: 1.4 

The result of 

=NFX5(NO1, 1.6e-11, -3.1e-8, 2.1e-5, -5.6e-3, 1.2, 1.4) 

is 31 

 

NFADD(data NO) 
This function returns the sum with previous data for the data NO that is 

given as argument. 

If the argument contains error, blank cell or disconnection data, the value 

is not returned. 

 

Example The previous value of data NO1: 10 

The value of data NO1: 20 

The result of =NFADD(NO1) is 30 

 

Reference  NFSUB() function 
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NFSUB(data NO) 
This function returns the difference from previous data for the data NO 

that is given as argument. 

If the argument contains error, blank cell or disconnection data, the value 

is not returned. 

 

Example The previous value of data NO1: 100 

The value of data NO1: 90 

The result of =NFSUB(NO1) is -10 

 

Reference  NFADD() function 

 

NMAX(data NO1 [, data NO2, ...]) 
This function returns the maximum value in the data NO that is given as 

argument. 

If the argument contains error, blank cell or disconnection data, the data 

of that argument is not the target of comparison. 

 

Example The values of data NO1 to data NO4: 

135, 125, 153, 127 

The result of =NMAX(NO1, NO2, NO3, NO4) is 153 

 

Reference  NMIN() function 

 

NMIN(data NO1 [, data NO2, ...]) 
This function returns the minimum value in the data NO that is given as 

argument. 

If the argument contains error, blank cell or disconnection data, the data 

of that argument is not the target of comparison. 

 

Example The values of data NO1 to data NO4: 

135, 125, 153, 127 

The result of =NMIN(NO1, NO2, NO3, NO4) is 125 

 

Reference  NMAX() function 

 

NO(data number) 
This function returns the calculated value of specified data number. This 

is used when implementing calculation between data. 

 

Example =NO(1)+NO(2) 

=ABS(NO(1)) 

 

Reference  CH() function 
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NPDEG(X-axis data NO, Y-axis data NO, Z-axis data NO) 
This function returns the maximum principal strain direction of 

rectangular rosette gauge. 

For argument, input X-axis data NO, Y-axis data NO and Z-axis data NO 

in order. 

The relationship between principal strain direction and direction of 

gauge axis is shown below. 

The calculated value is displayed between the first quadrant and the 

fourth quadrant. 

 

The number in brackets shown in the figure indicates the gauge axis 

number. 

 

Example When the calculated value exceeds 90 degrees, 

The value of data NO1 (X-axis): 1.7 

The value of data NO2 (Y-axis): 3.412 

The value of data NO3 (Z-axis): 2.55 

The result of =NPDEG(NO1, NO2, NO3) is -89.8 

(degree) 

-

+

X(1)

Z(3)
Y(2)

-89.8

90.2

°

°

 

Reference  NEMAX() function, NEMIN() function, NSMAX() 

function, NSMIN() function 
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NSMAX(X-axis data NO, Y-axis data NO, Z-axis data NO) 
This function returns the maximum principal strain of rectangular rosette 

gauge. 

For argument, input X-axis data NO, Y-axis data NO and Z-axis data NO 

in order. 

 

Example The value of data NO1 (X-axis): -561 

The value of data NO2 (Y-axis): 1561 

The value of data NO3 (Z-axis): -801 

The result of =NSMAX(NO1, NO2, NO3) is 2179 (x 

10-6 strain) 

 

Reference  NSMIN() function, NEMAX() function, NEMIN() 

function, NPDEG() function 

 

NSMIN(X-axis data NO, Y-axis data NO, Z-axis data NO) 
This function returns the minimum principal strain of rectangular rosette 

gauge. 

For argument, input X-axis data NO, Y-axis data NO and Z-axis data NO 

in order. 

 

Example The value of data NO1 (X-axis): -561 

The value of data NO2 (Y-axis): 1561 

The value of data NO3 (Z-axis): -801 

The result of =NSMIN(NO1, NO2, NO3) is -1179 (x 

10-6 strain) 

 

Reference  NSMAX() function, NEMAX() function, NEMIN() 

function, NPDEG() function 

 

NSUM(data NO1 [, data NO2, ...]) 
This function returns the sum of data NO that is given as argument. 

If the argument contains error, blank cell or disconnection data, the value 

is not returned. 

 

Example The values of data NO1 to data NO4: 

-135, -125, -153, -127 

The result of =NSUM(NO1, NO2, NO3, NO4) is -540 

 

Reference  NAVE() function 

 



 

 

 14-14 

NTEMAX(X-axis data NO, Y-axis data NO, Z-axis data NO, Young’s 
modulus, Poisson’s ratio) 

This function returns the maximum shearing stress of rectangular rosette 

gauge. 

For argument, input X-axis data NO, Y-axis data NO, Z-axis data NO, 

Young’s modulus and Poisson’s ratio in order. 

 

Example Young’s modulus = 205,900 (MPa) 

Poisson’s ratio = 0.3 

The value of data NO1 (X-axis): -561 

The value of data NO2 (Y-axis): 1561 

The value of data NO3 (Z-axis): -801 

The result of =NTEMAX(NO1, NO2, NO3, 205900, 

0.3) is 265.9 (MPa) 

 

Reference  NTSMAX() function 

 

NTR(data NO, cycle) 
This function returns the difference between the value of data number 

and a multiple of cycle value (if the value of data number is negative, 

sum of the value of data number and a multiple of cycle value). The 

returned value V is 0<=V<Cycle. 

For argument, input data NO and cycle in order. 

 

Example The value of data NO1: 480 

Cycle: 360 

The result of =NTR(NO1, 360) is 120 

 

NTSMAX(X-axis data NO, Y-axis data NO, Z-axis data NO) 
This function returns the maximum shearing strain of rectangular rosette 

gauge. 

For argument, input X-axis data NO, Y-axis data NO and Z-axis data NO 

in order. 

 

Example The value of data NO1 (X-axis): -561 

The value of data NO2 (Y-axis): 1561 

The value of data NO3 (Z-axis): -801 

The result of =NTSMAX(NO1, NO2, NO3) is 3358 (x 

10-6 strain) 

 

Reference  NTEMAX() function 

 

PI() 
This function returns the circle ratio (π). 

Though the PI() function does not take argument, be sure to attach the 

parentheses (). 

 

Example The result of SIN(PI()/2) is 1 
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SGN(value or formula) 
This function returns the signum for specified value or formula. 

The signum is SGN(0)= 0, SGN(x)= x/|x|. 

 

Example The result of =SGN(0) is 0 

The result of =SGN(-30) is -1 

 

SIN(value or formula "radian") 
This function returns the sine of "radian" which is specified by value or 

formula. 

 

Example The result of =SIN(PI()/2) is 1 

The result of =SIN(30*PI()/180) is 0.5 

 

Reference  ASIN() function, PI() function 

 

SQRT(value or formula) 
This function returns the square root of the value that is given as 

argument. 

When the value is negative, the value is not returned. 

 

Example The result of =SQRT(16) is 4 

 

TAN(value or formula "radian") 
This function returns the tangent of "radian" which is specified by value 

or formula. 

 

Example The result of =TAN(45*PI()/180) is 1 

 

Reference  ATAN() function, NO() function 
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